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1
Documentation and support

This section includes the following topics:

• System documentation (page 14)

• Safety symbols (page 15)

• System technical support (page 16)



BD FACSVerse System Reference14

System documentation
Introduction This topic describes the information that is available for this 

product.

Available 
documentation

•  Cytometer Safety and Limitations Guide. This guide is 
included with your cytometer and describes any possible 
hazards or limitations.

• User’s Guide. This guide provides information for setting up 
and running the BD FACSVerse with BD FACSVerse System 
using a typical workflow. Information includes basic 
instructions on the operation of the cytometer and basic 
instructions on how to set up, acquire, and analyze flow data 
using BD FACSVerse System. This document is available in 
print or as a PDF.

• Reference system. The information in this reference system is 
organized into the following parts:

– Introductory information. This part contains information 
about system hardware and components, and a basic 
overview of BD FACSVerse System.

– Using the system. This part contains sections that describe 
the tasks and provide typical workflows for the setup and 
operation of the system.

– Software reference. This part contains information about 
the Library and describes the tools used for data 
visualization and analysis.

– System reference. This part contains sections about the 
Loader, system options, cytometer configurations, system 
specifications, and troubleshooting.

• Assay guide (RUO). This document describes the BD-defined 
assays available for use with the system.

• Technical data sheets. These documents are included with 
reagents.
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Safety symbols
Introduction  This topic describes that safety symbols used in this guide. For a 

complete description of all safety hazards, see the BD FACSVerse 
System Safety and Limitations Guide.

Safety symbols The following table lists the safety symbols used in this guide to 
alert you to potential hazards.

Symbol Meaning

General warning. 

Risk of personal injury to operator.

Biological hazard

Electrical hazard

Laser hazard

Fire hazard

Mechanical hazard, pinch points
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System technical support
Introduction This topic describes how to obtain assistance from BD Biosciences 

technical support.

Before contacting 
technical support

Try the following options for answering technical questions and 
solving problems:

• Read the section of this guide specific to the operation you are 
performing. 

• Read topics of related information which are listed in the More 
Information section.

• Search the BD FACSVerse System Reference for a specific 
topic. 

Contacting 
technical support

To contact technical support:

1. Go to www.bdbiosciences.com.

2. Select your region. 

3. Click the Support link for details for your local region. 

When contacting BD Biosciences, have the following information 
available:

• System health report that includes the Product name, part 
number, and serial number, and details of recent system 
performance. See Generating a system health report (page 481) 
for more information.

• Any error messages

More information • System documentation (page 14)

http://www.bdbiosciences.com


Part 1: Introductory
information

This part includes the following sections:

• About the system (page 19)

• System setup (page 43)
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2
About the system

This section includes the following topics:

• System overview (page 20)

• Cytometer overview (page 23)

• Optical components (page 26)

• Fluidics components (page 28)

• System options and upgrades (page 31)

• BD FACSuite software overview (page 33)

• BD FACSuite software components (page 36)

• Daily workflow (page 41)
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System overview
Introduction This topic gives an overview of the BD FACSVerse system and 

provides a description of the main components. 

About the system The BD FACSVerse system includes the BD FACSVerse cytometer, 
the optional BD FACS Universal Loader, and BD FACSuite 
software running on the system workstation. The system also 
includes customized setup beads. All of these components combine 
to create an integrated system designed for use in a wide variety of 
multicolor research applications. 

The BD FACSVerse flow cytometry system acquires and analyzes 
particles or cells in a liquid suspension. Antibodies to specific cell 
proteins are labeled with a fluorescent dye and incubated with the 
cell suspension. The suspension flows through the cytometer and is 
interrogated by a laser which excites the fluorescent antibodies. 
The fluorescence is captured and the resulting data is analyzed to 
reveal information about the cells. Multiple antibodies, each 
labeled with a different dye, can be used in a single tube to 
simultaneously identify different cell populations. This technique 
can be used in diverse research areas such as stem cell 
development, cell signaling pathways, and HIV.

Waste 
tank

BD FACSVerse 
cytometer

BD FACS 
Universal Loader 
(optional)

Workstation with 
BD FACSuite 
software

Sheath 
tank

BD FACSuite 
CS&T research 
beads 
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BD FACSuite software is used to operate the instrument, acquire 
samples, and analyze the data. Quality control performance, 
tracking, and reporting are streamlined and automated. Routine 
tasks such as daily cleaning and shutdown can be programmed to 
occur automatically. Select from a variety of pre-defined research 
assay modules to quickly create experiments using existing BD 
reagent kits. The modular design of the software allows you to 
analyze data as samples are being acquired.

BD FACSVerse 
cytometer

The BD FACSVerse cytometer is a compact research flow 
cytometer. Several hardware options and upgrades can be used to 
customize the system for different applications. 

The vacuum-driven fluidics along with a uniquely designed flow 
cell and sample injection tube provide reliability and good signal 
resolution. In addition to standard high, medium, and low flow 
rates, a special high-sensitivity fluidics mode makes it easier to 
detect dimly stained particles.

Three laser configurations provide the ability to analyze up to 8 
colors (10 parameters). A unique heptagon detector array takes the 
guesswork out of changing filters and ensures that the correct 
filters and mirrors are installed.

BD FACS Universal 
Loader

The Loader is an optional automated loading system that delivers 
samples to the BD FACSVerse cytometer for acquisition. It is 
designed for walkaway operation.

The Loader offers various settings to resuspend and mix samples. 
It has the flexibility to draw from 12 x 75-mm tubes in 30- and 40-
tube racks, and multiple types of microtiter plates, including deep-
well plates. A barcode reader verifies the ID on tube racks, plates, 
and individual tubes. A built-in imaging system provides safety 
checks, such as verifying the correct rack type and tube 
orientation, and ensuring that tubes and plates were loaded 
correctly.
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Workstation The system is shipped with a workstation that includes a monitor, 
keyboard, and mouse. The workstation runs BD FACSuite 
software and other applications and controls the cytometer. The 
workstation comes equipped with these items:

• Microsoft® Windows® 7 operating system

• BD FACSuite software version 1.0 or later

The workstation requires a security key that plugs into a USB port 
to run the software.

Sheath and waste 
tanks

Several tank sizes are available depending on the sample 
throughput and needs of the individual laboratories. The standard 
5-L capacity sheath and waste tanks are located to the left side of 
the cytometer in a dock. The dock can be disconnected from the 
cytometer. Optional 10-L extended-use tanks are also available. 
Level sensors alert you when fluid levels are low (sheath) or high 
(waste). Additionally, for high-volume labs, a BD FACSFlow 
cubitainer can be used to supply sheath fluid.

For more information on fluidics tank options, see System options 
and upgrades (page 31). 

Beads, reagents, 
and assays

BD FACSuite CS&T research beads are used to check the 
cytometer performance and automatically make adjustments, 
ensuring consistent values from day to day and experiment to 
experiment. 

BD FACSuite FC beads are used to set up compensation controls 
which are valid for 30 days.

BD research assays are available as predefined modules that can be 
used with standard BD reagents to support a wide range of 
applications. Worksheets with plots and gates are already set up 
for acquisition and analysis. The research assays can also be used 
as a starting point for creating customized experiments and assays.
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More information • Cytometer overview (page 23)

• System options and upgrades (page 31)

• BD FACSuite software overview (page 33)

Cytometer overview
Introduction This topic describes the main components of the BD FACSVerse 

cytometer, the location and functions of the status indicators, and 
the available cytometer configurations.

Main components The locations of the main components of the cytometer, including 
the status indicators, are shown in the following figure.

Cytometer power 
button

Fluidics status 
indicator

Acquisition status 
indicator

Manual tube port 

Heptagon 
detector arrays, 
behind front door

Cytometer status 
indicator

Connector panel 

Ethernet 
connector for 
workstation

AC power 
circuit breaker

SIT door

Access door for 
sheath filter on 
left side of 
cytometer
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Status indicators When the system is started, status indicators display different 
conditions to indicate the system’s status. The functions of the 
status indicators are described in the following table.

Indicator Condition Status

Cytometer status Green Ready for operation

Solid amber Fault condition

Blinking amber Warming up

Red System inoperable

Cytometer power 
button

Amber Power is off to all major 
subsystems

Green Power is on

Blinking green Shutdown process has 
started

Acquisition status Off Not previewing or acquiring 
sample

Blinking blue Previewing or acquiring 
sample

Fluidics status Off Ready

Blinking amber  Sheath fluid low

 Waste tank almost full

Red  Sheath fluid empty

 Waste tank full

 Waste tank disconnected
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Cytometer 
configurations

The BD FACSVerse system is available in the following 
configurations.

More information • Optical components (page 26)

• Fluidics components (page 28)

• System options and upgrades (page 31)

• BD FACSuite software overview (page 33)

Lasers Number of colors 

1 laser (blue) 4-color (4-0-0)

2 lasers (blue, red) 6-color (4-2-0)

3 lasers (blue, red, violet) 8-color (4-2-2)
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Optical components
Introduction This topic describes the optical components, including the 

heptagon detectors and the filter holders.

Location of optical 
components

The optical compartment is located on the front of the cytometer, 
behind the front door. The heptagon arrays for each laser are 
accessible when the door is open. The following figure shows the 
locations of the optical components.

Heptagon detector 
arrays

The heptagon detector arrays contain the filters, mirrors, and 
photomultiplier tubes (PMTs) for each laser. There is a separate 
heptagon for each laser.

Front door in 
open position

Heptagon detectors, 
one for each laser

Red 640 nm

Blue 488 nm

Violet 405 nm
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Filter holders Each channel in a detector array has a removable filter holder that 
contains a bandpass filter and a mirror for that channel. The filter 
holder has an ID chip that identifies the holder to the system so the 
software can confirm that the correct filter holder is in place.

The following figure shows a heptagon and a filter holder.

Location of lasers The system lasers and beam-steering optical components are 
located at the top of the cytometer, under the top cover. There is no 
user access to the laser area.

More information • Fluidics components (page 28)

• System options and upgrades (page 31)

• Laser and detector configurations (page 538)

• Technical specifications (page 548)

Heptagon

Filter holder

Handle

ID chip
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Fluidics components
Introduction This topic describes the main fluidics components of the 

BD FACSVerse system.

Manual tube port The manual tube port is located on the right front of the cytometer. 
A circular LED indicator at the base of the port turns green when 
the system is ready to accept a tube. 

The following figure shows the manual tube port.

The following table describes the conditions and status of the 
manual tube port indicator.

Sample injection 
tube (SIT)

The sample injection tube (SIT) is the tube that aspirates sample 
from a tube or a well and delivers it to the flow cell. 

Condition Status

Solid green Ready to accept a tube

Blinking amber SIT flush in progress, do not load 
a tube

Off Tube is loaded

Manual tube port

Tube loaded on port

LED status indicator
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Qualified tubes Only the following tubes have been qualified for use on the manual 
tube port on the cytometer.

a. For optimal performance in reducing carryover, fill to 0.5 mL or less, so 
the wash probe does not contact sample.

For information on BD part numbers for tubes, see the 
BD FACSVerse section of the BD Biosciences website.

Tube adapters You can use 15-mL, 50-mL, and Eppendorf 2-mL tubes by 
installing a tube adapter. The 15-mL and 50-mL adapters screw 
onto the top of the tubes. The Eppendorf adapter slides onto the 
tube from the side.

Tube type
Maximum 
volume

BD Falcon™ 5 mL (12 x 75-mm) polystyrenea 2 mL

BD Falcon 5 mL (12 x 75-mm) polypropylenea 2 mL

BD Trucount™ 5 mL (12 x 75-mm)a 2 mL

BD Falcon 15 mL (when used with adapter) 14 mL

BD Falcon 50 mL (when used with adapter) 45 mL

Eppendorf 2 mL (when used with adapter) 1.5 mL

50-mL adapter 15-mL adapter
Eppendorf 2-mL 
adapter
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Sheath filter The sheath filter is located on the left side of the cytometer behind 
the access door. The sheath filter should be changed every three 
months.

More information • Replacing the sheath filters (page 478)

• System options and upgrades (page 31)
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System options and upgrades
Introduction This topic describes the BD FACSVerse system options and 

available upgrades.

Category Option Description

System 
hardware

BD FACS Universal
Loader

The Loader is an optional automated loading 
system that mixes samples and delivers tube 
racks and plates to the BD FACSVerse system 
for acquisition. 

See BD FACS Universal Loader overview 
(page 502).

Handheld barcode 
reader

The handheld barcode reader plugs into the 
USB port on the system computer workstation 
and reads most current barcode standards. 

See Using the handheld barcode reader 
(page 531).

BD Flow Sensor The optional Flow Sensor provides quick and 
accurate volume measurements for 
determining cell counts in a sample at medium 
and high flow rates. 

See About the BD Flow Sensor option 
(page 525).

Optics Laser upgrades Upgrade a 1-laser system to a 2-laser or 3-laser 
system. These upgrades can be done at the 
customer site.

Fluidics Large fluidics tanks 
(10-L capacity)

The optional large volume sheath and waste 
tanks have a 10-L capacity. These tanks do not 
have a dock and are normally stored on the 
floor. 

See Fluidics tank options (page 532).

Cubitainer Sheath fluid can also be supplied from a 
BD FACSFlow cubitainer by using an optional 
adapter. 
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Applications 
and assays

FCAP Array™ 
software version 3.0 

FCAP Array software facilitates the data 
analysis of bead assays. These assays can 
detect the presence of, or determine 
concentrations for, multiple analytes (for 
example, proteins and peptides) in a sample.

BD Assurity Linc™ 
software

BD Assurity Linc software is a highly secure 
remote systems management service that 
connects BD instruments and BD technical 
support personnel. Using the BD Assurity Linc 
Agent, BD support personnel can securely 
access your workstation through an enterprise 
server and diagnose problems remotely. 

See Using BD Assurity Linc software 
(page 534).

BD assays Contact your BD representative for a current 
list of available BD assays.

Category Option Description
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BD FACSuite software overview
Introduction This topic provides an overview of the basic features and 

functionality of BD FACSuite software. BD FACSuite integrated 
multicolor flow cytometry software controls the BD FACSVerse 
cytometer and the optional BD FACS™ Universal Loader.

General software 
features

BD FACSuite software provides tools for data acquisition and 
analysis, and advanced setup and QC tools to maintain peak 
system performance. Using the software, you can customize the 
system hardware configuration and software interface to fit your 
specific workflow and application needs.

Use BD FACSuite software to build and refine experiments using 
the full array of BD reagents, to create assays from these 
experiments, and then to automatically acquire and analyze 
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samples from a list of entries in a worklist. Data can be displayed, 
saved, and exported based on your preferences.

Setup and QC BD FACSuite software provides comprehensive tools to set up the 
cytometer, assays, and experiments and to run QC on a daily basis 
to maintain precise and reproducible results and ensure consistent 
performance.

The setup and QC procedures use BD FACSuite CS&T research 
beads and assays to measure and adjust cytometer PMT voltages. 
This ensures that target values for the cytometer and assays and 
experiments are maintained.

Levey-Jennings charts are generated. Use these charts to track and 
set acceptance criteria for various performance parameters. Use 
generated QC reports to document and track the system 
performance over time.

Experiments and 
assays

In BD FACSuite software, you can measure and analyze samples 
using either assays or experiments. Both formats organize and 
specify the conditions for acquisition and analysis for tubes. 

Use assays when you want to run a specific protocol or analysis on 
samples repeatedly. Assays are run as entries in a worklist, which 
provides batch acquisition and analysis. Use experiments to test 
studies and different samples, and to develop protocols. 
Experiments are exploratory and highly customizable. You can 
define the properties of each tube and create custom tube settings 
and apply them to other tubes. You can refine an experiment and 
then save it as an assay to set the test protocols. 

While assay protocols are pre-defined to target specific data 
(markers, populations, fluorochromes, etc) and look for specific 
results, you can modify plots, gates, and other worksheet or report 
elements. Worklists provide administrative control capabilities 
such as e-signature and audit trails. BD FACSuite software runs 
both BD-defined and user-defined assays. 



Chapter 2: About the system 35

In experiments, data can be displayed in a worksheet or report 
using any combination of plots or histograms. In BD FACSuite 
software, worksheets and reports are live data portals and 
continuously display current data. You can acquire data and then 
analyze it by gating populations of interest, displaying statistics, 
and adding expressions. You can create custom, formatted reports 
that include the details you want to analyze and present in a final 
lab report.

Worklist The worklist is a list of tasks to be performed. It organizes multiple 
entries, which include tubes, tasks, status, and other information 
about the sample. Each entry task includes an assay or fluidics 
(cleaning or maintenance) procedure. 

Using the worklist, you can acquire entries, display acquisition 
data, perform analysis on the acquired entries, and export data 
automatically based on your preferences. 

With the BD FACS Universal Loader option, you can load tube 
racks or plates and run worklists in a more automated manner. 

Library The library stores and manages shared resources and assay 
properties. Resources include assays, beads, reagents, keywords, 
labels, and tube settings. You can import, add, and delete all 
resources. You can also edit keywords and assay properties.

Resources are used as elements in experiments, worklists, and 
setup and QC. For example, you can assign a tube setting to an 
experiment, or a keyword to an entry in a worklist.
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BD FACSuite software components
Introduction This topic describes the components of BD FACSuite software 

windows and describes the menus, and shortcuts you can use to 
navigate the software and perform tasks. 

Window 
components

The BD FACSuite windows consist of the following components.

 

Navigation bar Status barPanels

WorkspaceTitle bar Menu bar Message bar
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• Title bar. Displays the BD FACSVerse System product name 
and the standard window controls (minimize, maximize, 
close).

• Menu bar. Displays the following software menus.

• Message bar.  Located at the top of the window (below the 
Menu bar) and displays system messages. 

• Workspaces. Contain the panels, fields, tables, and tools 
required for a specific function. Individual workspaces are 
provided for setup and QC, experiments, worklists, and the 
library. 

Menu Description

File This menu includes specific tools and items for the current window or 
workspace. Choices include importing, exporting, printing, saving, and 
managing specific workspaces (for example, creating a new experiment, 
opening a worklist).

Edit This menu includes Cut, Copy, Paste, Delete, Undo, Redo, and other 
editing tools.

View This menu includes display control items.

Tools This menu includes user management, preferences, administration, 
tracking, and setup items.

Cytometer This menu includes cytometer cleaning, information, and control items.

Help This menu includes documentation in PDF format and basic software 
information.

Reference This menu includes the BD FACSVerse System Reference. Use the 
BD FACSVerse System Reference to view and search for information on 
using the system.

User profile 
(username)

This menu item opens the My Profile dialog. Use this dialog to manage 
your login password and user profile information.

Preferences This menu item opens the Preferences dialog. Use this dialog to set 
default system preferences.

Logout This menu item log the current user out of BD FACSuite software.
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• Navigation bar. Located at the left side of the window. Click 
the navigation bar icons to open the different workspaces. 

• Panels. Contain the tools, fields, and options for performing 
specific and detailed functions required for a workspace. You 
can maximize, minimize, or reposition panels on the screen. 

• Status bar. Located at the bottom of the window and displays 
the current cytometer connection status, fluidics status, and an 
acquisition progress bar.

About the Home 
page

The Home page is the default starting page. This page includes the 
following sections:

• Quick Start. Displays shortcuts for the most commonly used 
workflows or operations. 

• System Status. Displays the current status and serial numbers 
of the system for the fluidics, lasers, and all system 
components, and the connection status. It also displays all 
installed options.

• BD Assays. Displays the list of currently installed BD-defined 
assays.
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Quick Start 
shortcuts

The following table describes the available Quick Start shortcuts. 

Quick Start System status

BD assays

Shortcut Task Description

 

Setup & QC Opens the Setup & QC workspace 
and displays the Setup & QC tab.

Setup & QC 
Report

Opens the Setup & QC workspace 
and displays the QC Report tab.

QC 
Tracking

Opens the Setup & QC workspace 
and displays the QC Tracking tab.
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More information • System overview (page 20)

• Daily workflow (page 41)

• System documentation (page 14)

Acquire 
Data in 
Experiment

Opens the Experiment workspace 
and displays a new experiment.

Acquire 
Data in 
Worklist

Opens the Worklists workspace and 
displays a new worklist.

Analyze 
Data in 
Experiment

Opens the Experiment workspace 
and displays the Experiment 
Management tab.

Analyze 
Data in 
Worklist

Opens the Worklists workspace and 
displays the Worklists Management 
tab.

Manage 
Library

Opens the Library workspace and 
displays the categories of library 
resources.

Manage 
Users

(Administrators only) Opens the 
User Management dialog and 
displays the list of users.

Shortcut Task Description
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Daily workflow
The following diagram shows the typical daily workflow for the 
BD FACSVerse system.

More information • System setup (page 43)

• System startup and shutdown (page 111)

• Daily setup and QC (page 117)

• Experiment acquisition and analysis (page 129)

• Worklist acquisition and analysis (page 221)

• Maintenance (page 467)

Shut down
the system

Worklist

Experiment

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data

Acquire data Analyze data
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3
System setup

This section includes the following topics:

• Setting up the system (page 45)

• Setting administration preferences (page 50)

• Managing user accounts (page 51)

• Managing departments (page 52)

• Managing users (page 54)

• Setting user login and password policies (page 57)

• Importing and exporting users (page 58)

• Managing my profile (page 60)

• BD FACSuite preferences (page 61)

• Setting system (global) preferences (page 63)

• Setting setup and QC preferences (page 66)

• Setting experiment preferences (page 70)

• Setting worklist preferences (page 71)

• Setting Loader preferences (page 76)

• Setup and QC overview (page 79)

• Importing or adding a CS&T bead lot (page 82)

• Running characterization QC (page 83)
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• Running laser setup (page 86)

• Transferring CS&T bead lots (page 88)

• About tube and reference settings (page 90)

• About setup and QC reports (page 93)

• QC tracking overview (page 97)

• Setting Levey-Jennings charts preferences (page 99)

• Setting alarms and scaling ranges (page 103)

• Levey-Jennings reports (page 105)
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Setting up the system
Introduction This topic describes system setup and the setup tasks you can 

perform after system installation and configuration.   

About system setup Initial system installation and configuration are performed by your 
BD Service representative. After installation, the CS&T bead lot is 
imported, the system is characterized (characterization QC), and 
the default tube settings and references settings are created. A 
default administrator user account allows complete administrative 
access to your system. 

BD FACSuite software includes default user accounts and 
preferences. You can operate the system using these default user 
accounts and preferences, or you can add user accounts (as needed) 
and modify preferences to suit your specific needs.

Setup tasks Although you can perform many setup tasks in any order (as 
needed), the following tables describe the setup tasks and when 
they should be performed.
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Initial setup tasks 
(performed after 
installation)

These tasks are typically performed after installation. Most tasks 
can also be performed at any time as needed.

Task Purpose Who For more information

Import a CS&T 
bead lot 

Adds a CS&T bead lot 
for a new installation, or 
replaces an expiring bead 
lot file.

This is typically 
performed after 
installation, then 
whenever bead lots 
expire.

All users See Importing or adding 
a CS&T bead lot 
(page 82).

Run 
characterization 
QC

Establishes a system 
baseline.

This is typically 
performed after 
installation, then every 
six months.

Administrator 
only

See Running 
characterization QC 
(page 83).

Set 
administration 
preferences

Controls connected 
systems and software, 
and generates a system 
health report.

This is typically 
performed after 
installation, but it can be 
performed at any time as 
needed.

Administrator 
only

See Setting 
administration 
preferences (page 50).

Manage users Adds user accounts or 
manages users and 
passwords.

This is typically 
performed after 
installation, but it can be 
performed at any time as 
needed.

Administrator 
only

See Managing user 
accounts (page 51).
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Daily setup tasks These tasks should be performed daily in the following order.

Task Purpose Who For more information

Run 
performance 
QC

Measures daily system 
performance.

These tasks should be 
performed daily, and as 
needed.

All users See Running daily 
performance QC 
(page 123).

Run assay and 
tube setup

Prepares the system for 
daily use.

These tasks should be 
performed daily, and as 
needed.

All users See Running Assay and 
Tube Settings Setup 
(page 125).
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Periodic setup 
tasks

These tasks can be performed as needed.

Task Purpose Who For more information

Import a CS&T 
bead lot

Adds a CS&T bead lot 
for a new installation, or 
replaces an expiring bead 
lot file.

This is typically 
performed after 
installation, then 
whenever bead lots 
expire.

All users See Importing or adding 
a CS&T bead lot 
(page 82).

Run 
characterization 
QC

Establishes a system 
baseline.

This is typically 
performed after 
installation, then every 
six months.

Administrator 
only

Running 
characterization QC 
(page 83).

Manage users Adds user accounts or 
manages users and 
passwords.

This is typically 
performed after 
installation, but it can be 
performed at any time as 
needed.

Administrator 
only

See Managing user 
accounts (page 51).

Set preferences Defines how the system 
operates, displays, and 
organizes data.

This can be performed at 
any time.

All users See BD FACSuite 
preferences (page 61).

View the system 
optical 
configuration.

Displays the current 
laser, mirror, and filters.

This can be performed at 
any time.

All users See Cytometer 
configurations 
(page 537).
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More information • Setup and QC overview (page 79)

• About tube and reference settings (page 90)

View setup and 
QC reports. 

Displays setup and QC 
results.

This can be performed at 
any time.

All users See About setup and 
QC reports (page 93).

Set up and view 
Levey-Jennings 
reports. 

Determines how 
performance is tracked 
over time.

This can be performed at 
any time.

All users See QC tracking 
overview (page 97).

Manage My 
Profile

Manages your user 
profile and password.

This can be performed at 
any time.

All users See Managing my 
profile (page 60).

Task Purpose Who For more information
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Setting administration preferences
Introduction This topic describes how Administrators can set administration 

preferences. Administration preferences are global settings that 
specify where files are saved and when the system health reports 
are generated for the cytometer. 

Procedure To set administration preferences:

1. From the menu bar, select Tools > Administration. 

The Administration dialog opens.

2. Under Logs, select the Generate System Health Report 
checkbox to automatically create system health reports.

3. (Optional) Specify a different destination folder for system 
health reports.

a. Click the Browse button to open the Browse for Folder 
dialog.

b. Select a folder and click OK. 

4. Enter or select a value in the Every x Days field to specify the 
frequency for generating system health reports. 

The default schedule is every 30 days.

Browse
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5. If FCAP Array software is installed on your system, click the 
FCAP Array Browse button and navigate to the FCAP.exe file. 

6. Click OK to save your administration preferences and close 
the dialog.

More information • Setting up the system (page 45)

• Managing user accounts (page 51)

Managing user accounts
Introduction This topic describes the user management tools in BD FACSuite 

software.

Administrators can use the User Management window to create 
and manage user accounts in BD FACSuite software, as well as 
manage and assign corresponding departments to user accounts 
and create passwords. 

User account types BD FACSuite software includes the following default user 
accounts: 

• Administrator. This account can administer and manage all 
accounts (except BD Service) and has complete access to 
administrator and operator accounts.

• Operator. This account can only administer its own profile 
with certain limitations. 

See Managing my profile (page 60).

About the User 
Management 
window

The User Management window can be accessed only by 
Administrator user accounts. The window is divided into two 
panels: a Master panel that displays a table of current users and 
user information, and a Details panel for creating or editing 
information about the user.
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User management 
tasks

The following table lists the user management tasks. 

More information • Setting up the system (page 45)

• Setting administration preferences (page 50)

Managing departments
Introduction This topic describes how to manage departments by adding, 

editing, and deleting their information. 

Departments must be created before you can assign users. This is 
an Administrator task.

Adding new 
departments

To add a new department:

1. From the menu bar, select Tools > User Management. 

The User Management panel opens. 

2. In the Departments tab, click New. 

The New Department detail panel displays at the bottom of 
the tab.

To... See...

Add or edit the department 
that is associated to a user. 

Managing departments (page 52) 

Add or edit user profiles. Managing users (page 54) 

Set the password policy for 
your users.

Setting user login and password 
policies (page 57)

Export or import user 
accounts. 

Importing and exporting users 
(page 58)
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3. Enter values in all required fields and optional fields, as 
needed. 

All values are alphanumeric text. All fields have a 30-character 
limit, except the Address field, which has a 40-character limit 
and the URL field, which has a 200-character limit. 

4. (Optional) Add a custom department field if needed.

a. Click the Settings tab. 

b. Under Custom Department Fields, click in a field and type 
a category (for example, Supervisor).

c. Click the Department tab. 

The new department field is displayed in the Department detail 
panel.

5. Click Done to add the new department settings to the table.

Editing 
departments

To edit a department:

1. In the Departments tab, select a department to edit.

The Department detail panel displays at the bottom of the tab.

2. Click Edit.

3. Edit the information as necessary. 

4. Click Done. 

Deleting a 
department

To delete a department:

1. In the Departments tab, select the department to delete. 

You can delete only one department at a time. Departments 
containing user accounts cannot be deleted.

2. Click Delete. 

The Delete Department dialog opens.

3. Click Yes to confirm the deletion. 
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The department is deleted.

More information • Managing user accounts (page 51)

• Managing users (page 54)

Managing users
Introduction This topic describes how Administrators can add a new user in 

BD FACSuite software and edit their information later.

Users must be assigned to a department in an institution. The value 
for the department can be None. 

Adding a new user To add a new user:

1. From the menu bar, select Tools > User Management. 

2. In the Users tab, click New.

The User detail panel opens at the bottom of the tab.

Several fields in this panel use pre-defined values from other 
tabs in the User Management window (Departments, 
Passwords, and Roles). 

3. Enter values for all required fields, and the optional fields as 
needed. 
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Values are alphanumeric text. 

In the field... Enter the value for...

First Name 
(Required)

First name for the user (120 characters).

Last Name 
(Required)

Last name for the user (120 characters).

User ID 
(Required)

A user ID for the user (125 characters).

Title A work title for the user (130 characters).

Status A status for the user:

 Active. For users who are granted access to BD FACSuite 
software.

 Inactive. For users who are no longer granted access to the 
software.

 Locked. For active users with expired passwords, or users who 
have exceeded the maximum number of failed login attempts.

Department 
(Required)

A department for the user, as defined in the Departments tab. The 
value can be None. 

Institution 
(Required)

An institution for the user, as defined in the Departments tab. If the 
Department value is None, then the Institution value is None. 

Email An email address for the user (must be 1–60 characters and include 
the @ symbol).

Role A role for the user (for example, Administrator or Operator 
(default)). 

Password 
Expiration Date

The date that the user password expires (for example, Password 
Expiration Date = today's date + Password Expiration Days). 
Password details are defined in the Settings tab.
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4. (Optional) Add a custom user field if needed.

a. Click the Settings tab. 

b. Under Custom User Profile Fields, click a field and type a 
category (for example, Supervisor).

c. Click the Users tab. 

The new user profile field is displayed in the User detail panel.

5. Click Done to save the new user to the Users table.

Editing user details To edit user details:

1. In the Users tab, select a row in the Users table.

2. Click Edit.

3. Edit the information as needed. 

4. Click Done.

Resetting a user 
password

To reset a user password:

1. In the Users tab, select a row in the Users table.

2. Click Edit.

3. In the User detail panel, click Reset Password to generate a 
random password, or type a new password in the Temporary 
Password field.

Phone A phone number for the user.

Temporary 
Password 
(Required) 

A temporary (initial login) password. Administrators can type 
specific passwords (case-sensitive, 4–16 characters, no spaces), or 
generate a random password by clicking Generate Password. 

At first login, the user is prompted to enter a new password.

Notes Any notes to document history, or other descriptions of the new user 
(maximum of 250 characters). 

In the field... Enter the value for...
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4. In the Password Expiration Date field, reset the expiration 
date for the new password.

5. (Optional) Click the Settings tab to view the password policies.

6. Click Done.

Making users 
inactive

To make a user inactive:

1. In the Users tab, select a row in the Users table.

2. Click Edit.

3. In the User detail panel, select Inactive in the Status menu.

4. Click Done.

The user status becomes inactive in the Users table and access 
is denied.

More information • Managing user accounts (page 51)

• Managing departments (page 52)

Setting user login and password policies 
Introduction This topic describes how to set the user login and password 

policies for BD FACSuite users. These settings are global and 
changes affect all users. This is an Administrator task.

Procedure To set user login and password policies:

1. From the menu bar, select Tools > User Management.

2. Click the Settings tab.

3. Enter values for all required fields and optional fields, as 
needed. 
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Values are alphanumeric text.

More information • Managing users (page 54)

• Importing and exporting users (page 58)

Importing and exporting users
Introduction This topic describes how to import existing user management 

information into the User Management window. This allows you 
to transfer a repository of all user information. This is an 
Administrator task.

For the field... Enter the value for...

Lockout Attempts The maximum number of allowed invalid 
attempts (None, 3, 4, or 5) before login is 
locked. When None is selected there is no 
limit on the number of attempts.

Password 
Expiration

The number of days before a password 
expires.

Password 
Expiration Warning

The number of days before a password 
expires to start displaying the password 
expiration warning.

Custom User 
Profile Fields

The number of characters allowed for each 
required custom text (1–20 characters). If 
this field is blank, it is not added to the user 
profile. 

Custom 
Department Fields

The number of characters allowed for each 
required custom text (1–20 characters). If 
this field is blank it is not added to the 
department profile.
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Importing users Importing overwrites all current user management information in 
the User Management window. Logged in user and department 
information is not affected.

To import existing user management settings:

1. From the menu bar, select Tools > User Management. 

The User Management window opens.

2. Click Import.

The Import dialog opens.

3. Navigate to the user management (XML) file you want to 
import, then click Open.

All user management related data (user profile, department, 
and settings) are imported. 

Exporting users You can export (save) user management information as an XML 
file. You can then share this information with other BD FACSuite 
systems. You cannot export the BD Service account information. 

To export user management information:

1. In the User Management window, click Export.

The Export dialog opens.

2. Type a name for the file you want to export.

3. Navigate to the target folder, then click Save.

The user management information (user profile, department, 
and settings) are exported as an XML file.

More information • Managing user accounts (page 51)

• Managing my profile (page 60)
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Managing my profile 
Introduction This topic describes how to manage your user profile and 

passwords. All users can manage profile information using the My 
Profile dialog. Only Administrators can create users and set an 
initial password in the User Management dialog.

See Managing user accounts (page 51) for administrator 
information about creating and managing user accounts.

Procedure To manage your user profile:

1. Click the user name that appears in the right corner of the 
BD FACSuite title bar.

The My Profile dialog opens.

The name, user ID, and role appear in read-only fields. 

2. Edit the personal profile information as needed. 

Changing your 
password

To change your password:

1. In the My Profile dialog, click Change Password.

The Change Password dialog opens.

The User ID field displays the current User ID. 

2. In the Old Password field, type your old password.

3. In the New Password field, type a new password. 

Passwords are case-sensitive and must be between 4–16 
characters (with no spaces).

4. In the Confirm New Password field, type your new password 
again.

5. Click OK to set the new password.
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More information • Managing user accounts (page 51)

• BD FACSuite preferences (page 61)

BD FACSuite preferences
Introduction This topic describes preferences: what they are and how they are 

managed. 

About preferences Preferences specify administration settings, display options, 
schedules for automatic actions, notifications, and other functions. 
They include settings for the System, Worklist, Experiment, Setup 
& QC, and BD FACS Universal Loader. Once set, preferences 
persist until modified.

All preferences, except system preferences, are specific to a user. 
Changes to system preferences affect all users while changes to 
other preferences affect only the logged-in user and his view. 

The ability to edit preferences is defined by your assigned role. 
Administrators can set and edit preferences for all users but 
operators can set and edit only their user-defined preferences. 
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Preferences The following table describes the various preferences.

More information • Setting system (global) preferences (page 63)

• Setting setup and QC preferences (page 66)

• Setting experiment preferences (page 70)

• Setting worklist preferences (page 71)

• Setting Loader preferences (page 76)

Preference Description

System These global preferences set system startup and behavior, 
programmed startup and shutdown, and other general system 
settings. System preferences are applied to all users. 

Setup & QC These preferences set automatic printing for Setup and QC 
reports, exported file locations, QC expirations, and QC dot plot 
parameters for specific cytometer configurations. Setup and QC 
preferences are associated to each user ID, so you can customize 
them without affecting other users. 

Experiments These preferences set preview and acquisition and default tube 
settings. Experiment preferences are associated to each user ID, so 
you can customize them without affecting other users.

Worklist These preferences set the acquisition and report delay timers, 
define exported file names and locations, and set printing options. 
Worklist preferences are associated to each user ID, so you can 
customize them without affecting other users.

Universal Loader These preferences define how samples are loaded and mixed. 
Loader preferences are associated to each user ID, so you can 
customize them without affecting other users.
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Setting system (global) preferences
Introduction This topic describes how to set the system general preferences. 

These preferences are global and are applied to all users. We 
recommend that only Administrators or lab supervisors set these 
preferences.

Setting system 
general 
preferences

This procedure describes how to set the system general preferences 
for the default startup view, a notification type to indicate 
completion of a task, language selection, and information that 
displays on assay and Setup and QC reports. 

To set the system general preferences:

1. From the menu bar, select Tools > Preferences.

The Preferences dialog opens with the System tab displayed. 

2. Select General in the left panel. 

3. Under Startup, select a default startup view from the Default 
Startup View menu. 

The selected workspace is displayed when the software opens. 

4. Under Notification Type, select a sound for each notification 
type. 

The value can be None. 

a. Click the Play button to hear the selected sound for each 
notification type.

Play button
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5. Under Reports, enter values in the Director and Address fields. 

Values can be alphanumeric characters. The information 
entered here is displayed as a header or footer on all assay and 
setup and QC reports. 

6. Continue with additional preferences, or click OK to save your 
preferences and close the dialog.

Setting cytometer 
schedule 
preferences

This procedure describes how to specify the cytometer shutdown 
and automatic startup schedules. Setting shutdown sets the time 
that the cytometer can stay idle before the system shuts down. 
Setting preprogrammed startup sets the times when the system 
automatically starts. When the schedules are set, the cytometer 
automatically starts at the scheduled time and shuts down after the 
defined idle time. 

The default setting is unprogrammed (manual).

To set cytometer schedule preferences:

1. From the menu bar, select Tools > Preferences.

The Preferences dialog opens with the System tab displayed. 

2. In the System tab, select Hardware in the left panel. 

3. Under Cytometer Schedules, select the Pre-programmed 
Startup checkbox. 

The Start-up Schedule fields are enabled. 
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4. Specify the startup days and times by selecting checkboxes for 
the days and then entering times. You can also use the current 
time icon to set the time to the current time.

 

BD FACSuite software must remain running for automatic 
startup to begin. Do not turn BD FACSuite software off at the 
end of the day. The fluidics tanks need to be refilled and the 
waste emptied as in any other startup procedure.   

5. Under Cytometer Schedules, select the Pre-programmed 
Shutdown checkbox. 

The Hours After Cytometer Idle field is enabled.

6. Specify the length of time that the system can be idle before 
shutting down (1–24 hours). 

7. Continue with additional preferences, or click OK to save your 
preferences and close the dialog.

More information • BD FACSuite preferences (page 61)

• Setting setup and QC preferences (page 66)

Current time icon
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Setting setup and QC preferences
Introduction This topic describes how to specify setup and QC preferences. 

Since these preferences are associated to each user ID, you can 
customize them without affecting other users.

Specifying report 
preferences

This procedure describes how to specify setup and QC preferences 
for printing reports and including linearity charts in 
characterization QC reports. 

To specify setup and QC report preferences:

1. From the menu bar, select Tools > Preferences.

The Preferences dialog opens.

2. Click the Setup & QC tab.

The Setup & QC Preferences dialog opens, displaying a left 
panel with a list of options and the Reports preferences in the 
right panel.

3. Select the Automatically print Setup Report checkbox to 
automatically print the setup and QC report, on the default 
printer when it is generated. 

4. Select the Include Linearity Charts in the Characterization QC 
Report checkbox to include linearity charts in the 
characterization QC report. 

This selection is available to Administrators only. 

5. Continue with additional preferences, or click OK to save your 
preferences and close the dialog.

Specifying file 
location 
preferences

This procedure describes how to specify the file location for the file 
types generated during setup and QC. Default locations can be 
specified for both automatically and manually exported files. 

To specify file locations:

1. From the menu bar, select Tools > Preferences.
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2. In the Setup & QC tab, select File Locations in the left panel.

You can view or modify the destination folder location for 
exporting generated setup reports.

3. Specify a file location (storage) path for each generated file 
type. The default location is C:\BDExport\Setup\Reports. 

a. Click the Browse button to display the Browse For Folder 
dialog.

b. Select a folder and click OK.

The new file path with the new folder name is displayed. 

4. Continue with additional preferences, or click OK to save your 
preferences and close the dialog.

Setting expiration 
preferences

This procedure describes how to specify the expiration preferences 
for characterization QC, performance QC, and LW/LNW and 
user-defined reference settings. This task is available only to 
Administrators.

To set expiration preferences:

1. From the menu bar, select Tools > Preferences.

2. In the Setup & QC tab, select the Expiration option.

Browse button
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3. Enter the expiration durations for characterization QC, 
performance QC, LW/LNW (default reference settings), and 
user-defined reference settings. 

4. Continue with additional preferences, or click OK to save your 
preferences and close the dialog.

Setting dot plot 
parameter 
preferences

This procedure describes how to specify the default X and Y dot 
plot parameters for each installed laser on the system for viewing 
during setup and QC. 

To set dot plot parameter preferences:

1. From the menu bar, select Tools > Preferences.

2. In the Setup & QC tab, select Dot Plot Parameters in the left 
panel.

3. In the Cytometer Configuration field, select a cytometer 
configuration from the list.

Item Expiration limit

Performance QC 24 hours

Characterization QC 12 months

Lyse wash/Lyse no wash settings 190 days



Chapter 3: System setup 69

4. In the parameters table, double-click any parameter in the X or 
Y column to enable editing.

5. Select a different parameter for the X and Y axis.

6. Continue with additional preferences, or click OK to save your 
preferences and close the dialog.

Plots display these parameters during characterization QC and 
performance QC for this configuration.

More information • Setting system (global) preferences (page 63)

• Setting experiment preferences (page 70)
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Setting experiment preferences
Introduction This topic describes how to set experiment preferences. 

Experiment preferences can be set for each user and apply to all 
experiments created and run by that user. 

Since these specific preferences are associated to each user ID, you 
can customize them without affecting other users.

Procedure To set experiment preferences:

1. From the menu bar, select Tools > Preferences. 

The Preferences dialog opens.

2. Click the Experiment tab.

3. In the Default Tube Settings for the new Experiment field, 
select either Lyse No Wash or Lyse Wash from the list. 

4. Continue with additional preferences, or click OK to save your 
preferences and close the dialog. 

More information • About tube and reference settings (page 90)

• Setting setup and QC preferences (page 66)

• Setting worklist preferences (page 71)
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Setting worklist preferences
Introduction This topic describes how to set preferences for running a worklist, 

details for exporting entry run packages, FCS files and results, and 
printing options.

Since these specific preferences are associated to each user ID, you 
can customize them without affecting other users.

Setting worklist 
acquisition 
preferences

To select worklist acquisition preferences:

1. From the menu bar, select Tools > Preferences.

The Preferences dialog opens.

2. Select the Worklist Preference tab.

The Worklist Preference dialog opens with a left panel that 
displays a list of options and a right panel that displays 
preferences. 

3. Select Acquisition from the left panel.

4. Under Acquisition Delay Timer:

a. Enter a value in the Preview for field to set how long to 
preview. This is the time to update PMT voltages and move 
gates before data is acquired. 

b. Select one of the following options:

• Use Acquisition Delay Timer and audible alarm for 1st 
tube in each entry

• Use Acquisition Delay Timer for all tubes

5. Under Report Delay Timer, in the Preview for field, enter a 
delay value. 

This time is the duration that the report is displayed before the 
next tube or entry acquisition is started. 

See Worklist tab overview (page 227) for more information 
about the Acquisition Delay Timer and the Report Delay 
Timer. 
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6. Continue with additional preferences, or click OK to save your 
preferences and close the dialog.

Setting entry run 
package export 
preferences

An entry run package includes all the information needed to 
replicate an entry in a different worklist. This includes acquired 
data. 

To set entry run package export preferences:

1. In the Worklist Preference tab, double-click Export, then click 
Entry Run Package to view the export options. 

2. Under Export Options, select the Export Entry Run Package 
after acquisition checkbox to automatically export the entry 
run package, the FCS file, and metadata which are generated 
and saved to the specified folder location when the entry status 
is Approved.

3. In the Location field, specify the folder where the exported 
entry run packages are stored. Click the Browse button to 
display the Browse for folder dialog.

4. If you want to create separate dated folders for exported files, 
select the Date folder checkbox.

A folder with the current date in yyyymmdd format is added to 
the Location field. For example, if the folder location field is 
BDExport\ERP\Worklists and the checkbox is selected, then 
the folder location becomes: 
BDExport\ERP\Worklists\20110701.

5. Under Naming Format, click one or more name fields, then 
select a naming element or type a name. 
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The naming elements you select are displayed in the Example 
based on selected choices field as an example. The selections 
are used in setting the name of the entry run package. 

6. Click the Delimiter field and select a delimiter to display 
between naming elements in the file name. 

7. Select the Auto numbering Starting with checkbox to add auto 
numbering to the file name.

The example field shows an example of the resulting name (for 
example, Worklist Name_001_Sample ID_001_AssayName).

8. Continue with additional preferences, or click OK to save your 
preferences and close the dialog.

Setting FCS export 
preferences

An FCS file is a file that contains the raw data. In BD FACSuite 
software, the FCS standard is 3.0.

To set FCS export preferences:

1. In the Worklist Preference tab, select Export > FCS. 

2. Under Export Options, select the Export FCS after acquisition 
checkbox to automatically export the FCS file that is generated 
when you run a worklist. 
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3. In the Location field, specify the folder where exported FCS 
files are exported. Click the Browse button to display the 
Browse for folder dialog.

4. If you want to create separate dated folders for exported files, 
select the Date folder checkbox.

A folder with the current date in yyyymmdd format is added to 
the Location field. For example, if the folder location field is 
BDExport\FCS\Worklists and the checkbox is selected, then 
the folder location becomes: 
BDExport\FCS\Worklists\20110701.

5. Under FCS Naming Format, click one or more name fields, 
then select a naming element or type a name. 

The naming elements you select are displayed in the final name 
format as an example. The selections are used in setting the 
name of the FCS file.

6. Click the Delimiter field and select a delimiter to display 
between naming elements in the file name. 

The example field shows an example of the resulting name. 

7. Continue with additional preferences, or click OK to save your 
preferences and close the dialog.

Setting result 
export preferences

Results are generated by running entry run packages in a worklist. 
One CSV file is created for the worklist. The file contains a column 
header row that contains the sample ID, assay name, export date, 
and the name of each exported result from all assay tasks in the 
worklist.

To set result export preferences:

1. In the Worklist Preference tab, select Export > Result. 

2. Under Export Options, select the Automatically export results 
checkbox to automatically export the results. 

3. In the Location field, specify the folder to export results to. 
Use the Browse button to display the Browse for folder dialog. 
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4. If you want to create separate dated folders for results files, 
select the Apply date to folder checkbox. 

5. Continue with additional preferences, or click OK to save your 
preferences and close the dialog.

Setting worklist 
printing 
preferences

To set worklist printing preferences:

1. In the Worklist Preference tab, select Print.

2. Under Print Options, select the Print Report for Entries 
checkbox to automatically print a report when the entry state 
is approved. 

3. Continue with additional preferences, or click OK to save your 
preferences and close the dialog.

More information • Setting experiment preferences (page 70)

• Exporting entries and worklists (page 268)

• Setting Loader preferences (page 76)
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Setting Loader preferences
Introduction This topic describes how to set the loading, sample carrier, and 

mixing preferences for systems equipped with the BD Universal 
Loader option. 

These preferences are user specific and are applied as the default 
each time you load sample carriers using the Loader. You can 
customize these settings for entries in a worklist and override these 
default preferences.

Setting loading 
options

To select loading options:

1. From the menu bar, select Tools > Preferences.

The Preferences dialog opens.

2. Click the Loader tab.

3. Select Loading Options in the left pane.

4. For Loader type, select Loader.

5. For Carrier Type, select a carrier (for example, 30 Tube Rack).

6. (Optional) Select the Unload Sample Carrier at end of Worklist 
Run checkbox to have the Loader unload the sample carrier 
after each worklist run completes.

7. Click OK to save your preferences and close the dialog.

Setting carrier 
properties

To set carrier properties:

1. In the Loader tab, select Carrier Properties in the left pane.
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2. Click the drop-down arrow and select a layout as shown in the 
following figure.

3. (Optional) Select the Don’t use edge positions checkbox to 
ignore edge carrier positions.

4. (Optional) In the Number of empty positions between tubes 
field, specify the number of empty positions between tubes in 
the sample carrier. 

Type a value or click the up or down arrow in the field.

Layout option Description

Horizontal linear layout starts at A1 and loads 
each tube in the row. Once a row completes, 
the tubes in the next row load starting with B1.

Vertical linear layout starts at A1 and loads 
each tube in the vertical row. Once a row 
completes, the tubes in the next vertical column 
load starting with A2.

Horizontal serpentine layout starts at A1 and 
loads horizontal rows of tubes from the carrier 
left to right, then from right to left.

Vertical serpentine layout starts at A1 and 
loads vertical columns of tubes from the carrier 
top to the bottom, then from bottom to top.
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5. (Optional) In the Number of empty positions between entries 
field, specify the number of empty positions between entries. 

Type a value or click the up or down arrow in the field.

About mixing 
settings

You can set two types of mixing settings:

• Initial mixing. The first mix that occurs when the carrier is 
run. The initial mix setting is designed to re-suspend the 
samples. Because of this, the initial mix is more aggressive than 
the interim mix.

• Interim mixing. Any subsequent mixes that are defined by time 
or interval.

These mixing settings apply to all tube racks and plates run on 
the system. 

Setting initial 
mixing settings

To set initial mixing settings:

1. In the Loader tab, select Mix settings in the left pane.

Under Initial Mixing, in the Duration (sec) field, type a value 
or click the up or down arrow.

2. In the Intensity (rpm) field, type a value or click the up or 
down arrow.

Setting interim 
mixing settings

To set interim mixing settings:

1. Under Interim Mixing, click the Interim Type field and select 
Time or Interval.

2. Set the interval according to the interim type you selected.

• If you selected Time, set the time between mixes in the 
Interval (sec) field.

• If you selected Interval, set the number of tubes between 
mixes in the Interval (tubes) field.

3. Set the interim mixing duration in the Duration (sec) field.

4. Set the interim mixing intensity in the Intensity (rpm) field.
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5. Click OK to save your preferences and close the dialog.

More information • Setting worklist printing preferences (page 75)

• Setup and QC overview (page 79)

• Defining custom sample carrier layouts (page 508)

• About mixing settings (page 512)

Setup and QC overview
Introduction This topic describes periodic and daily setup and quality control 

(QC) procedures for the cytometer. 

Use the Setup & QC workspace to perform these tasks. After you 
perform setup and QC tasks, you can view the results summary in 
the Setup & QC workspace, or view a detailed report of the task.

Pre-requisite tasks The following tasks should be completed before performing setup 
and QC tasks (as needed).

Task Description For more information

Import or add a 
a CS&T bead lot

Verify that you have a current (non-expired) 
CS&T bead lot. You must have a current bead 
lot to characterize the system, perform daily 
quality control tasks, and create tube settings 
and reference settings. 

You can import bead lot ID information from 
the BD website or add bead lot ID information 
by scanning the bead lot file card in a kit.

See Importing or 
adding a CS&T bead 
lot (page 82).

Install assays Install BD assays in BD FACSuite software. 
Follow the installation instructions included in 
the technical data sheet.

See System options 
and upgrades 
(page 31).
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Daily setup and QC 
tasks

The following setup and QC tasks should be performed daily.

Setup and QC 
task Description For more information

Performance 
QC

Performance QC is a daily process that utilizes 
a set of automated software functions and 
calculations that measure the daily operating 
efficiency of the cytometer.

See Running daily 
performance QC 
(page 123).

Assay and tube 
settings setup

Assay and tube settings setup is a daily process 
that sets the tube settings and the daily 
performance QC. This task determines the 
correct PMT voltages needed that day for each 
fluorochrome to match median fluorescence 
intensity (MFI) determined by the tube target 
value (TTV) in the tube settings. 

See Running Assay and 
Tube Settings Setup 
(page 125).

See Running 
characterization QC 
(page 83)
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Periodic setup and 
QC tasks

The following setup and QC tasks should be performed only as 
needed.

More information • Running characterization QC (page 83)

• About tube and reference settings (page 90)

• About setup and QC reports (page 93)

Setup and QC 
task Description For more information

Characterization 
QC

Characterization QC is only available to 
Administrators. This task establishes the 
measured cytometer performance baseline that 
is used for all subsequent performance QC runs. 
Characterization QC is performed at 
installation and every six months. 

See Running 
characterization QC 
(page 83).

Laser setup Laser setup is only available to Administrators. 
This task initiates an automatic re-alignment of 
the lasers, followed by performance QC to 
update settings. Run this procedure if the laser 
alignment check fails during performance QC, 
or if the % rCV is out of range.

See Running laser 
setup (page 86).

CS&T bead lot 
transfer

CS&T bead lot transfer transfers the associated 
ABD values from an existing bead lot to a new 
bead lot. This allows use of the tube target 
values and spillover values based on the new 
CS&T bead lot without having to re-
characterize the system. In addition, CS&T 
bead lot transfer transfers the %rCV criteria 
from existing lot to a new lot for automatic laser 
realignment.

See Transferring 
CS&T bead lots 
(page 88).
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Importing or adding a CS&T bead lot
Introduction This topic describes how to import or add a new CS&T bead lot 

when your existing lot has expired.

You must have a current bead lot to characterize the system, to 
perform daily quality control tasks, and to create tube settings and 
reference settings.

Importing CS&T 
bead lots

Import CS&T bead lots if you do not have the optional barcode 
reader. CS&T bead lot files can be downloaded from the BD 
website. See the information included in the CS&T bead kit for the 
specific URL and instructions for downloading bead lot files.

To import a CS&T bead lot:

1. On the navigation bar, click Library. 

The Library workspace opens.

2. In the Browser, double-click Beads and Reagents, then click 
CS&T. 

The CS&T bead information is displayed in the upper-right 
panel. 

3. From the menu bar, select File > Import. 

The Import dialog opens.

4. Navigate to the CS&T bead lot file location and select the 
appropriate CS&T bead lot file. 

5. Click Open. 

The new bead lot file is displayed in the table. The Import 
confirmation dialog opens if there are warnings or errors. 
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Adding a new CS&T 
bead lot

To add a new CS&T bead lot using the barcode scanner:

1. On the navigation bar, click Library. 

The Library workspace opens.

2. In the Browser, double-click Beads and Reagents, then click 
CS&T. 

3. In the CS&T Bead Lots table, click Scan barcode and scan the 
new bead lot barcode card inside the CS&T bead kit.

The information is automatically displayed in the CS&T Bead 
Lots table.

Running characterization QC 
Introduction This topic provides instructions for running characterization QC. 

This is an Administrator task.

About 
characterization QC

Characterization QC establishes initial values for measurements 
that are used to track cytometer performance. Characterization 
QC is performed using the normal and high-sensitivity fluidics 
modes. The measured values are specific to each cytometer 
configuration. Run characterization QC at installation (by BD 
Service), every 6 months, and when a new configuration is created. 

Before you begin • Prepare the CS&T beads according to the instructions in the 
technical data sheet. 

Procedure To run characterization QC:

1. On the navigation bar, click Setup & QC.

The Setup & QC workspace opens.
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2. In the Setup & QC Options panel, verify that the BD FACSuite 
CS&T beads have not expired.

• If the bead lot has expired, see Importing or adding a 
CS&T bead lot (page 82). 

• If your current bead lot is running low on beads, see 
Transferring CS&T bead lots (page 88). 

3. Select Characterization QC from the Task menu. 

4. Click Start. 

The Load Tube dialog opens.   

5. Load the CS&T beads on the cytometer. 

The system detects the tube and setup task begins.
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Characterization QC details for normal and high sensitivity 
fluidics modes are displayed in the Setup Tasks panel. A 
checkmark indicates that a step in the task has been 
completed. 

When all tasks are complete, a dialog opens and indicates 
whether the task passed or failed. 

6. Click Yes to view the report for the QC task, or click No to 
close the dialog.

7. Unload the tube.

More information • Setup and QC overview (page 79)

• Running laser setup (page 86) 

• Viewing a setup and QC report (page 94)
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Running laser setup 
Introduction This topic describes how to perform laser setup using CS&T 

beads. This is an Administrator task.

About laser setup Laser setup initiates an automatic re-alignment of the lasers, 
followed by performance QC to update the settings. Run this 
procedure if the laser alignment check fails during performance 
QC, or if the %rCV is out of range. 

Before you begin • Run the monthly clean procedure. 

• Prepare the CS&T beads according to the instructions in the 
technical data sheet. 

Procedure To run laser setup:

1. In the navigation bar, click Setup & QC.

The Setup & QC workspace opens.

2. In the Setup & QC Options panel, select Laser Setup from the 
Task menu. 

3. In the CS&T Bead Lot ID field, select the appropriate bead 
lot. 

4. Click Start. 

The Load Tube dialog opens, indicating the lot of beads to use.

5. Load the tube of CS&T beads. 

The system detects the tube and setup task begins.
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Laser setup details for normal and high sensitivity fluidics 
modes are displayed in the Setup Tasks panel. A checkmark 
indicates that a step in the task has been completed.

If the laser setup task completes successfully, a performance 
QC task begins. When all tasks are complete, a dialog opens 
and indicates whether the task passed or failed. 

6. Click Yes to view the report for the QC task, or click No to 
close the dialog.

7. Unload the tube.

More information • Setup and QC overview (page 79)

• Running characterization QC (page 83)

• Viewing a setup and QC report (page 94)

• Performing the monthly clean procedure (page 475)
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Transferring CS&T bead lots
Introduction This topic describes how to transfer to the current performance 

and characterization values used with a bead lot to a new CS&T 
bead lot when the existing lot has expired. This ensures consistency 
across bead lots. This is an Administrator task.

Before you begin • Add the new CS&T bead lot to the library. See Importing or 
adding a CS&T bead lot (page 82) for instructions.

• Prepare the old and new lots of CS&T beads in separate tubes 
according to the directions in the technical data sheet.

Procedure To transfer CS&T bead lots:

1. On the navigation bar, click Setup & QC. 

The Setup & QC workspace opens.

2. In the Setup & QC Options panel, click CS&T Bead Lot 
Transfer. 

3. Select the old CS&T bead lot ID from the Old CS&T Bead Lot 
ID menu.

4. Select the new CS&T bead lot ID from the new CS&T Bead 
Lot ID menu.

If your current bead lot has expired and there are no new lots 
in the New CS&T Bead Lot ID list, then click New Lot to add 
a new bead lot. See Importing or adding a CS&T bead lot 
(page 82) for instructions.

5. In the Setup & QC Options panel, click Start.   

The Load Tube dialog opens.   

6. Load a tube with the old CS&T bead lot indicated in the 
dialog. 
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The system detects the tube and setup task begins. Old CS&T 
bead lot details for normal and high sensitivity fluidics modes 
are displayed under Old CS&T Bead Lot in the Setup Tasks 
panel. A checkmark indicates that a step in the task has been 
completed. 

When all of the old CS&T bead lot tasks have completed, the 
Load Tube dialog opens.

7. Unload the old CS&T tube and load the tube with the new 
CS&T bead lot. 
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New CS&T bead lot details for normal and high sensitivity 
fluidics modes are displayed under New CS&T Bead Lot in 
the Setup Tasks panel. A checkmark indicates that a step in the 
task has been completed.

When all tasks are complete, a dialog opens and indicates 
whether the task passed or failed.

8. Click Yes to view the report for the QC task, or click No to 
close the dialog.

9. Unload the tube and place a tube of DI water onto the port.

More information • Setup and QC overview (page 79)

• Running characterization QC (page 83)

• Importing or adding a CS&T bead lot (page 82)

• Viewing a setup and QC report (page 94)

About tube and reference settings
Introduction This topic describes tube settings and how they are used to ensure 

reproducible results from day to day and from system to system. 
This topic also describes reference settings and how they relate to 
tube settings.

About tube settings Tube settings include a collection of attributes that are used to 
place the positive population at the same position (brightness) 
whenever the tube settings are applied to tubes. These values are 
called tube target values (TTVs). Tube settings allow the system to 
produce comparable results from day to day and from system to 
system.
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Every tube includes an associated spillover value (SOV) matrix by 
default. If a tube setting has associated measured spillover values, 
the combination of the tube setting and the associated measured 
spillover values are referred to as reference settings. If there are no 
associated measured spillover values, the spillover values are 
automatically calculated based on the existing LW reference values 
and the current PMT voltages. 

Tube settings include the following information. 

How tube settings 
are created and 
saved

You can create new tube settings after you create a tube and 
modify settings in an experiment. These tube settings are stored in 
the library and saved with the experiment. If you create a user-
defined assay from the experiment, the tube settings are included 
with the assay. See Creating tube settings (page 184).

Tube settings are included when you export an experiment, a user-
defined assay, or an entry run package (ERP) by running entries in 
a worklist. 

When you import an exported experiment, user-defined assay, or 
ERP onto a different workstation, then run Assay and Tube 
Settings setup, the tube settings from these imported experiments, 

Item Description

Tube Target Values 
(TTVs)

Tube target values determine the median target channel of the positive 
population for each fluorescence and scatter parameter.

These values are the a ratio of median fluorescence intensity (MFI) to 
assigned BD unit (ABD) for a tube.

Threshold A level of discrimination to eliminate unwanted events. Only events 
with parameter values above the threshold are acquired.

Flow Rate The rate that the sample flows through the flow cell in the cytometer 
(high, medium (default), low, or high sensitivity).

Window Extension Adjusts the time the system measures the signal (pulse).

Area Scaling Factor 
ASF(R) ratio

Ratio of the area scaling factor set for the tube to the area scaling 
factor determined by the performance QC.



BD FACSVerse System Reference92

assays, and entries ensure that the tubes run at the same intensity 
on each system and generate reproducible results.

How tube settings 
are used to ensure 
reproducible 
results

BD FACSuite software uses system measurements (collected during 
performance QC) and tube settings to ensure that experiments and 
worklists generate reproducible results on from day to day, over 
time, and on different systems. 

When you run performance QC and then run assay and tube 
settings setup in the Setup & QC workspace, PMT voltages and 
spillover values are set based on the tube settings.

This process:

• Reduces daily setup time

• Enables assays and experiments to be used on different systems 
and labs and produce equivalent results

• Sets initial PMT voltages and spillover values (SOVs) for BD-
defined assays and any user-defined assays

• Provides the ability to add spillover values for a single 
fluorochrome without having to run each fluorochrome again

About reference 
settings

Reference settings are tube settings and the associated spillover 
values that have been measured using fluorescence control tubes. 
Tube settings that have associated measured spillover values are 
indicated by an X in the Reference Settings column of the Tube 
Settings table (in the BD FACSuite Library).
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If a tube setting has associated measured spillover values, they are 
automatically applied to the tube when you preview or acquire the 
tube. 

If your tube setting does not have associated measured spillover 
values, the spillover values are calculated. In this case, the spillover 
values applied to any tube using this tube setting are derived from 
the reference spillover values and actual MFI measurements from 
performance QC and assay and tube settings setup.

If you modify any values that are part of a tube setting, the 
software automatically calculates modified (star) tube settings and 
recalculates the spillover values based on the default LW reference 
setting and MFI and PMT voltages. Calculated spillover values are 
not saved and cannot be reused except by copying and pasting a 
tube from one experiment to another.

Using measured spillover values increases the accuracy of the 
compensation matrix compared to using the calculated settings.

More information • Setup and QC overview (page 79)

• Running Assay and Tube Settings Setup (page 125)

• Creating tube settings (page 184)

• Creating reference settings (page 187)

About setup and QC reports
Introduction This topic describes the content of the setup and QC reports. You 

can access these reports in the Setup & QC workspace, in the 
Setup and QC Reports tab.
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About setup and 
QC reports

Setup and QC reports contain information about the system, 
detectors settings, lasers, setup bead lots, and cytometer settings. 
They are generated after characterization QC, performance QC, 
and laser setup. Each time a procedure is completed, two reports 
are generated, one for each fluidics mode: normal and high 
sensitivity. Information in the reports varies depending on the 
cytometer being used. 

Viewing a setup 
and QC report

To view a setup and QC report:

1. In the Setup & QC workspace, click the Setup and QC Report 
tab.

2. In the Report Browser, click the report you want to view.

The following sections describe report details.

System information The top section displays the cytometer type, name, configuration, 
serial number, options, last characterization and QC date, and user 
and institution identity. 

Summary This section displays pass/fail status. Pass status is indicated by the 
word PASSED. Fail status in indicated by the word FAILED. 

Warnings Warnings are displayed when the current values are outside of the 
acceptable range. Red text indicates out-of-range or expired 
values. 

Section or field Description

Parameter Laser power and/or laser current

Value Current value of the parameter

Range Expected value range for the parameter

Message Reason for the warning
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Detector settings QC reports for characterization QC and performance QC are 
different. This table displays information that is displayed in a 
characterization QC report. 

Section Field Description

Detector Name Name for the detector

Mirror Name of the mirror used with the detector

Filter Description of wavelengths transmitted

Position Location of the filter holder with mirror 

PMT Voltage Measured PMT voltage

Slope of Gain Slope of the PMT voltage vs brightness for bright beads 
(log MFI vs log PMT voltages)

Bead (bright, 
mid, or dim)

Median Median fluorescence intensity (MFI) value of the specific 
beads

%rCV Percent robust coefficient of variation of the bright beads

Linearity Min 
Channel

Minimum value for the acceptable linear range of the 
detector

Linearity Max 
Channel

Maximum value for the acceptable linear range of the 
detector

Resolution Sensitivity MFI of the bright bead to the two times the standard 
deviation of noise of a given detector. 

Electronic 
noise rSD

Robust standard deviation (rSD) of the electronic noise in 
the particular detector used to predict the minimum 
acceptable signal levels required for the best attainable 
resolution and sensitivity for the system

Qr Relative fluorescence detection efficiencyused for 
describing the light collection efficiency of a detector

Br Relative optical background signalused for tracking the 
optical background noise levels in a detector
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Laser settings The measurements shown in this section of the report are 
cytometer-dependent.

Info This section displays information on the setup beads and the 
cytometer settings that were used. 

Measurement Description

Laser Laser name

Position Location of each laser

Delay (Trigger on FSC) Laser delay values when thresholding on FSC

Delay (Trigger on 
Fluorescence)

Laser delay values when thresholding on 
fluorescence

Area Scaling Factor Area scaling factors that are determined by 
setting area and height values on the bright 
3-µm beads

Power Actual (mW) Laser power measured in milliwatts

Power Spec (mW) Laser power specification in milliwatts 

Current (mA) Laser current measured in milliamperes

Current Spec (mA) Laser current specification in milliamperes

Field Description

Bead Lot ID Setup bead identifier on the kit label

Expiration date Date after which the bead activity is not 
guaranteed

Windows extensions The amount of time added to collect the 
signal pulse above the threshold

FSC area scaling factor Area scaling factor that is determined by 
setting the FSC area and height values on the 
bright 3-µm beads
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Comments The Comments section displays comments that were previously 
added to the report. Click the Comments icon to add a new 
comment to the report. 

Linearity results This section of the report shows linearity plots for each detector.

A detector’s linear range is determined by measuring the MFI ratio 
of bright beads to mid beads across the detector’s dynamic range. 
The ratio values from the middle of the range, which is known to 
be linear, are averaged and compared against individual ratios. If 
the difference between the measured ratio and the averaged ratio is 
greater than 2%, the results are not considered linear.

More information • Setup and QC overview (page 79)

• Running characterization QC (page 83)

QC tracking overview
Introduction This topic describes how to use QC tracking tasks to set up Levey-

Jennings charts.

About QC tracking Using the QC Tracking tab, you can set the performance values 
you want to display in the Levey-Jennings (LJ) charts. Levey-
Jennings charts and reports provide a visual display of instrument 
performance. Time is plotted on the x-axis. A data point is plotted, 
indicating its position relative to the mean. The distance from the 
mean is measured in standard deviations (SDs). 

When the system is functioning at peak performance, the 
variability will be small (within one SD). If the performance 
declines, the variability and SD range will increase. The data 
should not fall more than 3 SD higher or lower than the mean. 
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Any user can specify scaling options and alarm boundaries, but 
only Administrators can customize the chart display. 

QC tracking tasks The following QC tasks can be performed as needed.

More information • About setup and QC reports (page 93)

• Levey-Jennings reports (page 105)

QC tracking task Description For more information

Set up Levey-
Jennings chart 
preferences

These preferences determine which set of data 
will be displayed in LJ charts and reports 
based on different filters including bead lot, 
date range, filter status, and fluidics mode. 
These preferences are specific to each user ID.

See Setting Levey-
Jennings charts 
preferences (page 99).

Setting alarms 
and scaling 
ranges

The alarm and scaling ranges for LJ charts 
and reports determine how the performance 
data is scaled and which alarm criteria is used 
in LJ charts and reports. This determines 
when to flag data points as out of range in 
reports.

See Setting alarms and 
scaling ranges 
(page 103).
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Setting Levey-Jennings charts preferences
Introduction This topic describes how to set the data display and tracking 

preferences for Levey-Jennings (LJ) charts and reports. These 
preferences determine which set of data will be displayed in LJ 
charts and reports based on different filters including bead lot, date 
range, filter status, and fluidics mode. These preferences are 
specific to the user currently logged in. 

Setting data 
display preferences 

To set data display preferences for LJ reports:

1. On the navigation bar, select Setup & QC. 

The Setup & QC workspace opens. 

2. Click the QC Tracking tab.

3. In the Cytometer Configuration field, select an available 
cytometer configuration from the list. 

 

4. Click the LJ Charts tab.

The LJ Charts tab opens with a Preferences panel on the left 
and a Charts panel on the right. 

5. In the Preferences panel, click and expand the Data Display 
box to view the list of preferences.

Click to collapse
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6. In the CS&T Bead Lot ID(s) field, select a bead lot ID.

7. Under Fluidics Mode, select Normal or High Sensitivity mode.

8. Under Filter by Date Range, select a date filtering preference.

9. Under Filter By Status, select a status filtering preference.

10. Under X-Axis Label, select a label preference.

Setting data 
tracking 
preferences

To set data tracking preferences for LJ reports:

1. On the navigation bar, select Setup & QC. 

The Setup & QC workspace opens. 

2. In the left panel, click and expand the Data Tracking section to 
view the list of performance measurements.
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See Measurements (page 106) for information about the 
measurement categories.

3. Under Channel Data, select an option checkbox to display the 
channel data you want to track in the LJ chart, either using the 
controls for selecting all channels, columns, rows, or 
individual checkboxes. 

4. Under Laser Data, select an option checkbox to display the 
channel data you want to track in the LJ chart, either using the 
controls for selecting all channels, columns, rows, or 
individual checkboxes.

Selects all channels

Selects a column

Selects individual

Selects a row
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As measurements are selected for display, their corresponding 
LJ charts are displayed in the Charts panel. 

5. Complete any of the following actions as needed:

• Click View Report to view the selections in a sample 
report.

• Click Comments to add a comment to the report. 

• Use the icons on the top right of each chart to copy or 
zoom in on the charts individually.

• Use the slider to the right of the LJ report to vary the size of 
the report. 
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More information • About setup and QC reports (page 93)

• Levey-Jennings reports (page 105)

• Glossary definition: fluidic mode (page 578)

Setting alarms and scaling ranges
Introduction This topic describes how to set the alarm and scaling ranges for 

Levey-Jennings (LJ) charts and reports. 

These preferences determine how the performance data will be 
scaled and what alarm criteria will be used in the LJ charts and 
reports, and impact when data points are flagged as out of range in 
reports. 

Procedure To set alarms and scaling ranges for LJ charts:

1. On the navigation bar, select Setup & QC. 

The Setup & QC workspace opens.

2. In the QC Tracking tab, click the Alarm Ranges & Scale tab.

3. In the Cytometer Configuration field, select an available 
cytometer configuration from the list. 

The cytometer configuration should be the same as the one 
used for setting up the LJ charts.

4. In the left panel, click and expand the Tracked Data section to 
view the list of data types, channel data, and laser data, if 
necessary.

5. Under Channel Data, select a measurement in the left panel 
(for example, select PMT). 
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6. In the Channel column in the right panel, select a channel in 
one of the groups, either ∆PMT or PMT (for example, select 
FSC).

7. In the Scale column, select a scaling option. 

a. Select Auto to set an automatic scale on the y-axis based on 
the data. Select the checkboxes for each channel you want 
to autoscale. The min value is set to zero and the max value 
is set to a specific value based on the channel. 

b. Clear the Auto checkbox for any channels you want to 
adjust manually. Click a Min or Max field and type a 
minimum or maximum value. 

8. Under Alarm Ranges, in the Boundary column, click a row 
and select a boundary type. The boundary is set to Mean +/-3 
standard deviations.

9. Under Alarm Ranges, in the Min and Max columns, double-
click in a Min or Max field and type a minimum or maximum 
value. 

More information • Levey-Jennings reports (page 105)
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Levey-Jennings reports
Introduction This topic describes the content of Levey-Jennings reports. You can 

access these reports in the Setup & QC workspace, in the QC 
Tracking tab.

About Levey-
Jennings reports

Levey-Jennings reports contain information about the system, 
detectors settings, lasers, setup bead lots, and cytometer settings. 
They are generated for each fluidics mode that is selected. Levey-
Jennings reports are organized into sections that display different 
system details, which are dependent on the preferences selected by 
the Administrator.   

Viewing Levey-
Jennings reports

To view a Levey-Jennings report:

1. In the Setup & QC workspace, click the QC Tracking tab.

2. In the LJ Charts tab, click View Report.

The report opens.

System information The top section of the report displays the cytometer type, 
cytometer name, serial number, options, last characterization QC 
date, user, and institution. 

Warnings Warnings appear when the current values are outside the 
acceptable range. Red text indicates out-of-range or expired 
values. 

Section or field Description

Parameter Fluorochrome name

Value Current value of parameter

Range Expected value range for the parameter

Warning Reason for the warning
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Measurements Following is a list of possible measurements you can track in the 
Levey-Jennings chart. For each graph, there is a legend. 

 

Legend Description

CST Lot Setup bead identifier on the kit label

Setup Status Current setup status of pass, warning, or fail

Setup Type Task performed to generate a report: 
performance QC, characterization QC, or 
CS&T bead lot transfer

Measurement Description

PMT Voltage Photomultiplier tube voltage (PMTV) required 
to place the bright bead population

∆ PMT Voltage Difference between PMT voltage value for the 
characterization check and current 
performance check

Qr Relative fluorescence detection efficiency, a 
measurement used for tracking the light-
collection efficiency of a detector

Br Relative optical background signal,a 
measurement used for tracking optical 
background levels in a detector

Bright Bead %rCV Percent robust coefficient of variation of the 
bright beads,a measurement used in the 
calculation of photon detection efficiency (Qr)

Bright Bead Median MFI value of bright beadsa measurement 
used in the calculation of photon detection 
efficiency (Qr) and linearity

Linearity The acceptable linear range is the ratio of 
bright beads to dim beads across the detector 
response. If the mean of the ratio is greater 
than 2%, the results are not considered linear. 
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More information • QC tracking overview (page 97)

• Setting Levey-Jennings charts preferences (page 99)

• Setting alarms and scaling ranges (page 103)

Linearity (±2%) Min Minimum value (±2%) for the acceptable 
linear range of the detector

Linearity (±2%) Max Maximum value (±2%) for the acceptable 
linear range of the detector

Sensitivity Instrument sensitivity (IS) is a fluorescence-
normalized, detector-specific measure of signal 
to noise. For a given detector, the value is 
defined as the median fluorescence intensity 
(MFI) of the CS&T bright bead divided by 
twice the standard deviation of combined 
noise. 

Power (mW) Laser power, measured in milliwatts

Current (mA) Laser current, measured in milliamperes

Delay trigger to FSC Laser delay values when thresholding on FSC

Delay trigger to fluor Laser delay values when thresholding on 
fluorescence

Measurement Description
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Part 2: Using the system

This part includes the following sections:

• System startup and shutdown (page 111)

• Daily setup and QC (page 117)

• Experiment acquisition and analysis (page 129)

• Worklist acquisition and analysis (page 221)
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4
System startup and shutdown

This section includes the following topics:

• Performing system startup (page 112)

• Performing manual system shutdown (page 113)

• Performing automated system shutdown (page 115)
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Performing system startup

Introduction This topic describes how to perform the normal system startup 
procedure. You can also set up a pre-programmed time and day to 
start the system automatically. 

See Setting system (global) preferences (page 63) for more 
information.

Daily consumables The following table describes the required consumables for daily 
operation of the system.

Procedure To start up the system:

1. Turn on the power to the system by pressing the Power button.

The Power button turns green when system power is on. Allow 
20 minutes for the lasers to warm up before starting any 
acquisition work.

2. Log in to BD FACSuite software.

a. Double-click the BD FACSuite icon to start BD FACSuite 
software.

b. Enter a username and password to log in, then click OK.

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data
Shut down
the system

Item Requirement Supplied by

Bulk fluids  BD FACSFlow sheath solution

 Bleach (for the waste tank)

 Deionized (DI) water 

 BD

 User

 User

Setup beads  BD FACSuite CS&T research beads  BD
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3. Verify that the software is connected to the cytometer by 
looking for the green Connected status icon in the lower-left 
corner of the workspace.

4. Check the fluid levels.

a. Check the sheath tank to ensure that there is enough sheath 
fluid to perform your work.

b. Check the waste tank to ensure there is adequate capacity.

5. Verify that the fluidics system is ready by looking for the green 
Fluidics status icon in the lower-right corner of the workspace.

More information • Refilling the sheath tank (page 471)

• Emptying the waste tank (page 473)

Performing manual system shutdown

Introduction This topic describes the manual system shutdown procedure. Use 
this procedure to manually perform the daily cleaning and 
shutdown of the system.

Alternatively, you can program the system to shut down 
automatically. See Performing automated system shutdown 
(page 115).

Required materials • 1 tube containing 2 mL of 10% bleach solution

• 1 tube containing approximately 3 mL of DI water

• Disposable towels or wipes.

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data
Shut down
the system
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Shutting down the 
system

To manually shut down the system:

1. From the menu bar, select Cytometer > Daily Clean. 

The Daily Clean dialog opens.

2. Place a tube containing 2 mL of 10% bleach solution on the 
manual tube port, then click Continue.

3. When prompted, place a tube containing approximately 3 mL 
of DI water on the manual tube port, then click Continue.

The dialog closes when the process is complete.

4. Leave a tube containing 2 mL of DI water on the manual tube 
port.

5. Clean external surfaces.

a. (Optional) Wipe down the external surfaces of the 
cytometer and work area.

b. Dispose of the used cleaning materials in biohazard 
containers.

6. From the menu bar, select Cytometer > Shutdown. 

The Cytometer Shutdown dialog opens.

7. Click Yes.

The Power button blinks green for a few seconds, then power 
to the system turns off and the Power button turns amber.

Note that a tube of DI water should be loaded on the manual 
tube port whenever the system is not in use.
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Shutting down the 
software (optional)

If you are using the pre-programmed startup feature, do not 
perform the following steps. The software must remain running to 
enable startup at the defined day and time.

1. Log out of the software.

a. From the right side of the menu bar, click the Log Out 
button.

b. In the confirmation dialog, click Yes.

2. Exit the software. 

a. From the main menu, select File > Exit. 

More information • Performing system startup (page 112)

• Performing automated system shutdown (page 115)

Performing automated system shutdown

Introduction This topic describes the process for shutting down the system by 
running a worklist on the Loader. 

Automated 
shutdown using the 
worklist

Automate the shutdown process using the worklist by adding 
cleaning and shutdown entries to a worklist and then running that 
worklist using the Loader. 

For this process, you need to prepare a tube with a 2mL of 10% 
bleach solution and a tube containing approximately 3 mL of DI 
water. Place the tubes in a 30- or 40-tube rack (plates cannot be 
used). Next, create new worklist, or open an existing worklist, 
then add cleaning and shutdown entries to the end of the worklist.

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data
Shut down
the system
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For details about creating cleaning and shutdown entries in a 
worklist, see Adding fluidics cleaning or shutdown to a worklist 
(page 239).

The following figure shows a sample worklist with cleaning and 
shutdown entries added.

Once the entries are added to a worklist, you can open the worklist 
and run it.

Running an 
automated 
shutdown using a 
worklist

To run an automated shutdown using a worklist:

1. Open the shutdown worklist.

2. Run the worklist.

When the worklist is finished, the system power turns off.

3. Place a tube of DI water on the manual tube port.

Note that a tube containing 2 mL of DI water should be 
loaded on the manual tube port whenever the system is not in 
use.

More information • Acquiring data in a worklist (page 249)



5
Daily setup and QC

This section includes the following topics:

• About the Setup and QC workspace (page 118)

• Daily setup and QC workflow (page 122)

• Running daily performance QC (page 123)

• Running Assay and Tube Settings Setup (page 125)
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About the Setup and QC workspace
Introduction This topic describes the tabs in the Setup and QC workspace. 

The Setup and QC workspace includes multiple tabs that you use 
to perform different setup and quality control tasks, view reports, 
track QC over time, and view or modify the cytometer optical 
configuration.

To open the Setup and QC workspace, click Setup & QC on the 
navigation bar.

Setup & QC tab The Setup and QC tab includes the following panels:

• Setup & QC Options. Use this panel to select setup and QC 
tasks, select CS&T bead lots, and start or abort setup and QC 
operations.

• Cytometer. This panel displays the current cytometer 
configuration and the current cytometer status. Status displays 
the system status (including real-time status for the SIT), 
fluidics, and lasers. This box also reminds you when you need 
to run system cleaning protocols.

You can click the arrow icon in the Status title bar to expand 
or collapse this section.
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• Setup Tasks. This panel displays real-time status of setup and 
QC task steps. Green checkmarks indicate completed steps. 
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Setup and QC 
Reports tab

In the Setup and QC Reports tab, the Reports Browser table lists 
all of the reports that are generated when you perform a 
characterization, performance, or laser setup QC task. Separate 
reports for each fluidics mode (normal and high sensitivity) are 
generated for each setup and QC task. 

Reports contain details about the system, detector settings, lasers, 
setup bead lots, and cytometer settings. Click a report in the table 
to view, print, or export the report. 

QC Tracking tab Use the QC Tracking tab to set the performance values that you 
want to display in Levey-Jennings charts and the alarm ranges and 
scales. Levey-Jennings charts are used to track the instrument 
performance over time.

Assay Setup 
Reports tab

In the Assay Setup Reports tab, the Assay Setup Reports table lists 
all of the reports that are generated when you perform assay and 
tube settings setup. 

Reports contain details about the assay, cytometer configuration, 
setup bead lot, and user. Click a report in the table to view, print, 
or export the report. 
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Configuration tab Use the Configuration tab to view the current cytometer 
configuration and the details for each laser and detector.

You can assign fluorochromes to detectors, and view, print, and 
export configuration reports.

More information • QC tracking overview (page 97)

• Daily setup and QC workflow (page 122)

• About setup and QC reports (page 93)
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Daily setup and QC workflow

Introduction This topic describes the setup and QC tasks you need to complete 
before you acquire and analyze data using experiments or 
worklists. 

Daily setup and QC 
tasks

Perform the following setup and QC tasks each day.

More information • About the Setup and QC workspace (page 118)

• Setup and QC overview (page 79)

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data
Shut down
the system

Stage Description

1 Run performance QC to measure the daily operating 
efficiency of the cytometer.

See Running daily performance QC (page 123).

2 Run Assay and Tube settings setup to determine the PMT 
voltages needed to meet the median fluorescence 
determined by the tube target values in the tube settings. 

See Running Assay and Tube Settings Setup (page 125).
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Running daily performance QC
Introduction This topic describes how to run daily performance QC in the Setup 

& QC workspace.

A typical performance QC should take approximately 10 minutes 
if the CS&T beads have already been prepared.

Before you begin • Prepare a tube with BD FACSuite Research CS&T beads 
according to the directions in the technical data sheet.

• If you are planning to run QC with a new bead lot, add the 
new bead lot to the library first. 

Procedure To run daily performance QC:

1. On the navigation bar, click Setup & QC.

The Setup & QC workspace opens.

2. In the Setup & QC Options panel, verify that Performance QC 
is selected. 

3. Verify that the correct CS&T bead lot ID is selected. 

4. Click Start. 

The Load Tube dialog opens. 

5. Load the tube of CS&T beads onto the manual tube port. 

The system detects the tube and setup task begins.
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The details for normal and high sensitivity fluidics modes are 
displayed in the Setup Tasks panel. A checkmark indicates that 
a step in the task has been completed.

When all tasks are complete a dialog opens and indicates 
whether the task passed or failed.

6. Click Yes to view the report for the QC task or click No to 
close the dialog.

7. Unload the tube.

Next step Running Assay and Tube Settings Setup (page 125)
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More information • Setup and QC overview (page 79)

• Viewing a setup and QC report (page 94)

• About the Setup and QC workspace (page 118)

• Daily setup and QC workflow (page 122)

• Importing or adding a CS&T bead lot (page 82)

Running Assay and Tube Settings Setup 
Introduction This topic describes how to run daily assay and tube settings setup 

in the Setup & QC workspace.

Daily assay and tube settings setup is used to ensure that assays 
and experiments run properly. Use this procedure to select the 
assays and tube settings that you want to update for use today.

Before you begin Run daily performance QC.

Procedure To run assay and tube settings setup:

1. On the navigation bar, click Setup & QC.

The Setup & QC workspace opens.

2. In the Setup & QC Options panel, select Assay & Tube 
Settings Setup. 

3. Click Select.

The Assays and Tube Settings tabs open in the right panel. 

4. In the Assays tab, from the Assays list, select the checkboxes 
for the assays that you want to set up or select the checkbox in 
the header row to select all assays.



BD FACSVerse System Reference126

Selecting an assay automatically selects the appropriate tube 
settings.

5. If you want to update a different tube setting, click the Tube 
Settings tab and select a checkbox. 

Note that if you run performance QC, the lyse/wash and lyse/
no-wash tube settings are automatically updated.

6. In the Setup & QC Options panel, click Start. 

The Load Tube dialog opens. 

7. Load the tube of CS&T research beads. 

The system detects the tube and setup task begins.
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The details for normal and high sensitivity fluidics modes are 
displayed in the Setup Tasks panel. A checkmark indicates that 
a step in the task has been completed.

When all tasks are complete, a dialog opens and indicates 
whether the task passed or failed. 

8. Click Yes to view the report for the QC task, or click No to 
close the dialog.

9. Unload the tube.

The assays that were selected for assay and tube settings setup 
are now displayed on the opening page of the Setup & QC 
workspace with a status of OK.
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More information • About the Setup and QC workspace (page 118)

• Setup and QC overview (page 79)

• About setup and QC reports (page 93)

• Viewing a setup and QC report (page 94)

• Running characterization QC (page 83)

• Experiment overview (page 131)
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Experiment acquisition and analysis

This section includes the following topics:

• Experiment overview (page 131)

• Using the Manage Experiments tab (page 134)

• Locating existing experiments (page 137)

• Importing and exporting experiments (page 139)

• Experiment acquisition workflow (page 141)

• Creating and opening experiments (page 142)

• Using the Experiment tab (page 146)

• Building experiments (page 155)

• Creating tubes (page 156)

• Creating plots in a worksheet (page 158)

• Previewing data in plots (page 161)

• Adjusting the cytometer settings for a tube (page 163)

• Drawing gates in plots (page 164)

• Modifying tube properties (page 167)

• Setting general tube properties (page 169)

• Viewing tube parameters (page 171)

• Modifying the compensation matrix (page 172)
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• Editing reagent labels (page 174)

• Working with keywords (page 176)

• Setting acquisition stopping rules (page 179)

• Creating tube settings (page 184)

• Creating reference settings (page 187)

• Adding fluorochromes to a reference setting (page 195)

• Updating reference settings in an experiment (page 198)

• Saving modified reference settings (page 201)

• Acquiring data in an experiment (page 202)

• Experiment analysis (page 204)

• Creating experiment analysis reports (page 206)

• Modifying experiment worksheets and reports (page 208)

• Formatting and printing a report (page 213)

• Exporting experiment reports as PDFs (page 217)

• Creating a user-defined assay from an experiment (page 218)
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Experiment overview 
Introduction This topic describes experiments, the Experiment workspace, and 

provides typical workflow steps for creating, editing, and saving 
experiments. This basic workflow includes only the basic required 
elements for creating and acquiring data in an experiment using 
BD default settings. 

See Using the Manage Experiments tab (page 134) for more 
information about optional features and functions.

About the 
Experiment 
workspace

The Experiment workspace includes the Manage Experiments tab 
and Experiment tab which represents an open experiment.

To open the Experiment workspace, click Experiments on the 
navigation bar.

Use the Manage Experiments tab to create new experiments, 
preview and open existing experiments, organize experiments, 
filter and search for experiments, and share them with other users. 
Use the BD FACSuite menus to rename, import, or export 
experiments.



BD FACSVerse System Reference132

Use the Experiment tab to develop your experiment, adjust 
settings, set properties, acquire and visualize tube data, and 
analyze the data using different analysis tools. A separate tab is 
created for each open experiment.

Manage Experiments tab
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More information • Using the Experiment tab (page 146)

• Using the Manage Experiments tab (page 134)

• Experiment acquisition workflow (page 141)

Experiment tab
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Using the Manage Experiments tab 
Introduction This topic describes experiment folders, how to open and preview 

existing experiments, and how to manage experiments using the 
Manage Experiments tab.

About experiment 
folders

The Experiments Browser panel in the Manage Experiments tab 
displays experiment folders. Each user has a default experiment 
folder identified by the user login name. You can create an 
unlimited number of subfolders and organize different experiments 
within your default experiment folder.

You can rename experiments and folders, move experiments from 
one subfolder to another, and delete, share, or make experiments 
private.

Opening the 
Experiment 
workspace

To open the Experiment workspace:

1. On the navigation bar, click Experiments.

The Manage Experiments tab opens in the Experiment 
workspace.

Renaming 
experiments

When you create a new experiment, the experiment is identified by 
the default name Experiment_nnn, where nnn is a three-digit 
number (starting from 001). 

A unique or meaningful experiment name is useful when locating 
or categorizing experiments by purpose, fluorochrome, bead type, 
cell type, author, or other attributes that are meaningful to your 
laboratory.

To rename an existing experiment:

1. In the Experiments Browser, right-click an experiment name, 
then select Rename Experiment.

2. Type a new name, then click outside the field or press Enter.
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Saving an 
experiment as a 
different 
experiment

To save an experiment (Save As) as a different experiment:

1. In the Experiments Browser, right-click an experiment, then 
select Save As.

A Save Experiment As dialog opens.

2. In the Experiment Name field, type a new experiment name.

3. (Optional) If you want to save the experiment properties, 
plots, gates, and other worksheet elements, but not the tube 
data, select the Save Experiment without Data checkbox.

4. Click OK to save a copy of this experiment with a new name.

Renaming an 
experiment 
subfolder

To rename an experiment subfolder:

1. Right-click an experiment or folder name, then select Rename 
Folder.

2. Type a new name, then click outside the field or press Enter.

Creating an 
experiment in a 
new subfolder

To create an experiment in a new experiment subfolder:

1. In the Experiments Browser, right-click your default user 
folder and select New Folder.

A new subfolder is created with the default name Folder_nnn, 
where nnn is a three-digit number (starting from 001). 

2. Click New.

A new experiment opens. 

Moving an 
experiment

To move an experiment to a different folder:

1. Click an experiment folder, then click an experiment.

2. Drag the experiment from one folder into a different folder.
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Changing sharing 
settings

Experiments are private by default. Only Administrators or 
experiment owners (authors) can change share settings. Once an 
experiment is shared by the author, all users can modify, rename, 
or export the experiment. Changes are saved to the original, shared 
experiment. Only Administrators or experiment owners (authors) 
can delete private or shared experiments.

Shared experiments are listed in all shared by folders. Private 
experiments are listed only in the All Experiments and Owned by 
Me experiment folders. 

To change the share setting for an experiment:

1. In the Experiments Browser, right-click an experiment and 
select Make Private or Share.

Deleting 
experiments

To delete an experiment:

1. In the Experiments Browser, right-click an experiment name, 
then select Delete Experiment.

A confirmation dialog opens.

2. Click Yes.

Deleting 
experiment 
subfolders

To delete an experiment subfolder:

1. In the Experiments Browser, right-click an experiment 
subfolder, then select Delete Folder.

More information • Locating existing experiments (page 137)

• Experiment acquisition and analysis (page 129)

• Creating and opening experiments (page 142)
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Locating existing experiments 
Introduction This topic describes how to use the experiment search field to filter 

experiments and folders, and to search to locate specific 
experiments (both private and shared).

About locating 
experiments

Experiments are located in your user folder(s) and are listed by 
experiment name and creation date. Private experiments are 
accessible only by their author. Shared experiments are accessible 
by all users.

If your folders include numerous subfolders with many 
experiments, you can search individual folders to locate 
experiments.

If you cannot find a specific experiment, the experiment might not 
be shared. See your Administrator or the experiment author for 
more information.

Procedure To locate experiments:

1. In the Experiment workspace, click the Manage Experiments 
tab.

2. In the Experiments Browser, click your default experiment 
folder, subfolder, or an experiment category.

Category filters

Default folder

Subfolder

Search field
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A filtered list of experiments is displayed. 

3. If your experiment is not included in the list, you can type an 
experiment name, number, date, or owner in the Search field, 
then press Enter.

More information • Experiment overview (page 131)

• Importing and exporting experiments (page 139)
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Importing and exporting experiments
Introduction This topic describes how to import and export BD FACSuite 

experiments using the Manage Experiments tab.

Importing 
experiments

To import an experiment:

1. In the Experiment workspace, click the Manage Experiments 
tab.

2. In the Experiments Browser, click an experiment folder.

3. From the menu bar, select File > Import Experiments.

The Import Experiments dialog opens.

4. Navigate to the folder that contains the experiment you want 
to import (for example, C:\BDExport\BDFSExperiment\ 
myexperiment.Experiment.)

5. Click Open. 

The experiment is imported and is displayed in the selected 
experiment folder.

Exporting 
experiments

Export experiments so that you can import them onto a different 
BD FACSuite workstation or to backup experiments as a part of 
your specific data management process.

To export an experiment:

1. In the Experiment workspace, click the Manage Experiments 
tab.

2. In the Experiments Browser, click an experiment folder.

3. Right-click an experiment.

4. Select Export Experiments, then select one of the following 
options:

• With Data. Saves all tube properties, instrument settings, 
worksheets, reports, and acquired data. 
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• Without Data. Saves tube properties, worksheets, and 
reports. Select this option when you are creating tubes you 
want to reuse.

The Browse For Folder dialog opens.

5. Navigate to a target export folder (for example, 
C:\BDExport\BDFSExperiment).

6. Click OK to export the file.

7. View the status bar to confirm that the files have exported 
successfully.

More information • Experiment overview (page 131)

• Locating existing experiments (page 137)
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Experiment acquisition workflow

Introduction This topic describes the typical workflow stages you need to 
complete to build an experiment and acquire data. 

Typical workflow Perform the following typical workflow stages for acquiring data 
in an experiment.

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data
Shut down
the system

Stage Description 

1 Create a new experiment or open an existing experiment.

See Creating and opening experiments (page 142).

2 Build an experiment.

See Building experiments (page 155).

3 Acquire data.

See Acquiring data in an experiment (page 202).

4 (Optional) Save, export, or print the experiment.

See Using the Manage Experiments tab (page 134).

5 (Optional) Create a user-defined assay from the experiment.

See Creating a user-defined assay from an experiment 
(page 218).
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More information • Daily workflow (page 41)

• Performing system startup (page 112)

• Creating and opening experiments (page 142)

Creating and opening experiments 
Introduction This topic describes the default experiment folder, how to create a 

new experiment in the Manage Experiments tab, and how to open 
an existing experiment.

About the default 
experiment folder

A default experiment folder is automatically created for each user 
ID. All experiments that you create are stored in the default folder 
associated with your user ID. Within this folder, you can create 
custom subfolders using your own method for storing experiments 
(for example, by category, by date, or by sample). 

See Using the Manage Experiments tab (page 134) for more 
information about custom subfolders.

Creating a new 
experiment

To create a new experiment:

1. On the navigation bar, click Experiments.

The Manage Experiments tab opens in the Experiment 
workspace.

2. In the Experiments Browser panel, click your default folder or 
subfolder.

3. Click New.
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A new experiment opens. The new experiment name and 
creation date are displayed in the Experiments Browser, and a 
new tab opens in the Experiment workspace.

Opening an 
existing 
experiment

To open an existing experiment:

1. In the Experiments Browser, click your experiment folder or 
click an experiment subfolder to display the available 
experiments.
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2. (Optional) Click an experiment to display a snapshot of the 
experiment in the Experiment Preview panel.

3. Double-click an experiment to open the experiment in the 
Experiment workspace.

Opening multiple 
experiments

To open multiple experiments at the same time:

1. In an experiments folder, Ctrl+click each experiment that you 
want to open.

2. Right-click, then select Open Experiment. 

All selected experiments open as individual tabs.

Creating a new 
experiment from an 
assay

If you want to modify a current BD-defined (RUO) assay or a user-
defined assay, you can create a new experiment from the assay, 
modify the experiment, then create an assay from the modified 
experiment.

To create a new experiment from an assay:

1. Open the Manage Experiments tab.

Experiment preview
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2. From the menu bar, select File > New experiment from assay.

The Select an Assay dialog opens.

3. Click an assay in the list, then click OK.

The new experiment is displayed in the Experiments Browser 
and the new experiment opens.

Note that when BD-defined assays are converted to 
experiments, they do not include any reports or worksheets 
that are present in the original assay.

If you intend to modify an existing user-defined assay and want to 
retain the same assay name, you can overwrite the original by 
creating an assay with the same name.

See Creating a user-defined assay from an experiment (page 218).

Next steps • If you want to create new tubes or delete existing tubes in your 
experiment, continue with Creating tubes (page 156).

• If your experiment has the correct tubes, plots, gates and 
properties, you can acquire tubes, re-acquire existing tubes, or 
analyze the data. See Acquiring data in an experiment 
(page 202).

More information • Using the Experiment tab (page 146)

• Modifying tube properties (page 167)

• Using the Manage Experiments tab (page 134)
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Using the Experiment tab
Introduction This topic describes the different panels in the Experiment tab and 

how to use them to build, modify, and run experiments.

About the 
Experiment tab 

When you create a new experiment or open an existing experiment 
in the Manage Experiments tab, a new Experiment tab opens. The 
Experiment tab represents an experiment and includes the 
following panels:

• Acquisition Status

• Data Sources

• Cytometer Settings

• Worksheets and reports 

You can drag the panels to organize them in any order within 
the workspace, or click to minimize panels to maximize 
display space.

Data Sources panel Worksheet

Cytometer Settings panel
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About the 
Acquisition Status 
panel

Use the Acquisition Status panel to view real-time status for time, 
event counts, and aborts. You can also set flow rate and SIT flush 
options specific to an acquisition.

This panel is open by default. You can show or hide this panel. 
When you hide (close) the panel, an Acquisition Status button is 
displayed in a toolbar at the top of the Experiment tab. Click the 
button to display the panel.

Acquisition data displays each time you preview or acquire data. 
The display is refreshed (cleared) each time you preview or acquire 
a tube. You can also click to expand Advanced Status to display 
the acquisition abort count and abort rate.
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You can select the following options in this panel.

These settings are applied to all subsequent tubes in an experiment 
unless you change them.

About the Data 
Sources panel

Use the Data Sources panel to add and delete tubes and FCS files 
for acquisition and analysis. You can right-click tubes to set tube 
properties, duplicate tubes, create tube settings, and create or 
update reference settings. The run pointer indicates which tube is 
being previewed or acquired, and which tube’s data is applied to a 
plot.

Option Description

Flow rate Select the rate (low, medium, or high) that the sample flows through 
the flow cell in the instrument. High and medium flow rates are 
typically used for immunophenotyping experiments and to increase 
event throughput. Lower flow rates are typically used when high 
precision is required (for example, DNA experiments) to measure 
slight variations in fluorescence.

The fluidic mode (normal or high-sensitivity) varies the speed that the 
sheath and sample passes through the flow cell in the instrument. The 
high-sensitivity fluidics mode slows the sample and sheath flow, and 
is used to obtain better separation between the negative and positive 
fluorescence populations. 

Events to display Select the maximum number of events to display in plots.

SIT flush The SIT Flush checkbox is selected by default to perform one SIT 
flush after the acquisition completes and after you remove the tube 
from the manual tube port. Increase the number of flushes when 
extra cleaning is required between acquisitions to reduce sample 
carryover.

To specify a different number of SIT flushes:

1. In the list, select the number of times you want to flush the SIT 
(1–6).
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The Data Sources table displays the tube name, sample ID, and 
acquisition date. The following table describes the buttons in the 
Data Sources panel.

Button Description

New Tube Click to add a new tube to the list.

A new default tube has the default lyse/wash (LW), lyse/no-wash 
(LNW) properties (based on the cytometer optical configuration and 
experiment preferences). 

Lyse/wash provides a starting point for the majority of sample types.

Lyse/no-wash provides a starting point for lysed whole blood prepared 
using a no-wash method.

Import FCS Files Click to display a dialog where you can select FCS files to import files 
for analysis.

Delete Tube Click a tube in the list, then click this button to delete the tube.

Add From 
Worklist

Click to select tubes from a worklist and add them as tubes in an 
experiment. 

See Adding tubes from entries in a worklist (page 157).

Preview Click to start the sample flow and to populate plots with event data. 
This does not record event data.

Acquire Click to start the sample flow and record event data to an FCS file.

Stop Click to stop the sample flow and the current preview or acquisition.

Run pointer
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About the 
Cytometer Settings 
panel

Use the Cytometer Settings panel to view system status, run 
cleaning protocols, adjust PMT voltages, and view laser delay and 
area scaling. This panel includes the following sections:

• Status

• PMT Voltages

• Lasers

Status The Status section displays the system status, including real-time 
status for the SIT, fluidics, and lasers. This section also indicates 
when you need to run system cleaning protocols.

Next Click to set the run pointer to the next tube in the Data Sources table. 
You can also click this button to add tubes. Note that this is the 
equivalent of duplicating without data.

See Adding tubes using the Next button (page 157).

Pause Click during preview to pause the sample flow and event counters and 
timers.

Resume Click to resume a paused preview.

Restart During preview, click to clear the counters and timers. This clears the 
acquisition data without pausing the fluid flow.

During acquisition, click to delete acquired events, clear counters and 
timers, and clear the progress bar. This clears the acquisition data 
without pausing the fluid flow.

Button Description
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A checkmark indicates a Ready status. You can click the arrow 
icon in the Status title bar to expand or collapse this section.

PMT Voltages Use the PMT Voltages section during preview to select the area, 
height, width, and adjust the voltage and threshold for scatter or 
fluorescence parameters. You can also add or remove parameters.

If you are using the default tube settings and then adjust PMT 
voltages or other cytometer settings, the changes apply only to the 
current tube. If you want to reuse adjusted settings for additional 
tubes, create a new tube setting. 
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In the PMT Voltages section, you can perform the following 
actions.

Button Description

Threshold 
Operation

1. Select And or Or to specify how multiple thresholds are combined 
logically.

Add 1. Click Add to add a new parameter.

2. Click the Name field in the blank row and select a fluorochrome.

Remove 1. Select a parameter in the PMT Voltage table.

2. Click Remove to remove the selected parameter. 

Parameter 
(Name column)

1. Click any fluorescence parameter in the table.

2. Select an available parameter and select a fluorochrome.

A (Area), 
H (Height), and 
W (Width)

A (Area) is the default parameter that measures the entire voltage 
pulse. H (Height) is the peak of the voltage pulse, and W (Width) is 
the amount of time taken for the event to pass through the laser 
(multiplied by a constant).

1. Select these checkboxes to specify which parameters to include in 
the acquisition. 

Voltage Adjusting the voltage changes the amount of sensitivity used by the 
PMT to view events.

 Click the up and down arrows to adjust the value in increments of 
1 V.

 Ctrl+click the up and down arrows to adjust the value in 
increments of 10 V.

 Drag the slider to adjust the voltage value in any increment.
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You can click the arrow icon in the PMT Voltages title bar to 
expand or collapse this section.

Lasers Use the Lasers section to set the area scaling and delay values for 
each configured laser. If you performed daily performance QC, the 
laser delay settings are set appropriately. The laser delay values 
should not need adjustment. The area scaling factor might require 
adjustment depending on the experiment particle size.

These settings are only temporary and do not affect tube or 
reference settings in the library. Note that changes to the delay or 
area scaling affect all tubes in the experiment. These settings are 
only saved with the experiment.

Threshold An electronic threshold on a parameter to eliminate unwanted events. 
Only events with parameter values above the threshold are acquired.

1. Select the checkbox to enable threshold for the parameter.

2. Adjust the value.

– Click the up and down arrows to adjust the value in 
increments of 100.

– Ctrl+click the up and down arrows to adjust the value in 
increments of 10.

– Drag the slider to adjust the voltage value in any increment.

Button Description
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In the Lasers section, you can perform the following actions.

You can click the arrow icon in the Lasers title bar to expand or 
collapse this section.

About worksheets 
and reports

Worksheets are used to develop experiments and assays to visualize 
data. You can display plots, statistics, populations, and expressions 
to help visualize and calculate tube data.

Reports are used to display results and associated information and 
can include all the details you want to analyze and present in a 
final lab report. 

You can create multiple worksheets and reports. Each worksheet 
or report can include multiple pages. 

Button Description

Window 
Extension

This is time added to the pulse duration above the threshold to give 
the total time during which a pulse is sampled. The window 
extension can be set from 0–25 µs.

The default is 3 µs (normal mode) and 5 µs (high-sensitivity mode).

FSC Area Scaling Adjusts area measurements to be the same magnitude as height 
measurements for signals from the FSC detector.

Name (Read-only) Indicates the name of the laser in the current 
configuration.

Delay Adjusts the amount of time between processing signals from different 
laser intercepts to align the signals from multiple lasers (±162.5 µs).

The delay in normal mode is typically 35 µs, and high-sensitivity 
mode is typically 70 µs.

Area Scaling Adjusts area measurements relative to height measurements for 
signals from the corresponding laser.

For optimal data, the magnitude of area and height measurements 
should match.
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More information • Experiment overview (page 131)

• Creating tubes (page 156)

• Creating plots in a worksheet (page 158)

Building experiments
Introduction This topic provides the basic workflow for building an experiment.

Typical workflow Perform the following typical workflow stages for building an 
experiment. Note that this basic workflow uses default tubes and 
does not require the modification of tube properties or create tube 
settings.

Stage Description 

1 Add tubes (if needed) with default tube settings, or apply 
existing tube settings.

See Creating tubes (page 156).

2 Create and modify worksheet, reports, plots, and create gates 
and statistics views. 

See Creating plots in a worksheet (page 158), Previewing data 
in plots (page 161), and Drawing gates in plots (page 164).
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More information • Creating and opening experiments (page 142)

Creating tubes
Introduction This topic describes how to create tubes in the Data Sources panel 

by adding or duplicating tubes. This topic also describes how to 
delete tubes from an experiment. 

Adding tubes to an 
experiment

When you create a new experiment, one default tube is displayed 
in the Data Sources panel. 

To add a tube to an experiment:

1. In the Data Sources panel, click New Tube. 

A new default tube is displayed. The Lyse Wash (LW) or Lyse 
No Wash (LNW) tube settings are applied to all default tubes.

3 Adjust cytometer settings as needed.

See Using the Experiment tab (page 146) for more 
information about the panels in the Experiment tab that you 
use to adjust cytometer settings.

4 (Optional) Create tube settings and reference settings as 
needed.

See Creating tube settings (page 184) and Creating reference 
settings (page 187).

5 (Optional) Modify the tube properties for each tube (if you do 
not want to use the default tube properties).

See Modifying tube properties (page 167).

Stage Description 
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Duplicating tubes 
with or without 
data

To duplicate tubes with acquired data:

1. Before you can duplicate with data, acquire the tube.

See Acquiring data in an experiment (page 202).

2. In the tube list, right-click the tube you want to duplicate.

3. Select one of the following:

• Duplicate with data. A duplicate tube is added to the list 
with the same tube name and includes all data that is 
associated with the source tube.

• Duplicate without data. A duplicate tube is displayed with 
a new name and includes all tube properties and settings 
except the acquired data.

Adding tubes from 
entries in a worklist

To add tubes from entries in a worklist:

1. In the Data Sources panel, click Add from Worklist.

The Add Tubes From Worklist dialog opens. 

2. Select one of the following:

• Under Entries, click a worklist entry, then click Add 
Selected Entry Tubes. 

• Under Entries, click a worklist entry. Under Tubes, click 
individual tubes that are displayed in the entry, then click 
Add Selected Tubes.

The tubes are added to the Data Sources panel.

Adding tubes using 
the Next button

To add new tubes using the Next button:

1. In the Data Sources panel, click Next to move the run pointer 
to the next tube. 

If you click the last tube in the list, and then click Next, a new 
duplicate tube without data is created and the run pointer 
moves to the tube.
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Clearing data in a 
tube

To clear existing data from a tube:

1. In the Data Sources panel, right-click a tube and select Clear 
Tube.

All associated tube data is deleted and associated plots or 
statistics are cleared.

Deleting tubes 
from an experiment

To delete a tube from an experiment:

1. In the Data Sources panel, click a tube in the list.

2. Click Delete Tube.

Next step After you add tubes to the experiment, create plots on a worksheet 
to visualize tube data.

More information • Creating plots in a worksheet (page 158)

• Modifying tube properties (page 167)

• Understanding keywords (page 297)

Creating plots in a worksheet 
Introduction This topic describes how to create plots in an experiment 

worksheet.

Before you begin • Be sure that you have created tubes before you create plots 
associated to the tubes. 

• (Optional) You can also set tube properties before you begin, 
or at any time before you acquire the tube.

Creating a plot When you create a new experiment, one default tube is displayed 
in the Data Sources panel and one default plot is displayed in the 
worksheet. 
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When you create additional plots, the plots display the default plot 
title and parameter names. You can modify the plot title and select 
different parameters for each axis after you create the plot.

To create a plot:

1. Open an experiment.

2. (Optional) Click Toggle Grid on the Worksheet toolbar to 
enable the grid. 

A grid on the worksheet provides guidelines for plot size and 
placement. 

3. Click a plot tool on the Plot toolbar.

4. Click in the worksheet to create the plot.

5. Continue to add plots for your scatter and fluorescence 
parameters as needed. 

The primary data source determines which tube is associated 
to a plot or plots in the worksheet. If the run pointer is selected 

Dot plot   Histogram plot Contour plot   Density plot
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as the primary data source (default), all plots display data from 
the tube that is indicated by the run pointer.

You can change the primary data source for a plot from the 
run pointer to a specific tube if needed. See Changing the 
primary data source (page 320) for information.

Modifying plot 
parameters

To modify plot parameters:

1. Select a plot in a worksheet.

2. Right-click the x-axis parameter label, then select a parameter 
from the list.

3. Right-click the y-axis parameter label, then select a parameter 
from the list.
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Next step • If you are working with un-acquired tubes, plots remain empty 
until you preview or acquire the tube to populate the plots 
with data. Continue by previewing or acquiring data.

• If a tube contains acquired data, new plots automatically 
display data. Continue by drawing gates in the plots.

More information • Modifying tube properties (page 167)

• Previewing data in plots (page 161)

• Acquiring data in an experiment (page 202)

• Drawing gates in plots (page 164)

• Plots (page 307)

• Plot types (page 309)

Previewing data in plots 
Introduction This topic describes how to preview data in plots and how to 

change the data display behavior for plots.

Before you begin Create plots in the worksheet before you preview tube data.

About previewing 
data

Previewing data is the process of starting the sample flow and 
displaying event data. Previewing does not record data. While 
previewing, you can adjust the PMT voltages and modify the tube 
properties.

This example describes previewing data from a single (manually 
loaded) tube using the run pointer as the primary data source. See 
Changing the primary data source (page 320) for more 
information about the primary data source.
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Procedure To preview data in a specific tube:

1. Load a tube on the manual tube port. 

2. In the Data Sources panel, set the run pointer to the tube you 
want to preview (for example, Tube_002).

3. Click Preview. 

During preview, the run pointer remains blue and displays an 
activity indicator. 

Data is displayed in the plots.

Next step Once data is displayed in plots, you can adjust the cytometer 
settings and draw gates to identify populations of interest.

More information • Drawing gates in plots (page 164)
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Adjusting the cytometer settings for a tube
Introduction This topic describes how to adjust the cytometer settings for a tube 

to optimize the sample brightness and place the events on scale. 

Procedure Perform the following adjustments as needed before or after you 
create gates in a plot. 

To adjust the cytometer settings:

1. Adjust the PMT voltages as needed to put all populations on 
scale.

a. In a plot, click the PMTV button in the lower-left corner of 
the plot to enable the data sliders.

b. Drag the slider control for each axis parameter in the plot. 

The PMTV value is displayed on the slider control. 

c. Click the PMTV button again to disable the slider control.

See About the Cytometer Settings panel (page 150) for details 
about adjusting PMT voltage using the PMT Voltages section 
of the Cytometer Settings panel.

2. Select a threshold operation as needed. 

3. Select a checkbox to enable a threshold, then adjust the 
threshold value as needed.
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4. Select area, height, and width parameters as needed.

See About the Cytometer Settings panel (page 150) for details 
about selecting parameters and adjusting values using the 
Lasers section of the Cytometer Settings panel.

5. Click Stop to stop previewing.

More information • Changing the primary data source (page 320)

• Drawing gates in plots (page 164)

• Gates and populations (page 343)

• Acquiring data in an experiment (page 202)

Drawing gates in plots 
Introduction This topic describes four basic gate types and how to draw 

different types of gates to define populations in plots. 

See Gates and populations (page 343) for descriptions and details 
about additional gate types including logical, interval, adaptive, 
and quadrant gates.

Before you begin Create plots for tubes and populate the plots with data before 
creating gates.
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Drawing gates The following table describes how to draw basic gates in plots.

To draw a... Then do this...

Rectangle gate 1. Click this tool on the Worksheet toolbar.

2. Click in the plot and drag diagonally to create and size the 
rectangle around specific events in the plot.

3. Release the mouse button to set the gate.

Polygon gate 1. Click this tool on the Worksheet toolbar.

2. Click on the plot to specify a starting point. A vertex is displayed.

3. Move the cursor to another position and click to add another 
vertex. Repeat this step to create a minimum of three vertices 
around specific events in the plot.

4. Click the first vertex or double-click to set the last vertex to close 
the gate.
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New gates are added to the hierarchy and are applied to all tubes 
within the experiment. The population hierarchy is updated to 
identify the new population.

Next step Experiment analysis (page 204)

Ellipse gate 1. Click this tool on the Worksheet toolbar.

2. Click in the plot and drag diagonally to create and size the ellipse 
around specific events in the plot.

3. Release the mouse button to set the gate.

Freehand gate 1. Click this tool on the Worksheet toolbar.

2. In the plot, click and hold the mouse button, then move the cursor 
to draw a freehand shape around specific events.

3. Release the mouse button to set the gate.

To draw a... Then do this...
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More information • Gating tools (page 347)

• About gates and population hierarchies (page 359)

• Creating logical gates (page 371)

• Creating adaptive (snap-to) gates (page 374)

• Creating auto gates (page 379)

• Creating quad gates (page 388)

• Creating staggered quad gates (page 394)

Modifying tube properties 
Introduction This topic describes how to modify the default properties for the 

current tube.

About tube 
properties

Tube properties define the identity and details for each tube and 
determine how tube data is acquired and displayed. Tube 
properties can be modified at any time before you acquire a tube. It 
can be useful to set some tube properties before you preview data 
(for example, selecting tube settings or adding labels), while other 
properties should be modified after plots and gates are created (for 
example, acquisition stopping rules). 

Tube properties The following table describes the tabs in the Tube Properties 
dialog.

Tab Description

General Use this tab to view or modify the tube name, ID, or sample ID, select 
tube settings, and view other descriptive information about the tube.

See Setting general tube properties (page 169)
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More information • Building experiments (page 155)

• Setting general tube properties (page 169)

Parameters Use this tab to view the current parameter names, area, height, and 
width, PMT voltages, and thresholds for the tube. Use the Cytometer 
Status panel to modify these parameters.

See Viewing tube parameters (page 171)

Compensation Use this tab to view or modify the compensation matrix for the current 
tube (either calculated or measured).

You do not need to modify this matrix for typical daily use.

See Modifying the compensation matrix (page 172)

Reagents Use this tab to select labels for fluorochromes used in this tube.

See Editing reagent labels (page 174)

Keywords Use this tab to view and assign keywords to the selected tube.

See Working with keywords (page 176)

Acquisition Use this tab to set acquisition stopping rules.

See Setting acquisition stopping rules (page 179)

Tab Description
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Setting general tube properties
Introduction This topic describes how to set general tube properties using the 

General tab in the Tube Properties dialog.

Setting general 
tube properties

To set general properties for a tube:

1. In the Data Sources panel, double-click the run pointer, or 
right-click a tube and select Properties to open the Tube 
Properties dialog.

The Tube Properties dialog opens in the General tab.

2. In the Tube Name field, use the current default name or type a 
new tube name. 

3. (Optional) In the Tube ID field, type a tube ID or click in the 
field and scan a barcode. 

4. (Optional) In the Sample ID field, type a sample ID or click in 
the field and scan a barcode.

Information for the following read-only fields is displayed when 
you acquire a tube: 

• Total Events (acquired for this tube)

• Acquisition Date

• Cytometer Name (the cytometer that was used for acquisition)

Selecting existing 
tube settings

When you create a new tube, the default tube settings are applied 
(Lyse/Wash (LW), or Lyse/No-Wash (LNW), based on the 
Experiment preferences). This section describes how to apply a 
different tube setting from the library. 

If you want to create an assay from the experiment or reuse the 
settings in other tubes, you need to create tube settings.

See Creating tube settings (page 184).

To select existing tube settings:

1. In the General tab, click Select in the Tube Settings field.
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The Select Tube Setting dialog opens.

2. Select a tube setting in the list. 

3. Click OK. 

The tube settings are applied to the current tube.

4. Continue with the next tab or click OK.

If you modify any values that are part of a tube setting, a star 
icon is displayed in the Tube Settings field. The software 
automatically calculates modified TTV* (star) tube settings 
and recalculates the spillover values based on the default LW 
reference setting and MFI and PMT voltages.

If you select a different tube setting, you will undo your 
current modified star values. Calculated spillover values are 
not saved and cannot be reused except by copying and pasting 
a tube from one experiment to another. If you want to save 
these modified settings for future use, create tube settings. 

See Creating tube settings (page 184).

More information • Modifying tube properties (page 167)

• Viewing tube parameters (page 171)

• Creating tube settings (page 184)
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Viewing tube parameters
Introduction This topic describes how to view the tube parameters, area, height, 

and width selections, and the PMT voltage and threshold settings.

Procedure To view tube parameters for a tube:

1. In the Data Sources panel, set the run pointer to the tube you 
want to modify (for example, Tube_001).

2. Double-click the run pointer, or right-click the tube and select 
Properties to open the Tube Properties dialog.

3. Click the Parameters tab.

This read-only tab displays only the parameters that are set for 
the current tube or an acquired tube. 
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More information • PMT Voltages (page 151)

• Setting general tube properties (page 169)

• Modifying the compensation matrix (page 172)

Modifying the compensation matrix
Introduction This topic describes how to view or modify the compensation 

matrix for your tube using the Compensation tab in the Tube 
Properties dialog.

About the 
compensation 
matrix

The compensation matrix is automatically recalculated any time 
you adjust the PMT voltages in the PMT Voltages section in the 
Cytometer Settings panel, or in a plot. 

If you apply tube settings that do not have associated reference 
settings, the matrix reflects calculated compensation settings. 

If you apply tube settings that have an associated reference setting, 
the matrix reflects measured compensation settings.

If the calculated spillover values work for your samples, you do not 
need to modify this matrix.

Procedure To modify the compensation matrix for a tube:

1. In the Data Sources panel, set the run pointer to the tube you 
want to modify (for example, Tube_001).

2. Double-click the run pointer, or right-click the tube and select 
Properties to open the Tube Properties dialog.
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3. Click the Compensation tab.

The Compensation Matrix displays the spillover values 
associated with the acquired tube or the values that will be 
used when a tube is acquired. The table shows how much of 
the column (for example, FITC parameter) is spilling over into 
the row (for example, PE parameter). For example, PE -
14.37%FITC.

4. Select the Enable Compensation checkbox to analyze with 
compensated data, or clear the checkbox to analyze with 
uncompensated data.

5. (Optional) Edit the spillover values as needed. 

The goal is to ensure that a single positive population and the 
negative population are centered. For example for a plot with 
FITC vs PE, the FITC mean on the y axis should not be higher 
or lower than the negative population mean.

a. Locate the row on the left, then move right across the table 
until you locate the intersecting column.

b. Type a new value (0.00 to 1000.00) in the table, or click 
the up and down arrows to adjust the value.

If you adjust the values in this matrix, the values are applied to 
the current tube. If you want to reuse these values, you need to 
save modified reference settings.
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More information • Saving modified reference settings (page 201)

• Viewing tube parameters (page 171)

• Editing reagent labels (page 174)

Editing reagent labels
Introduction This topic describes how to view or edit reagent labels for available 

fluorochrome parameters in a tube.

Procedure To edit reagent labels for available fluorochrome parameters in a 
tube:

1. In the Data Sources panel, set the run pointer to the tube you 
want to modify (for example, Tube_001).

2. Double-click the run pointer, or right-click the tube and select 
Properties to open the Tube Properties dialog.

Click the Reagents tab.

3. In the Label column for each parameter, click and select an 
available reagent label.
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• If you use reagents that require either lot-specific or lot- 
and label-specific spillover values (tandem fluorophores), 
select either a label or a label and a lot ID, and clear the 
Use Generic checkbox in order to apply the correct 
spillover to the tube.

• If the label is not lot-specific, select the Use Generic 
checkbox for the fluorochrome.

New lots and labels for tandem fluorophores must be 
added to the library before they are available as options in 
this tab. 

More information • Working with labels in the library (page 302)

• Adding fluorochromes to a reference setting (page 195)

• Modifying the compensation matrix (page 172)

• Working with keywords (page 176)
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Working with keywords
Introduction This topic describes how to view or assign keywords to a tube and 

how to modify keyword values using the Keywords tab in the Tube 
Properties dialog.

About keywords Keywords are unique fields for storing information in files. They 
are used to identify particular data elements, both required and 
optional, and can be added to tubes in an experiment. Keywords 
can include information such as patient information, dilutions, and 
cell or sample types.

See Understanding keywords (page 297) for a description of 
keywords and how they are used in BD FACSuite software.

Before you begin In the library, create any new keywords that you plan to assign to 
tubes. 

See Working with keywords in the library (page 299) for more 
information about creating keywords.

Assigning new 
keywords to a tube

To assign a new (user-defined) keyword to a tube:

1. In the Data Sources panel, set the run pointer to the tube you 
want to modify (for example, Tube_001).

2. Double-click the run pointer, or right-click the tube and select 
Properties to open the Tube Properties dialog.

3. Click the Keywords tab.

4. Click Add.

The Add Keywords to Tube(s) dialog opens.

5. In the Assign Keywords column, select the checkboxes for 
keywords you want to assign to the tube.
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To locate or view detailed information on the keywords, you 
can perform the actions in the following table.

6. Click OK.

The assigned user-defined keywords are displayed in the tab.

Changing values 
for assigned 
keywords

To change values for keywords assigned to a tube:

1. In the Tube Properties dialog, click the Keywords tab.

Any currently assigned user-defined keywords are displayed.

To... Then do this...

Filter keywords by 
name or type

In the Keyword Filter field, type the name 
or type criteria, then press Enter.

Show user-defined 
and system-defined 
keywords in the list

Select the Show System Defined Keywords 
checkbox.

View the properties 
of a keyword

1. Click Keyword Properties. 

2. Click a keyword in the list to view its 
properties.
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2. Select the Show System Defined checkbox to display all user-
defined and system-defined keywords that are assigned to this 
tube.

3. Click the user-defined keyword you want to modify. 

4. Click the Value field for that keyword and type a new value.

More information • Understanding keywords (page 297)

• Working with keywords in the library (page 299)

• Editing reagent labels (page 174)

• Setting acquisition stopping rules (page 179)
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Setting acquisition stopping rules
Introduction This topic describes how to set acquisition stopping rules using the 

Acquisition tab in the Tube Properties dialog.

If you want to assign a specific gate or gates to use as storage or 
stopping criteria, these gates must first be created before setting 
acquisition properties.

Setting acquisition 
stopping rules for a 
tube

To set acquisition stopping rules for a tube:

1. In the Data Sources panel, set the run pointer on the tube you 
want to modify (for example, Tube_001).

2. Double-click the run pointer, or right-click the tube and select 
Properties to open the Tube Properties dialog.

3. Click the Acquisition tab.

4. If the experiment has multiple worksheets, click and select a 
worksheet in the Worksheet to Display during Acquisition 
field.

5. In the Storage Gate field, click and select an existing gated 
population if you want to use a gate as the storage gate. 

A storage gate identifies which data is stored when the tube is 
acquired. If you select a gate for a subpopulation (P1, P2, etc), 
only events from that subpopulation are stored in the FCS file.

6. In the Stopping Rules tab, define the acquisition stopping 
rules.

BD FACSuite software always uses a combination of a time 
stopping rule and a gate criteria rule using an OR operator. 
Use Time Stopping Rule to change the time criteria. Use Create 
Gate Criteria and Combine Gate Criteria and Apply Rule to 
change and apply the gate criteria. The current acquisition 
stopping rules are displayed under Applied Stopping Rule.
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Defining time-
based stopping 
rules

To define time-based stopping rules:

1. Under Time Stopping Rule, select a maximum acquisition time 
(seconds). Do not select Infinite.

2. Under Create Gate Criteria, make sure that the event count is 
high to ensure that it does not interfere with the time stopping 
rule. 

Time stopping rules are always applied with Or criteria. If the 
event count is set too low, the acquisition might stop before the 
time stopping rule is satisfied.

The time stopping rule is automatically applied and is 
displayed under Applied Stopping Rule.

Defining event-
based stopping 
rules

To define event-based stopping rules:

1. Under Time Stopping Rule, select Infinite as the maximum 
acquisition time. 

This effectively eliminates time as a stopping trigger. 
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Single, event-based rules are always applied with Or criteria. If 
the max time is set too low, the acquisition might stop before 
the event stopping rule is satisfied.

2. Under Create Gate Criteria, select a stopping gate, then select 
the minimum number of required events that you want to 
acquire for the gate.

3. Click Add Criteria to add event criteria to the Combined Gate 
Criteria and Apply Rule box.

4. Click the new event criteria in the list, then click Apply Rule.

5. The event stopping rule is displayed under Applied Stopping 
Rule.

Defining combined 
stopping rules

To define combined event-based stopping rules:

1. Under Time Stopping Rule, select Infinite as the maximum 
acquisition time. 

This effectively eliminates time as a stopping trigger.

2. Under Create Gate Criteria, select a stopping gate, then select 
the minimum number of required events that you want to 
acquire for the gate. 

3. Click Add Criteria to add event criteria to the Combine Gate 
Criteria and Apply Rule box.
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4. Select additional stopping gates for additional populations, 
then select the minimum number of required events that you 
want to acquire for each gate.

5. Click Add Criteria to add event criteria to the Combine Gate 
Criteria and Apply Rule box.

6. In the Combine Gate Criteria and Apply Rule box, click all 
event criteria that you want to combine, then click an option:

• And. Requires that all event criteria are satisfied before 
acquisition stops.

• Or. Requires that one or more event criteria are satisfied 
before acquisition stops.

Note that you can also click Delete to remove event criteria 
from the list.

The combined event-based criteria are added to the list.

7. Click the new event criteria in the list, then click Apply Rule.
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8. The combined event stopping rule is displayed under Applied 
Stopping Rule.

Using the Advanced 
tab

Click the Advanced tab to view window extension, area scaling 
factors, and laser delay values for the tube. 

These fields are read-only. You can modify these values using the 
Cytometer Settings panel. 

Note that these values are global and affect all experiments and 
data. To prevent errant data, these values should not be modified 
after the daily performance QC or Laser setup. 

More information • Lasers (page 153)

• Working with keywords in the library (page 299)

• Using the Manage Experiments tab (page 134)

• Drawing gates in plots (page 164)
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Creating tube settings 
Introduction This topic describes how to adjust the default tube settings to 

optimize the brightness of the positive population, then create user-
defined tube settings in an experiment.

About tube settings If you want to create measured spillover values for a tube setting, 
you can:

• Create a new tube setting by creating a new reference setting 
with measured SOVs from an existing tube setting with 
reference settings. 

• Append an existing tube setting with reference settings.

See Creating reference settings (page 187).

When you create a new (default) tube in an experiment, the default 
LW (lyse/wash) or LNW (lyse/no-wash) tube settings are 
automatically applied to the tube. The default is determined by 
your cytometer optical configuration and based on the experiment 
preferences setting.

When you create tube settings, you are creating new target values 
based on the current tube parameters and instrument settings 
(PMT voltages, thresholds, etc). 

When to create 
tube settings

Create tube settings when: 

• You want positive stained cells or beads to be either brighter or 
dimmer in the fluorescence parameter than the default tube 
setting for LW or LNW and you want to re-use these 
optimized settings repeatedly.

• You plan to create a user-defined assay from an experiment 
that includes modified tube settings.

Important note If you modify the cytometer settings (PMT voltages, thresholds, 
area scaling, or window extension) to adjust the position or 
brightness of the positive populations, you are only modifying the 
cytometer settings for the selected tube. 
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If you do not create a new tube setting, these modified cytometer 
settings are saved only with the tube in the current experiment. The 
modified cytometer settings are identified as instrument settings 
(not tube settings) in the FCS file.

If you want to create additional tubes with the adjusted cytometer 
settings, you must manually duplicate the tube within the 
experiment. Note that you cannot create an assay from the 
experiment unless you create tube settings for modified tubes.

Before you begin • Prepare a tube of CS&T beads according to the instructions in 
the technical data sheet. 

• Run performance QC.

Optimizing the 
positive population 

To optimize the position and brightness of the positive population:

1. Create a new experiment.

2. In the Data Sources panel, select a tube, or add a new tube.

3. Load a tube of your sample onto the manual tube port.

4. Click Preview to start the sample flow and preview the data.

5. In the Acquisition Status panel, adjust the flow rate or fluidic 
mode as needed.

6. (Optional) In the Laser section of the Cytometer panel, adjust 
the following as needed:

a. Adjust the window extension to add or reduce the sampling 
time above the threshold.

b. Adjust the FSC area scaling so that the area measurements 
reflect an appropriate area vs height measurements for the 
FSC parameter. Note that this is automatically adjusted 
during daily performance QC.

c. For each laser that is used, adjust the area scaling factor to 
reflect an appropriate magnitude vs height measurement 
from the corresponding laser.
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7. In the PMT Voltages panel, adjust the PMT voltages and 
threshold as needed.

Creating user-
defined tube 
settings

The following procedure describes the typical method for creating 
tube settings without measured spillover values or acquired data. 

To create user-defined tube settings:

1. Right-click the tube and select Create Tube Settings. 

The Create Tube Settings wizard opens.

2. The CS&T lot ID field displays the CS&T bead lot to be used 
for this tube setting. 

If you want to use a different bead lot, click and select a 
different CS&T bead lot. If the appropriate lot is not available, 
add the CS&T lot to the library.

See Working with bead lots in the library (page 289).

3. Load a tube of CS&T beads onto the manual tube port.

4. Click Acquire.

When acquisition completes, the Name and Description dialog 
opens.

5. In the Tube Settings name field, type a meaningful name.

6. (Optional) In the Description field, type a meaningful 
description that helps to differentiate between similarly named 
tube settings. 

7. Click Finish. 

 The new tube settings are saved in the library.

More information • About tube and reference settings (page 90)

• Creating reference settings (page 187)

• About setup and QC reports (page 93)
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Creating reference settings
Introduction This topic describes how to create reference settings using the 

Create Reference Settings wizard.

Note that if your system uses multiple user-defined configurations 
(optical configurations), each different optical configuration 
requires its own default reference settings.

About default and 
user-defined 
reference settings

Default reference settings (LW or LNW) are created for the optical 
configuration when the system is initially installed or anytime the 
system is re-configured. Default reference settings are initially 
applied to all default tubes. These are used to calculate spillover 
values.

User-defined reference settings are created by measuring spillover 
values using control tubes.

When to create 
reference settings

Create reference settings when:

• You need a reproducible system setup from day to day and 
over time.

• You want to create reusable tube settings and measured 
spillover values for your samples that are different than the 
default reference settings provided with the system. 

Methods for 
creating reference 
settings

There are two methods for creating reference settings:

• Creating reference settings when the default tube settings are 
applied to a tube.

• Creating reference settings when user-defined tube settings are 
applied to a tube.

If you start with the default tube settings, modify the cytometer 
settings, then create the reference settings. A new tube setting is 
created in the library with the same name as the reference settings. 
This also creates measured spillover values for the new tube 
setting. 
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If you start with a user-defined tube setting applied to the tube, and 
then create the reference settings, the measured spillover values are 
associated to the existing user-defined tube setting. 

Before you begin • Prepare the CS&T beads according to the instructions in the 
technical data sheet. 

• Prepare the BD FACSuite FC beads or other single-color 
control according to the instructions in the technical data 
sheet.

• When using CompBeads, use 3 drops of CompBeads with 40µl 
of staining label fluorescence conjugates (for example, CD4).

• Make sure the kit information is entered into the FC Bead 
reagent section in the library.

• Ensure that the performance QC is current. 

Preparing a tube 
for creating 
reference settings

To prepare a tube for creating reference settings:

1. Create a new experiment.

2. In the Data Sources panel, click an existing tube or add a new 
tube.

3. Right-click the tube and select Properties.

The Tube Properties dialog opens.

4. In the Tube Settings field, verify that the correct tube settings 
have been applied to the tube. 

If not, click Select to select the correct tube settings. If you 
have not created tube settings yet, make sure the LW or LNW 
default is selected.

5. Close the Tube Properties dialog.

6. (Optional) Preview the tube data and modify the cytometer 
settings. 

If you do not need to adjust the cytometer settings, you can 
associate the spillover values (measured by this process) with 
the existing tube settings.
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If you need to adjust the cytometer settings, you can create a 
new tube settings to capture the modified target values.

7. Right-click the tube and select Create Reference Settings. 

The Create Reference Settings wizard opens. 

8. The CS&T lot ID field displays the bead lot used for the latest 
performance QC. If you want to use a different bead lot, click 
and select a different CS&T bead lot.

Selecting kits to 
run

The Kits table displays the available BD FACSuite FC beads that 
are stored in the library. 

To select kits to run:

1. In the Run column, select the Run checkbox for the FC bead 
kit you want to run.

2. In the Lot ID column, select a lot ID if you want to use a 
different BD FACSuite FC bead lot. 

Selecting control 
tubes

The Control Tubes table displays the fluorochromes of the beads 
included in each FC Bead kit. Control types include FC beads, 
BD™ CompBead particles, and fluorescence controls. The 
fluorescence control (FC) is useful when the fluorochrome/dye of 
interest is stained on a specific particle other than FC beads or 
CompBeads.
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To select control tubes:

1. In the Lot ID column, select a lot ID if you want to use a 
different FC bead lot. 

2. (Optional) If you want to add new fluorochromes or control 
types:

a. Under Control Tubes, click Add to add a new fluorescence 
control. 

Available controls are stored in the library.

b. In the Fluorochrome column, select a fluorochrome for the 
new control tube. 

c. In the Control Type column, select the control type (FC 
beads, or FC and CompBeads).

3. In the Label column, select to use a generic or specific label. 

Generic labels apply to any antibody or label. Use Specific 
labels when compensation requirements are different between 
labels (for example, for tandem dyes). Note that specific labels 
must be created in the library before you can select them.

4. In the Lot ID column, select a lot ID if you want to use a 
different bead lot. 

5. In the Unstained column, select a separate tube for the 
unstained control. 

If the field is blank, the unstained control is in the same tube as 
the fluorescence control.
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6. Click Next. 

The next wizard page displays a list of control tubes to 
acquire.

Acquiring control 
tubes

To acquire the control tubes:

1. Follow the instructions in the wizard.

a. Load a tube of CS&T beads onto the manual tube port.

The run pointer is set to the first control tube in the list and 
indicates which tube to acquire. 

b. Click Acquire.

During acquisition, plots display data for the CS&T beads. 
When the CS&T beads are acquired, the run pointer moves 
to the next tube. 

c. Remove the control tube, then load the next control tube 
onto the manual tube port (for example, FITC).

d. Click Acquire.

List of control tubes to acquire
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During acquisition, plots display data for each control 
tube.

2. When the acquisition of the tube completes, a green 
checkmark is displayed. Follow the instructions on the wizard 
and repeat step 1 for the remaining control tubes.

3. (Optional) Click Print to print the plots for each tube (in a 
single file) or click Save as PDF to save the file.
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4. Click Next. 

Saving the new 
reference settings

To save the reference settings:

1. Follow the instructions in the Reference Setting Name wizard.

a. Type a name for a new tube setting that includes the new 
reference settings.

• To create a new tube setting with this reference setting, 
type a new name in the Reference Setting Name field.

• To create a tube setting with this reference setting and 
replace an existing tube setting with the same name, 
type the name of an existing tube setting. This 
overwrites the existing tube setting in the library.

b. (Optional) In the Description field, type a meaningful 
description that helps to differentiate between similarly 
named tube settings. 

2. Click Finish. 

The new tube settings are saved in the library with the 
associated reference settings. 

3. (Optional) View the tube settings:

a. On the navigation bar, click Library.

Example of the reference settings report
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b. In the Library panel, double-click Tube Settings, then click 
User-defined.

c. Click a tube setting in the Tube Settings table. 

The tube settings and reference settings are displayed.

Tube settings that include reference settings are indicated by an 
X in the Reference Settings column.

4. (Optional) Print tube settings or reference settings:

a. Click a tube setting in the Tube Settings table. 

The tube settings and reference settings are displayed.

b. Click Print.

More information • About tube and reference settings (page 90)

• Creating tube settings (page 184)

• Importing or adding a CS&T bead lot (page 82)

• Working with labels in the library (page 302)

• About setup and QC reports (page 93)

• Running characterization QC (page 83)
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Adding fluorochromes to a reference setting
Introduction This topic describes how to add fluorochromes to the current 

reference settings. This procedure updates a selected tube setting 
(with an associated reference setting) with measured spillover 
values from the new fluorochrome.

Before you begin • Verify that the fluorochrome you want to add to a reference 
setting has already been added to the current optical 
configuration. 

See Working with configuration reports (page 543).

• For tandem dyes, you must first add the new lot to the library. 

See Working with labels in the library (page 302).

• Prepare the CS&T beads according to the instructions in the 
technical data sheet. 

• Prepare the BD FACSuite FC beads or other single-color 
control according to the instructions in the technical data 
sheet.

• When using CompBeads, use 3 drops of CompBeads with 40µl 
of staining label fluorescence conjugates (for example, CD4).

Procedure To add a fluorochrome:

1. Create a new experiment.

2. In the Data Sources panel, click a tube or add a new tube.

3. Load a tube of CS&T beads onto the manual tube port.

4. Right-click the tube and select Add Fluorochromes.

The Add Fluorochromes wizard opens.

5. If necessary, select a different CS&T bead lot.

6. Under Kits, select a lot ID if you want to use a different FC 
bead lot or a lot of a tandem dye (that was previously added to 
the library).
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7. Under Reference Settings, select a checkbox to add 
fluorochromes to a specific reference setting. 

The Control Tubes table displays the fluorochromes of the 
beads included in each FC Bead kit. Control types include FC 
beads, BD CompBeads, and fluorescence controls.

8. To add new fluorochromes:

a. Under Control Tubes, click Add to add a new fluorescence 
control tube, FC beads, or BD CompBeads.

b. In the Fluorochrome column, select a fluorochrome for the 
new control tube. 

c. In the Control Type column, select the control type.

d.  In the Label column, select a generic or specific label.

e. In the Lot ID column, select a lot ID if you want to use a 
different FC bead lot. 

f. In the Unstained column, select a separate tube for the 
unstained control. 

If the field is blank, the unstained control is in the same 
tube as the fluorescence control.

9. Click Next. 

The wizard displays a list of control tubes to acquire.

The run pointer is set to the first control tube in the list and 
indicates which tube to acquire.

List of control tubes to acquire
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10. Follow the instructions in the wizard.

a. Load a tube of CS&T beads onto the manual tube port.

b. Click Acquire.

When the CS&T beads are acquired, the run pointer moves 
to the next tube. 

c. Remove the control tube, then load the next control tube 
onto the manual tube port (for example, APC-Cy7).

d. Click Acquire.

During acquisition, plots display data for each fluorochrome.

11. When the acquisition of the tube completes, a green 
checkmark is displayed. Follow the instructions on the wizard 
and repeat step 10 for the remaining fluorochromes. 

12. (Optional) Click Print to print the plots for each tube (in a 
single file) or click Save as PDF to save the file.

13. Click Finish.
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The new fluorochrome is added to the existing tube settings 
and the reference settings are updated to include the measured 
SOVs for the new fluorochrome. 

More information • Updating reference settings in an experiment (page 198)

• Saving modified reference settings (page 201)

Updating reference settings in an experiment
Introduction This topic describes when and how to update the existing reference 

settings. 

Reference settings must be updated every 30 days, and whenever 
you run characterization QC, change the optical configuration, or 
modify the fluorochromes.

If you modified reference settings by adjusting cytometer settings 
(PMT voltages, thresholds, window extension, flow rate, or area 
scaling) but did not modify the control tubes or fluorochromes, see 
Saving modified reference settings (page 201) for a simplified 
procedure. 

Before you begin • Prepare the CS&T beads according to the instructions in the 
technical data sheet. 

• Prepare the BD FACSuite FC beads or other single-color 
control according to the instructions in the technical data 
sheet.

• When using CompBeads, use 3 drops of CompBeads with 40µl 
of staining label fluorescence conjugates (for example, CD4).

Procedure To update reference settings in an experiment:

1. In the Data Sources panel, right-click the tube and select 
Update Reference Settings. 

The Update Reference Settings wizard opens.
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The Tube Settings name field displays the tube settings 
currently associated with the tube. These tube settings include 
reference settings. 

2. (Optional) Select a different tube setting if needed.

3. If necessary, select a different CS&T bead lot.

4. Under Kits, select a lot ID if you want to use a different FC 
bead lot. 

5. Under Control Tubes, select the checkboxes for control tubes 
you want to use for measuring SOVs.

6. Click Next. 

The wizard displays a list of control tubes to acquire.

The run pointer is set to the first control tube in the list and 
indicates which tube to acquire. 

7. Follow the instructions in the wizard.

List of control tubes to acquire
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a. Load the tube of CS&T beads onto the manual tube port.

b. Click Acquire.

During acquisition, plots display data for the CS&T beads. 
When the CS&T beads are acquired, the run pointer moves 
to the next tube. 

c. Remove the control tube, then load the next control tube 
onto the manual tube port (for example, PE).

d. Click Acquire.

8. When the acquisition of the tube completes, a green 
checkmark is displayed. Follow the instructions on the wizard 
and repeat step 7 for the remaining control tubes. 

9. (Optional) Click Print to print the plots for each tube (in a 
single file) or click Save as PDF to save the file.

10. Click Finish.

The updated reference settings are saved with the tube setting 
in the library. 

More information • Creating reference settings (page 187)

• Creating tube settings (page 184)

• About setup and QC reports (page 93)
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Saving modified reference settings
Introduction This topic describes how to save modified reference settings when 

you adjusted cytometer settings (PMT voltages, thresholds, 
window extension, flow rate, or area scaling) but did not modify 
the control tubes or fluorochromes. 

If your reference settings have expired or if you have changed the 
optical configuration, modified the fluorochromes, or have run a 
new characterization QC, see Updating reference settings in an 
experiment (page 198) for the complete updating procedure.

Procedure To save modified reference settings:

1. In the Data Sources panel, click a tube that is associated to the 
tube setting (with reference settings) and adjust the settings as 
needed. 

See Optimizing the positive population (page 185).

2. Right-click the tube, then select Save Modified Reference 
Settings.

The Save Modified Reference Settings dialog opens.

3. In the Reference Setting Name field, type a name for the tube 
setting that includes the modified reference settings.

• To create new tube settings with this modified reference 
setting, type a new name in the Name field.

• To create tube settings with this reference setting and 
replace an existing tube setting with the same name, type 
the name of an existing tube setting. This overwrites the 
existing tube setting in the library.

4. (Optional) In the Description field, type a meaningful 
description to help differentiate between similarly named tube 
settings. 

5. Click Finish. 

If you typed an existing name to replace an existing tube 
setting with the same name, the Save Settings dialog opens.
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6. Click Yes to update (overwrite) the existing tube setting.

The modified reference settings are saved in the library with 
their associated tube settings and calculated SOVs. 

More information • Updating reference settings in an experiment (page 198)

• Creating tube settings (page 184)

Acquiring data in an experiment 
Introduction This topic describes how to acquire data in an experiment. You can 

acquire data in an experiment as long as the experiment has at 
least one tube. 

Procedure To acquire data in an experiment:

1. Load a tube onto the manual tube port. 

2. In the Data Sources panel, set the run pointer to the tube you 
want to acquire (for example, Tube_001).

3. Click Acquire. 

During acquisition, the run pointer turns orange and displays 
an activity indicator. 

Acquisition continues until the stopping rules (defined in the 
Tube Properties dialog) are satisfied. 
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The acquisition status is displayed in the Acquisition Status 
panel.

During acquisition, you can click Stop to manually stop 
acquisition, or click Restart to clear the current acquisition.

When acquisition is complete, the tube icon displays as a filled 
tube to indicate that data has been acquired.

4. Click Next to move the run pointer to the next tube. 

If no next tube exists, a new tube (duplicate without data) is 
created and the run pointer moves to the tube.
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Next step After you acquire data, you can analyze the data immediately, or 
open the experiment later to analyze it.

More information • Experiment analysis (page 204)

• Creating and opening experiments (page 142)

• Experiment overview (page 131)

Experiment analysis

Introduction This topic describes the workflow for analyzing data acquired in 
an experiment.

About analyzing 
experiments

When you create an experiment, you can preview data and 
perform basic analysis by adding plots and drawing gates to define 
populations. 

A more detailed analysis might include additional plots or 
histograms, specific fluorochromes, different types of gates, custom 
statistics views, expressions, or custom reports.

You can perform analysis on the workstation that is connected to 
the cytometer or from a remote workstation with BD FACSuite 
software and exported FCS files.

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data
Shut down
the system
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Typical workflow Perform the following the tasks to analyze data in an experiment.

More information • Data analysis example (page 433)

• Creating plots in a worksheet (page 158)

• Drawing gates in plots (page 164)

Stage Description 

1 Open an existing experiment or import an experiment on a 
remote workstation.

See Creating and opening experiments (page 142).

2 Create and modify reports.

See Creating experiment analysis reports (page 206) and 
Modifying experiment worksheets and reports (page 208).

3 (Optional) Export or print reports.

See Exporting experiment reports as PDFs (page 217).
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Creating experiment analysis reports 
Introduction This topic describes how to create custom experiment analysis 

reports. If you plan to create and run a user-defined assay, create 
and format a report when you create an experiment.

About analysis 
reports

In experiments, reports are used to report results and associated 
information and can include the details you want to present in a 
final lab report. You can include any of the worksheet elements 
(for example, plots, gates, and statistics) and create a format that 
includes company logos and custom text in the headers and 
footers. Reports are associated and saved with the current 
experiment. 

Reports are similar to worksheets in functionality. However, only 
reports can display an ESignature Box for electronic signature or 
approval. ESignature is enabled when you edit assay details.

In assays, the report displays the results after acquisition. BD-
defined assays include a pre-defined report. Reports update when 
you run an analysis.

Creating a new 
report

To create a report from a blank report sheet:

1. In an experiment, click the Add Report tool on the Worksheet 
toolbar.
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A new Report tab opens. 

2. Click the text in the Report tab, then type a new name (for 
example, Analysis Report).

3. Create plots, statistics views, and other analysis elements. 

The report is automatically saved with the experiment.

More information • Experiment analysis (page 204)

• Exporting experiment reports as PDFs (page 217)

• Formatting and printing a report (page 213)
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Modifying experiment worksheets and reports 
Introduction This topic describes how to modify the experiment worksheet or 

report layout, and how to modify the individual items on the 
worksheet or report. 

Worksheet and report items include plots, statistic views, 
population hierarchies, expressions, and text boxes. 

Worksheet and 
report tools

The following table describes tools you can use to create and 
modify the format of worksheets and reports.

Tool Description

Click this tool to create a new worksheet. The worksheet displays as a 
tab.

Click this tool to create a new report. The report displays as a tab.

Click a worksheet or report tab, then click the Delete Worksheet or 
Delete Report tool to delete the worksheet or report.

Click a worksheet or report tab, then click the Header & Footer tool 
to open the Header/Footer dialog. Use this dialog to add text to 
headers and footers, display dividing lines, add logos, and modify font 
formats.

See Formatting and printing a report (page 213).

Click this tool to add a page to the current worksheet or report. To 
effectively manage the pages (for future printing or report generation), 
make sure to only add new pages as needed.

Click this tool to fit the entire worksheet or report page to the 
window.
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Resizing one item 
on a worksheet or 
report

To resize worksheet or report items:

1. Open an experiment that includes at least one worksheet or 
report.

2. Click an item in the worksheet (for example, a plot or statistics 
view).

Click the magnification tools to increase or decrease magnification for 
the current worksheet or report. 

You can also Ctrl+scroll to zoom the worksheet or report.

Click this tool to select a page view percentage (from 10% to 350%).

Click this tool to toggle the grid on or off for the current worksheet or 
report.

Click this tool to select vertical or horizontal layout. In vertical layout, 
you can view two pages of a worksheet side by side. 

Click this tool to toggle the orientation of a single worksheet or report 
page between portrait and landscape page orientation for printing.

Click this tool to change the page size.

Click this tool to add a text box to the worksheet or report. You can 
resize or move the text box and format the text. The text box can 
include text, keywords, expressions, and results. 

See Adding text to a worksheet or report (page 211).

Tool Description
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3. Click on the vertical or horizontal handles and drag vertically 
or horizontally to stretch the element, or click one of the 
corner handles and drag diagonally to proportionally resize.

Resizing multiple 
items

To resize multiple items on a worksheet or report:

1. Click an item, then Ctrl+click additional items in the 
worksheet.

2. Click an item handle in one of the items and drag vertically or 
horizontally. 

This resizes all items proportionally.

3. Click in the worksheet to ungroup the items.

Moving items To move items in a worksheet or report:

1. Click a plot or Ctrl+click multiple plots. 

2. Drag the selected objects to a new location on the worksheet. 
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Adding text to a 
worksheet or 
report

To add text to a worksheet or report:

1. On the Worksheet toolbar, click the Add Rich Text tool.

A text box is displayed on the worksheet or report.

2. Type text in the text box, or right-click in the text box and 
select Insert to insert operands from any of the following 
categories.

3. (Optional) To modify the font, size, and style of the text, right-
click and select Format.

4. (Optional) To align the text within the text box, right-click 
and select Justify.

5. (Optional) To move the text to a new location within the 
worksheet or report, drag the text box.

About copying and 
pasting items

You can copy worksheet or report items and paste them:

• Within the same worksheet or report

• Onto a different page of the worksheet or report

• Onto a different worksheet in the same experiment

• Onto a worksheet or report in a different experiment

• Into a third-party application (outside BD FACSuite software) 
as an editable, enhanced metafile

Operand category Description

Worksheet Select statistics by worksheet > plot > tube 
> population > parameter > statistic.

Statistics Select statistics by statistic > tube > 
population > parameter. 

Populations Select statistics by population > tube > 
keyword or event.

Expression Select existing expressions.

Constants Select pi, or e constants.
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Copying and 
pasting within BD 
FACSuite software

To copy and paste worksheet or report items within BD FACSuite 
software:

1. Click an existing item in a worksheet.

2. Right-click and select Copy.

3. Locate your paste target.

• To paste within a worksheet or report, move to a new 
location in the worksheet.

• To paste into a different worksheet or report page, navigate 
to the target page and click to select the page.

• To paste into a worksheet in a different experiment, open 
the experiment and click the worksheet to select the page.

4. Right-click and select Paste. 

Copying and 
pasting into third-
party software

To copy and paste worksheet or report items into third-party 
software:

1. Click on an existing item in a worksheet.

2. Right-click and select Copy.

3. Open the third-party application (for example, Microsoft® 
Word or PowerPoint®).

4. Click in the target document page.

5. Paste the item. For example, select Edit > Paste Special.

6. Select to paste the item as an enhanced metafile. 

After you paste the item, you can ungroup it and click on 
image elements to modify text, lines, colors, and sizes.

Changing the 
orientation of 
single worksheet or 
report page

To change the orientation of a single page:

1. On the Worksheet toolbar, click Change Page Orientation to 
change to portrait or landscape page orientation for printing.
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Printing 
worksheets

To print the currently active experiment worksheet page:

1. From the menu bar, select File > Print. 

2. Perform your typical printing process.

More information • Editing assay properties (page 284)

• Formatting and printing a report (page 213)

• About worksheets and reports (page 154)

Formatting and printing a report 
Introduction This topic describes how to format a report and set header and 

footer properties. 

You can customize the headers and footers to include specific 
information and images, and create a custom report layout. Once 
you have an appropriate format, you can print the report.

Setting experiment 
report properties

To set report header and footer properties:

1. Open an experiment or assay report.

2. On the Worksheet toolbar, click the Header & Footer tool.

The Header/Footer dialog opens.
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3. Set the cursor in the upper-left corner of a header (left, center, 
or right) section. 

4. Under Elements, double-click an element you want to add to 
the header section (for example, Cytometer Name).

5. Add additional header elements to each section as needed.

6. Set the cursor in lower-left corner of a footer (left, center, or 
right) section. 

7. Add additional footer elements to each section as needed.

The Preview box shows the layout of the elements you 
selected.
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8. Once you have added elements to the report, you can perform 
the following optional actions.

9. You can also perform the following optional formatting 
actions.

10. Click OK.

The formatted report opens.

11. Rename the report as appropriate for the experiment. 

a. Click the report title.

b. Type a new name, then press Enter.

To... Then do this...

Move elements 
from one section to 
another

Drag elements from one section to another.

Delete elements 
from the report 
header or footer

Click an element in a section and press 
Delete to delete it from the section.

To... Then do this...

Display a border 
around the elements in 
the header or footer

In the Header or Footer section of the 
dialog, select the Show Border checkbox.

Add a logo or other 
image to the report

1. Click Add Image.

The Add Image dialog opens.

2. Navigate to the folder that contains 
the image, then click Add.

The image is added to the section and 
the header or footer is displayed 
under Preview.

Format the report text Select a font, font size, color, or style for 
all text in the report.



BD FACSVerse System Reference216

Printing the 
analysis report

To print the analysis report:

1. Click the Report tab.

2. From the menu bar, select File > Print. 

3. Preview the report and make sure that all analysis items are in 
the print area of the page.

4. Select Print on the Print Preview menu bar.

5. Complete your typical printing process.

More information • Experiment analysis (page 204)

• Creating plots in a worksheet (page 158)

• Drawing gates in plots (page 164)
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Exporting experiment reports as PDFs 
Introduction This topic describes how to export reports as PDFs. 

Exporting reports in PDF format allows you to archive a report 
separately from the experiment. If your experiment includes 
multiple report tabs, you must select each and export them 
separately.

Procedure To export a report:

1. Open an experiment.

2. Click the Report tab.

3. From the menu bar, select File > Export To PDF. 

The Save As dialog opens.

4. Navigate to the folder where you want to export your report.

5. Type a file name in the Name field.

6. Click OK.

More information • Modifying experiment worksheets and reports (page 208)
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Creating a user-defined assay from an experiment 
Introduction This topic describes how to create a user-defined assay from an 

experiment.

About saving 
experiments

Experiments are automatically saved as you make changes to them. 
Creating a user-defined assay from an experiment is useful when 
an experiment must be repeated often by you or others. The user-
defined assays provide uniform cytometer settings and format.

When you create a user-defined assay from an experiment, all 
properties, parameters, and preferences become permanent in the 
assay. You cannot edit these properties and parameters in the 
worklist. 

If you want to edit properties, you must create an experiment from 
the assay, modify it, then save it as a user-defined assay again with 
the same name.

Procedure To create a user-defined assay from an experiment:

1. Build or open an experiment in the Experiment workspace.

See Creating and opening experiments (page 142).

2. From the menu bar, select File > Create Assay.

The Create Assay dialog opens.

3. In the Name field, type a name for the new user-defined assay.

If you intend to modify an existing user-defined assay and 
want to retain the same assay name, you can overwrite the 
original by creating an assay with the same name. Note that 
you cannot overwrite BD assays.

See Creating a new experiment from an assay (page 144) for 
more information about modifying an existing assay.

4. (Optional) In the Description field, type a description of any 
details you want to document for the assay.
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5. (Optional) Select the Share checkbox if you want this user-
defined assay to be shared with all users. 

You can also make the assay shared from within the library 
after you save it.

6. (Optional) Select a report to display in the Report to Display 
After Entry Run list. 

This sets the default report that appears after the worklist 
runs.

7. Click OK. 

The user-defined assay is added to the library. 

More information • Building a worklist (page 237)

• Changing resource sharing settings (page 306)
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7
Worklist acquisition and analysis

This section includes the following topics:

• Worklist overview (page 222)

• Using the Manage tab (page 223)

• Worklist tab overview (page 227)

• Worklist acquisition workflow (page 236)

• Building a worklist (page 237)

• Assigning keywords to entries and tubes (page 243)

• Working with audit trails (page 245)

• Acquiring data in a worklist (page 249)

• Worklist run options (page 254)

• Reacquiring entries in a worklist (page 257)

• Using the layout view with worklists (page 259)

• Approving entries in a worklist (page 264)

• Using ESignature (page 266)

• Exporting entries and worklists (page 268)

• Worklist analysis (page 270)

• Working with assay reports (page 273)
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Worklist overview
Introduction This topic describes the Manage and Worklist tabs in the Worklist 

workspace.

A worklist is a list of tasks to be performed for sample acquisition 
and analysis. The worklist organizes multiple entries, which 
include sample IDs, tubes, tasks, status, and other information 
about the sample. 

About the Worklist 
workspace

The Worklist workspace includes the Manage tab and Worklist 
tabs which represent open worklists.

To open the Worklist workspace, click Worklists in the navigation 
bar, or click a worklist shortcut on the Home page.

Use the Manage tab to create new worklists, open existing 
worklists, and filter, search, and share worklists with other users. 
Use the BD FACSuite menus to create, rename, import, and export 
worklists.

Use the Worklist tab to develop your worklist and acquire and 
analyze the data using different analysis tools.

Manage tab
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Using the Manage tab 
Introduction This topic describes how to use the worklist Manage tab to create, 

open, or import a worklist, and how to change the share settings, 
sort, filter, and delete worklists.

Creating a worklist To create a worklist:

1. On the navigation bar, click Worklists. 

The Manage tab opens.

2. From the menu bar, select File > New Worklist.

The new worklist opens as a new tab in the Worklist 
workspace.

Worklist tab
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Opening an 
existing worklist

To open an existing worklist:

1. In the Manage tab, double-click a worklist in the Worklist 
Information table.

Importing a 
worklist

To import a worklist from a folder:

1. From the menu bar, select File > Import Worklist.

The Import Worklist dialog opens.

2. Navigate to the folder that contains the worklist you want to 
import and select the worklist.

3. Click Open.

The worklist is displayed in the Worklist Information table.

Changing worklist 
share settings

Worklist owners (authors) can change or delete only their 
worklists. Administrators can change or delete all worklists.

Worklists are private by default, but can be shared with other 
users. The Shared column in the Worklists table indicates whether 
a worklist is shared (Y) or private (N).

To change the share setting for a worklist:

1. On the navigation bar, click Worklists. 

The Manage tab opens.

2. In the Worklist Information table, right-click a worklist in the 
Shared column.

• If a Y is displayed in the Shared column, select Make 
Private to make the worklist private.
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• If an N is displayed in the Shared column, select Share to 
share the worklist.

Sorting worklists in 
the table

To sort worklist files in the table:

1. In the Worklist Information table, click any column header.

2. Select a sort mode option (Ascending or Descending) and click 
OK.

The worklists are sorted by category. Names (text) are sorted 
in alphabetical order. Numeric values are sorted in ascending 
or descending order. An icon is displayed in the column header 
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that indicates ascending (down arrow), or descending (up 
arrow) order.

You can click the icon to toggle between ascending and 
descending sort modes.

Deleting worklists Deleting a worklist makes the data files associated with the 
worklist inaccessible in the database. When you delete a worklist, 
the entry run packages (ERPs) for the worklist are automatically 
exported to the default export folder (as defined in worklist 
preferences). You can navigate to the export folder to locate and 
import the ERPs.

To delete a worklist:

1. In the worklist Manage tab, click a worklist in the Worklist 
Information table.

2. From the menu bar, select Edit > Delete.

The worklist is deleted.

More information • Worklist tab overview (page 227)

• Setting worklist preferences (page 71)

• Building a worklist (page 237)

• Setting worklist preferences (page 71)
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Worklist tab overview
Introduction This topic describes the different panels in the Worklist tab and 

how you use them to build and run worklists.

About the Worklist 
tab 

When you create a new worklist or open an existing worklist in the 
Manage tab, a new Worklist tab opens. Use the Worklist tab to 
build and run a worklist. This tab includes the following controls, 
panels, and tables:

• Worklist controls

• Layout View

• Acquisition Status

• Tasks

• Loading Options

• Cytometer

• Worklist Entries table (worklist)

• Entry Details

About the Worklist 
Controls

The Worklist Controls bar is displayed at the top of the Worklist 
tab and includes options for different worklist acquisition, re-
acquisition, analysis, and stopping conditions. The following table 
describes the worklist controls.

Control Description

Load Click this button to load the sample carrier (tube rack or plate) with the 
optional Loader.

Unload Click this button to manually unload the current sample carrier with the 
optional Loader.

Mix Click this button to perform any mix actions on the sample carrier (based 
on default or custom sample carrier preferences).

Run All Click this button to acquire unacquired entries, tubes, or wells, or analyze 
acquired entries. Click the arrow button to select additional options. A 
worklist run begins with preview mode, then begins acquiring after the 
Acquisition Delay Timer expires. 
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See Worklist run options (page 254) for more information about 
the Worklist controls.

Re-Acquire 
Selected

Click this button to reacquire any acquired entries, tubes, or wells. Click 
the arrow button to select additional options.

Skip Tube Click this button to skip tubes, entries, or sample carriers during an 
acquisition or analysis run. Click the arrow button to select additional 
options.

Stop Tube Click this button to stop a tube (immediately). Click the arrow button to 
select to stop the run after a tube completes, or stop the run after an entry 
completes. 

Stop Timer

Resume

Before acquisition
During preview mode, the Stop Timer button controls the Acquisition 
Delay Timer.

Click this button to manually stop the timer countdown for a specific 
duration (defined by the Acquisition Delay Timer) and pause the worklist 
before acquisition begins. You can stop the timer if you need to adjust 
PMT voltages, thresholds, or modify gates and statistics markers. 

If you make changes, a dialog opens. In this dialog, select how you want to 
apply these changes to the worklist.

The next tube or entry in the worklist automatically starts when the pre-
defined Acquisition Delay Timer time expires, or if you click Resume.

After acquisition
After acquisition, the Stop Timer button controls the Report Delay Timer. 
The report displays data from an acquired entry until the timer expires. 
You can click Stop Timer (before time expires) to continue viewing the 
report and adjust gates and statistics markers. 

Click Resume to resume acquisition and display the next entry in the 
report.

You can adjust the duration of the Acquisition and Report delay timers in 
the Preferences dialog. See Setting worklist preferences (page 71) for more 
information.

Control Description
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About the Layout 
View panel

The Layout View panel displays the carrier ID of the tube rack or 
plate and the tube or well layout. The order of tubes is based on 
where they are displayed in the worklist. 

Right-click a tube or well in the layout to display properties of the 
tube or well.

About the 
Acquisition Status 
panel

Use the Acquisition Status panel to view real-time status for time, 
event counts, and aborts. You can also set flow rate, events to 
display, and SIT flush options specific to an acquisition.
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The settings apply to the entire worklist, not individual tubes. For 
some BD-defined assays, the assay controls the flow rate, events to 
display, and the SIT flush settings.

About the Tasks 
panel

The Tasks panel lists the available BD-defined and user-defined 
assays, and fluidics tasks you can add to a worklist.
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You can select one or more tasks, then click Add. You can also 
select a task, then add the task multiple times by typing a number 
in the field, then clicking Add.

About the Loading 
Options panel

Use the Loading Options panel to select the carrier type and 
manual or automated loading mode. The default is 40 Tube Rack, 
Loader (automatic mode). 

If you do not have the Loader option installed, the default is 
Manual.

In automatic mode, you can select the Unload sample carrier at the 
end of Worklist Run checkbox if you want to automatically unload 
the sample carrier after acquisition.

Select the Lock Positions checkbox if you want to maintain the 
physical location of the target tubes or wells—even if you re-order 
or add new entries in the worklist. This can be helpful when you 
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are manually preparing samples to run using the Loader. Note that 
you cannot unlock the positions once you lock them. 

About the 
Cytometer panel

Use the Cytometer panel to view system status, run cleaning 
protocols, and adjust PMT voltages.

The Status section displays the system status, including real-time 
status for the manual load port and Loader, fluidics, and lasers. 

A checkmark indicates a ready status. This tab also reminds you 
when you need to run system cleaning protocols.

Use the PMT Voltages section to view and adjust the PMT 
voltages, area, height, width, and enable and adjust thresholds for 
scatter or fluorescence parameters. You can also add or remove 
parameters before you run a worklist.
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During preview mode, you can adjust threshold and PMT voltages 
and the system will automatically adjust spillover values for the 
current worklist only.

About the Worklist 
Entries table

The Worklist Entries table (worklist) organizes multiple entries to 
be acquired or analyzed, and displays status and other information 
about the entry.
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Worklists include the following elements.

Worklist 
elements Description

Entries An entry includes a sample ID, tubes, and one task. 

You can start a new worklist with blank entries and add new tasks. You 
can also start by importing saved entry run packages into the worklist. An 
entry run package includes all information needed to replicate an entry in 
a different worklist. This includes acquired data.

You can acquire individual entries, tubes, or an entire worklist, then 
perform individual sample analysis or batch analysis (entire worklist).

Each entry has an ID. Each tube within an entry is a child of the entry. For 
example, if a entry number is 1, then the tube IDs are 1.1, 1.2, and 1.3. 

Sample ID Each entry requires a sample ID. You can specify a sample ID by typing in 
the Sample ID column for an entry, or by clicking in the column and 
scanning the barcode that contains the information.

Task A task is an action that is performed when you run a worklist. Tasks 
identify the assay (BD-defined or user-defined) or a fluidics action. 

Assays are a collection of tubes. There are two types of assays that you 
can run in a worklist: 

 BD-defined assays

 User-defined assays

Fluidics tasks include:

 Daily clean

 SIT flush

 Shutdown

When you add a task in the Task column, all tubes associated with the 
task are added to the entry.
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More information • Building a worklist (page 237)

• Defining custom sample carrier layouts (page 508)

• Using the layout view with worklists (page 259)

• BD FACS Universal Loader (page 501)

• Assigning keywords to entries and tubes (page 243)

Status The current entry status is displayed in the Status column. 

 Ready. Indicates that the entry has a sample ID and a task.

 Not Ready. Indicates that the entry does not have a sample ID or task.

 Ready for Acquisition. Indicates that the tube is ready to be acquired 
and has all required information.

 Complete. Indicates that the entry or tube has been acquired.

 Ready For Approval. Indicates that the entry or tube has been 
acquired and requires approval. This is displayed when Automatically 
Approve is not enabled for the assay (default).

 Approved. Indicates that the entry or tube has been approved. This is 
displayed when Automatically Approve is enabled for the assay.

 Needs Review. Indicates that changes were made to an audited entry. 
This is displayed when an audit trail is enabled.

Location The Location column identifies the tube or well location used for this 
entry.

Sample 
Carrier

The Sample Carrier column identifies the tube rack or plate for this entry.

You can select different sample carrier types using the Loading Options 
panel. You can select a specific carrier using the Layout View panel.

Worklist 
elements Description
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Worklist acquisition workflow 

Introduction This topic describes the typical workflow stages you need to 
complete to build a worklist and acquire data. 

Workflow stages Perform the following typical workflow stages for acquiring entries 
and tubes in a worklist.

More information • Worklist overview (page 222)

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data
Shut down
the system

Stage Description

1 Open an existing worklist, or create a new worklist and create 
new entries.

See Building a worklist (page 237).

2 Run the worklist.

See Acquiring data in a worklist (page 249).

3 (Optional) Modify worksheet elements or instrument settings 
(as permitted). You can only modify elements based on user 
privileges and assay type.

See Worklist tab overview (page 227).

4 (Optional) Approve the changes and/or results.

See Approving entries in a worklist (page 264).

5 Save, print, or export results, FCS files, or entry run packages. 

See Exporting entries and worklists (page 268) and Working 
with assay reports (page 273). 
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Building a worklist 
Introduction This topic describes how to build a worklist using default 

preferences. It includes information about creating or opening a 
worklist and adding entries. Once you build the worklist, you can 
save it, export it, or begin acquiring data. This topic also includes 
information about creating entries by importing entry run 
packages, adding fluidics entries, and setting acquisition options 
for an entry.

Building a worklist You can set worklist preferences for acquisition delay and report 
delay timers, manual tube loading, exporting, and printing.

To build a worklist:

1. Create a new worklist or open an existing worklist. 

2. In the first blank row in the worklist, click in the Sample ID 
column, type a sample ID for an entry or scan a barcode, and 
then press Enter.

A new entry is displayed in the worklist.

3. Click in the Task column and select an assay or fluidics task. 

All tubes associated with the task are added to the entry.

If you want to add multiple tasks to a worklist (at the same 
time), you can add tasks using the Tasks panel. See About the 
Tasks panel (page 230).
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When you add a sample ID and a task, the Status column 
displays Ready. Each associated tube displays Ready to 
Acquire. 

4. (Optional) Once you add an entry, assign keywords to an entry 
or tube, or enable an audit trail for the entry.

See Assigning keywords to entries and tubes (page 243) or 
Working with audit trails (page 245).

5. When you are finished adding entries you can do any of the 
following: 

• Modify the default loading options. 

• Modify worksheet or report elements, or instrument 
settings (as permitted by the assay type or your user 
privileges).

• Begin acquisition.

• Close and save the worklist.

Adding entries by 
importing an entry 
run package

Individual worklist entries can be exported as entry run packages 
(ERPs). You can import these ERP files into any worklist and 
analyze the entry. Note that you cannot import an ERP into a 
worklist if an identical entry already exists in the worklist.

To import an existing entry run package as an entry in your 
worklist:

1. Click to highlight an entry in the worklist.

2. Select File > Import > Entry Run Package.

The Import Entry Run Package dialog opens.

3. Select an available ERP file, then click Open.

The ERP populates the entry in the worklist.
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Adding fluidics 
cleaning or 
shutdown to a 
worklist

You can create entries in an existing worklist to automate fluidics 
cleaning and shutdown tasks, or create a standalone cleaning or 
clean and shutdown worklist that you can run at the end of each 
day.

To add fluidics cleaning or shutdown entries to an existing 
worklist:

1. In an existing worklist, navigate to the first blank row at the 
bottom of the worklist. 

2. Click in the Task column and select a fluidics task:

• Perform Daily Cleaning

• Perform SIT Flush

• Shutdown

The new entry is displayed at the end of the worklist.

3. If you want to insert a SIT flush task between other entries in 
the worklist, drag the SIT flush entry before or after another 
entry in the list. 

4. If your workflow requires additional steps, add additional 
entries and select the task. For example, add entries for daily 
cleaning and shutdown to shut down the system after the 
cleaning task completes.



BD FACSVerse System Reference240

The following figure shows a SIT flush task after each assay 
task entry. The daily cleaning and shutdown tasks are 
displayed at the end of the worklist.

The Layout View automatically displays the tube locations for 
the new entries. The following figure shows the tube locations 
for the daily cleaning task.

For cleaning tasks, make sure that your tube racks include a 
tube with 10% bleach and a tube with DI water in the 
locations identified in the Layout View. 

5. Save the worklist. 
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If you are creating a standalone fluidics cleaning worklist, 
make sure to name the worklist as a cleaning or clean and 
shutdown worklist when you save it.

Setting a fluidic 
mode or flow rate

The fluidic mode controls the speed that the combination of sheath 
and sample passes through the flow cell in the instrument. These 
modes include:

• Normal (uses low, medium, or high flow rates)

• High-sensitivity (uses a flow rate that obtains a better 
separation between the negative and positive fluorescence 
populations).

Flow rates (low, medium, or high) determine the rate that the 
sample flows through the flow cell in the instrument. 

Note that you cannot apply different fluidic modes to separate 
entries within the same worklist. Changing from one fluidic mode 
to another causes the cytometer settings to recalculate and requires 
time for the fluidics to stabilize. However, you can change from 
one flow rate to another without recalculation.

To select a different sample flow rate or fluidic mode:

1. In the Acquisition Status panel, select a different flow rate than 
the default (medium). This setting applies to all entries in the 
worklist.

Note that if you are running a BD-defined assay, this setting 
might be controlled by the assay.

Setting the number 
of events to display

To set the number of events to display:

1. In the Acquisition Status panel, select the number of events to 
display. This setting applies to all entries in the worklist.

Note that if you are running a BD-defined assay, this setting 
might be controlled by the assay. 
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Saving a worklist Worklists are automatically saved as you add entries or make 
changes. You can also manually save the worklist at any time. All 
worklist entries and acquired data are saved only with the worklist 
(not as separate entities). 

To save a worklist when you close it:

1. Click the X on the worklist tab to close the worklist.

The Save Worklist dialog opens. 

2. In the Worklist Name field, type a name and click the Save 
button. 

To save the worklist at any time:

1. From the menu bar, select File > Save.

Next step Acquiring data in a worklist (page 249)

More information • Using the Manage tab (page 223)

• Defining custom sample carrier layouts (page 508)

• Using the layout view with worklists (page 259)

• Exporting entries and worklists (page 268)

• Running the daily clean procedure (page 469)
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Assigning keywords to entries and tubes 
Introduction This topic describes how to assign keywords to entries in a 

worklist. 

Assigning 
keywords to entries

To assign keywords to a worklist entry:

1. In the Worklist Entries table, right-click in the first column of a 
worklist entry, then select Assign Keywords. 

The Assign Keywords to Entry dialog opens.

2. (Optional) In the Keyword Filter field, type a partial or 
complete keyword name or identifier. 

The table filters keywords by name or identifier.

3. (Optional) Select the Show System Defined Keywords 
checkbox to include system-defined keywords in the list.
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4. (Optional) Click Keyword Properties, then click a keyword in 
the list to display its properties.

5. In the Assign Keyword column, select the checkbox for all 
keywords you want to assign to the entry.

6. (Optional) In the Show Column column, select the checkbox 
for any keyword that you want to include as columns in the 
worklist.

7. Click OK to apply your assignments and close the dialog.

Assigning 
keywords to tubes

To assign keywords to tubes or wells:

1. In the Worklist Entries table, right-click a tube in an entry, then 
select Assign Keywords. 

The Assign Keywords to Tube dialog opens.

2. In the Assign Keyword column, select the checkbox for each 
keyword you want to assign to the tube.

Keyword properties
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3. (Optional) In the Show Column column, select the checkbox 
for any keyword you want to include as a column in the 
worklist.

4. Click OK to apply your assignments and close the dialog.

More information • Using the Manage tab (page 223)

• Understanding keywords (page 297)

• Working with keywords in the library (page 299)

• Defining custom sample carrier layouts (page 508)

Working with audit trails 
Introduction This topic describes how to enable audit trails for entries in 

worklists, how to work with audited entries, and how to view, 
print, and export the audit trail log.

About audit trails Audit trails track changes to entries. Any changes that affect the 
data (for example, instrument settings, worksheet, reports, plots, 
gates, and statistics markers) are listed as changes in the audit trail 
log. 

When an audit trail is enabled, the following information is 
tracked:

• Date and time of changes

• User ID

• Reason for the changes

• Details of the changes

If you enable an audit trail for entries and then modify the audited 
entries, you must provide reasons for the changes for each entry. 
This helps to provide a more accurate history of the changes.
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Once you enable an audit trail, you cannot disable it. The audit 
trail is saved as part of the entry run package. 

Enabling an audit 
trail

To enable an audit trail:

1. Right-click the entry number, then select Enable Audit Trail. 

A confirmation dialog opens.

2. Click OK. 

A green audit icon is displayed in the Status column. 

Modifying audited 
entries

To modify audited entries:

1. Modify the entry (for example, the worksheet or report). 

A yellow audit icon is displayed and remains yellow until you 
provide a reason for the change.

2. Right-click the entry and select Provide Reason for Change. 
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The Reason for Change (number of changes) Entries dialog 
opens. 

3. Under Change Summary, select an entry.

4. Under Enter Reason, type a reason for the changing the 
selected entry.

5. Click OK. 

The reason is added to the audit trail log and the yellow audit 
icon turns green.
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Reviewing the 
audit trail log

To review the audit trail log:

1. Click an audited entry in the worklist to select it.

2. Right-click the entry and select View Audit Trail. 

The Audit Trail Log dialog opens.

The task name is displayed in the title bar. The audit trail log 
displays the history of changes and the reason for each change.

Printing the audit 
trail log

To print the audit trail log:

1. Click Print in the lower-right corner of the dialog.

The Audit Trail Viewer Print View dialog opens. 

2. Click the Print icon. 

The Print dialog opens.

3. Complete your typical printing procedure. 



Chapter 7: Worklist acquisition and analysis 249

Exporting the audit 
trail log

To export the audit trail log as a PDF file:

1. Click Export in the lower-right corner of the dialog.

The Export Audit Trail dialog opens. 

2. Click Save. 

The PDF file is exported to the default audit trail folder.

More information • Approving entries in a worklist (page 264)

• Using ESignature (page 266)

Acquiring data in a worklist 
Introduction This topic describes the worklist controls and how to load tubes or 

plates and start acquisition for assays in a worklist. 

Acquisition is performed only on entries that do not have an 
associated FCS file. If you want to reacquire an entry, tubes, or a 
worklist, see Reacquiring entries in a worklist (page 257).

Before you begin • Run performance QC and assay and tube settings setup.

• Build a worklist.

Loading or 
unloading tubes or 
plates

If you have the Loader option, you load prepared sample carriers 
onto the Loader, then the sample carriers are automatically loaded 
into the cytometer. If you do not have the Loader option, you need 
to load each tube manually.
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1. Complete one of the actions in the following table.

Running entries in 
the worklist

To run entries in a worklist:

1. Make sure that the entry is ready to be acquired. The Status 
column should display Ready (entry) and Ready to Acquire 
(tubes).

2. In the Worklist Controls bar, click Run All.

To... Then do this...

Manually load a 
single tube

1. Click Run All.

2. Follow the system prompts for loading and unloading tubes.

3. When the LED ring light turns green, place a tube onto the 
manual tube port and press the top of the tube onto the gasket 
until you feel a click.

The LED ring light turns off. 

4. Repeat for each tube as needed.

Manually unload a 
single tube

Carefully pull the tube down from manual tube port.

Automatically 
load a tube rack or 
plate

1. Make sure the sample carrier is loaded onto the Loader tray.

2. Click Load or Run All on the Worklist Controls bar.

Unload a tube rack 
or plate

If Unload sample carrier at the end of the run is selected in the 
Loading Options panel, the sample carrier automatically unloads 
after the acquisition completes. 

If the checkbox is not selected, the sample carrier remains in 
position until you click Unload in the Worklist Controls bar.
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3. Follow the instructions on the dialog that opens. 

The worklist run starts by previewing the first unacquired 
tube. 

4. (Optional) Pause the worklist in preview mode. 

a. Click Stop Timer to manually stop the acquisition delay 
timer countdown and pause the worklist for a specific 
duration before acquisition begins. 

Stop the timer if you need to adjust PMT voltages, 
thresholds, or modify gates and statistics markers. If you 
make changes, the Preview dialog opens.

b. Select how you want to apply these changes to the worklist, 
then click OK.
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c. Click Resume. Acquisition of the tube automatically starts.

As acquisition progresses, the Acquisition Status panel displays 
the time, events, and an acquisition progress bar. The run 
pointer moves to the next entry as each entry completes, until 
each entry is completely acquired.

5. (Optional) Review the results during assay acquisition.

During acquisition, the results are displayed on the assay 
worksheet in the Entry Detail panel. Data is displayed in the 
report after the entry is acquired.
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6. (Optional) Modify gates or statistics on the report once the 
report is populated with data.

After acquisition, the Stop Timer button controls the report 
delay timer. The report displays data from an acquired entry 
until the timer expires. You can click Stop Timer (before time 
expires) to continue viewing the report and adjust gates and 
statistics markers. Click Resume to resume acquisition and 
display the next entry or tube in the report.

See Setting worklist preferences (page 71) for information 
about changing the timer settings.

7. (Optional) After acquisition, select a row in the worklist to 
manually display the worksheets and reports of tubes and 
entries.

8. (Optional) View the tube properties for any tube in the entry 
by selecting a tube in the Entry Detail toolbar.

9. (Optional) View acquired data for specific tubes by selecting a 
current tube for this entry in the Entry Detail toolbar.

You can also click the arrow buttons on the right side of the 
toolbar to view results for the previous entry or the next entry.

Next steps You can continue by approving acquired entries, re-acquiring 
specific entries in a worklist, exporting entry run packages, or 
performing analysis on the acquired entries.
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More information • Worklist analysis (page 270)

• Worklist run options (page 254)

• Loading or unloading tubes or plates (page 249)

• Reacquiring entries in a worklist (page 257)

• Modifying tube properties (page 167)

• Running daily performance QC (page 123)

• Worklist tab overview (page 227)

• Approving entries in a worklist (page 264)

Worklist run options
Introduction This topic describes worklist run options. 

About worklist run 
order

Acquisition can be performed in different run order depending on 
the acquisition status of the tubes and where you want to start in a 
worklist. Once you start a worklist run, you cannot re-order tubes 
or entries during acquisition. You can add entries to the end of the 
worklist as it is running. However, the entry is assigned to a new 
sample carrier.

If you are using the Loader option, you can use the Layout View 
panel to view wells and tubes as they are ordered in the worklist. If 
you re-order entries or tubes in the worklist, the tray layout 
updates to match the worklist. If you prefer, you can lock the tray 
layout for a sample carrier, so that worklist changes do not affect 
the current layout. Any new entries are assigned to a different 
sample carrier. If you lock the tray, you cannot unlock it.
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Running all entries To run all entries:

1. Click Run All in the Worklist Control bar.

If your worklist includes acquired and unacquired entries, a 
dialog opens. 

• Click Start Acquisition Run to acquire any unacquired 
tubes or entries. 

• Click Start Batch Analysis Run to start analyzing acquired 
tubes or entries.

If your worklist includes acquired entries or tubes (FCS files 
exist for the entry or tube), you can reacquire. See Reacquiring 
entries in a worklist (page 257).

If you do not want to run the entire worklist from start to finish, 
you can perform one of the actions in the following sections.
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Running one or 
multiple entries

To run one or multiple entries in a worklist:

1. Complete one of the actions in the following table.

Skipping tubes, 
entries, and carriers

To skip tubes, entries, and sample carriers:

1. Complete one of the actions in the following table.

To... Then do this...

Run from a 
specific entry or 
tube and all 
subsequent tubes

1. Click a specific entry or tube in the worklist to set the run pointer.

2. Click the arrow next to the Run All button and select Run from 
pointer.

The worklist starts with the specified tube, then runs all 
subsequent tubes in the worklist.

Run a specific 
entry or tube in 
the worklist. 

1. Ctrl+click entries or tubes anywhere in the worklist. The tubes do 
not need to be adjacent in the worklist.

2. Click the arrow next to the Run All button and select Run 
selected.

The worklist starts with the specified tube and continues with the 
next selected entry or tube in the worklist. 

To... Then do this...

Skip a tube in a 
worklist

1. Click a specific tube in the worklist.

2. Click Skip Tube.

Skip an entry 1. Click a specific entry in the worklist.

2. Click the arrow next to the Skip Tube button and click Skip Entry.

Skip a carrier 
type

This applies only to systems using the optional Loader hardware.

1. In the Sample Carrier ID column, click a specific carrier for a 
tube.

2. Click the arrow next to the Skip Tube button and click Skip 
Sample Carrier.
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Stopping a worklist 
run

To stop the worklist run:

1. Complete one of the actions in the following table.

More information • Worklist overview (page 222)

• Acquiring data in a worklist (page 249)

• Reacquiring entries in a worklist (page 257)

Reacquiring entries in a worklist 
Introduction This topic describes when you can reacquire entries, tubes, or the 

entire worklist and how to reacquire them. 

You can only reacquire if FCS files exist for the entry or worklist.

How you know 
when FCS files exist

After an entry or tube is acquired, a message is displayed in the 
Status column of the worklist.

• If the Status column displays Complete, or if the tube icon is 
displayed as a filled tube, then an FCS file exists and you can 
reacquire if needed.

To... Then do this...

Stop the current 
tube immediately

1. Click a specific tube in the worklist.

2. Click Stop Tube.

Stop the worklist 
after the current 
tube completes

1. Click a specific tube in the worklist.

2. Click the arrow next to the Stop Tube button and click Stop 
After Tube Completes.

Stop the worklist 
after the current 
entry completes

1. Click a specific tube in the worklist.

2. Click the arrow next to the Stop Tube button and click Stop 
After Entry Completes.
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• If the Status column displays Ready To Acquire, you have not 
acquired the entry or tube and no FCS file exists. 

Reacquiring in a 
worklist

To reacquire in a worklist:

1. Complete one of the actions in the following table.

To... Then do this...

Reacquire an 
entire worklist

1. Select the first tube in the worklist. 

2. Click Re-Acquire All. 

This reacquires all tubes in the worklist that have an FCS file.

If your worklist includes acquired and unacquired entries, a dialog 
opens. Use this dialog to select how to run acquired or unacquired 
entries.

Reacquire from 
a specific 
starting point

1. Set the run pointer at a specific tube.

2. Click the arrow next to the Re-Acquire All button, then click Re-
Acquire from Pointer. 

This reacquires all subsequent tubes in the worklist that have an 
FCS file.

Reacquire 
specific entries 
or tubes

1. Ctrl+click to select specific tubes that have an FCS file.

The selected entries or tubes do not have to be adjacent.

2. Click the arrow next to the Re-Acquire All button, then click Re-
Acquire Selected. 

Restart a 
partially 
acquired tube

1. Select the tube that was stopped.

2. Click the arrow next to the Re-Acquire All button, then click Re-
Acquire Selected. 
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More information • Worklist analysis (page 270)

• Worklist run options (page 254)

Using the layout view with worklists
Introduction This topic describes how entries are assigned in the Layout View 

panel, how to view well details, and how to monitor the status of 
an acquisition. This topic also provides definitions for status 
indicators.

How entries 
populate the tray 
layout

As you add entries in a worklist, each tube in the entry is added to 
the layout view based on the loading options and run pattern you 
selected when you defined the layout. The entries populate the 
layout view starting with A1. 

The following example shows Entry #1, Test sample (tube 1) 
mapping to the A1 tube in a tube rack. This example uses a linear-
horizontal run pattern.
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Viewing tube or 
well details

You can view tube or well details by moving the mouse pointer 
over any populated well or tube. Note that the run pointer moves 
to the next well or tube after the well or tube is acquired or 
analyzed. You can manually set the run pointer to a different well 
or tube.

Run pointer
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Setting the run 
pointer in the 
layout view

The run pointer in the layout view is synchronized with the run 
pointer in the worklist. It automatically moves to the next well or 
tube after the well or tube is acquired or analyzed. 

In the layout view, you can manually set the run pointer on a 
different well or tube, then click Run from pointer in the worklist 
controls.

To manually set the run pointer to a different well or tube:

1. In the layout view, click a target well or tube.

2. Right-click the target well or tube and select Set Run Pointer.

The run pointer is set to the target well or tube.

Run pointer

Run pointer
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Monitoring 
worklist acquisition 
and analysis

You can monitor the status of a worklist run by viewing the color 
of each tube or well in the Layout View. The following illustration 
shows the color indicators.

The following table describes the layout view indicators and their 
corresponding meanings in the worklist

Indicator Description Worklist equivalent

Location not assigned. No tubes in an entry.

Tube or well has a sample. Tubes exist in a worklist 
entry.

Tube or well (with 
sample) is selected by the 
run pointer. 

The run pointer is set to a 
tube in the worklist.

Tube or well is 
previewing. 

Previewing is displayed in 
the worklist Status column.

Previewing

Assigned

Acquired
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More information • Exporting entries and worklists (page 268)

• Approving entries in a worklist (page 264)

Tube or well acquisition is 
in progress. 

Acquiring is displayed in 
the worklist Status column.

Acquisition is complete. Complete is displayed in the 
worklist Status column.

Tube or well acquisition 
error. 

Needs Review is displayed 
in the worklist Status 
column.

Indicator Description Worklist equivalent
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Approving entries in a worklist 
Introduction This topic describes how to approve entries after an acquisition or 

analysis. 

About entry 
approval

After an entry is acquired in a worklist, the Status column displays 
one of the following status messages.

If your laboratory workflow requires manual approval of an entry 
before work can continue, you can manually approve or reject it. 
You can also save a worklist without approving, then return to the 
worklist at a later time and finalize the status.

Status message Condition

Approved This message is displayed when Automatically 
Approve is enabled for the assay, or when you 
manually approve the entry.

ReadyForApproval This message is displayed when Automatically 
Approve is not enabled for the assay (default) 
and when no errors are reported for this entry.

NeedsReview This message is displayed when an audit trail is 
enabled and you make changes to the plots, 
gates, statistics, or expressions in an assay and 
when no errors are reported for the entry.
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Approving an entry Note that Approve and Sign have different functions and are 
controlled by user permissions. Approving an entry automatically 
releases results to the LIS.

To approve an entry:

1. Run an assay in a worklist. 

When the worklist run completes, a ReadyForApproval or 
NeedsReview message is displayed in the Status column.

2. Approve the entry by doing one of the following.

• Right-click the entry number, then select Approve.

• Ctrl+right-click to select multiple entries, then select 
Approve.

• In the Entry Detail, click Approve in the toolbar.

If you do not want to approve the entry, you can click Not 
Approve. The status changes to Not Approved.

Next step Export entry run packages or analyze entries in a worklist.
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More information • Using ESignature (page 266)

• Exporting entries and worklists (page 268)

• Working with audit trails (page 245)

• Worklist analysis (page 270)

Using ESignature
Introduction This topic describes how to electronically sign a report after an 

acquisition or analysis.

E-signing reports To E-sign reports:

1. View the report to see if the report requires an e-signature.

 If e-signature is enabled for the report, the signature box is 
displayed at the bottom of the report.

E-signature can be enabled for a user-defined assay in the 
library. See Editing assay properties (page 284).

2. In the Worklist Entries table, right-click the entry number that 
corresponds to the report, then select e-Sign.
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The ESignature dialog opens.

3. Select a user ID.

4. Type your password.

5. (Optional) Enter any comments.

6. Click Sign. 

The e-signature box displays the signers user id, date and time, 
and comments that were entered.

If you modify the worksheet or report layout, or any other 
elements or settings that affect the data after you e-sign the 
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report, the report is automatically un-signed and must be e-
signed again.

More information • Approving entries in a worklist (page 264)

• Working with audit trails (page 245)

Exporting entries and worklists
Introduction This topic describes how to export individual worklist entries as 

entry run packages (ERPs) and how to export complete worklists. 

You can build a base of specific re-usable worklists, and archive, 
share, and import ERPs into other worklists.

About entry run 
packages

Entry run packages are standalone, individual entries from a 
worklist that include everything that is required to recreate the 
entry in a different worklist. You can set export preferences to 
automatically export ERPs after each worklist acquisition, or you 
can manually export specific entries.

ERP data includes: 

• The assay

• Worksheets and reports

• Audit trails

• Tube settings

• Tube properties

• Assigned keywords

• Acquired data
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Manually exporting 
entries as ERPs

To manually export entries as ERPs:

1. In the navigation bar, click Worklists.

The Worklist workspace opens.

2. In the worklist Manage tab, click a worklist in the Worklist 
Information table.

The worklist opens.

3. Click to highlight an entry in the worklist. 

4. From the menu bar, select File > Export > Entry Run Package.

The Browse for Folder dialog opens.

5. Navigate to an export target folder (for example, 
C:\BDExport\ERP\Worklists).

6. Click OK. 

The entry is exported as an ERP file.

Exporting worklists To export a worklist:

1. In the worklist Manage tab, click a worklist in the Worklist 
Information table.

2. From the menu bar, select File > Export Worklist > With Data.

The Export Worklist path dialog opens.

3. Navigate to an export target folder (for example, 
C:\BDExport\AssayWorklists).

4. (Optional) Before you click Save, modify the name of the 
worklist if needed.

5. Click Save.
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More information • Building a worklist (page 237)

• Setting worklist preferences (page 71)

• Assigning keywords to entries and tubes (page 243)

Worklist analysis

Introduction This topic describes what you can analyze in a worklist and how 
worklist analysis works. It also provides a worklist analysis 
workflow and instructions for analyzing individual entries and 
entire worklists.

About worklist 
analysis

Analyzing worklists is an automated process that results in an 
automatically generated report and/or automatically exported 
statistics files.

You can analyze any individual entry or tube that has been 
acquired, or use batch analysis to analyze all acquired entries or 
tubes in a worklist. Batch analysis allows you to increment files, 
pause between data sets, and print automatically.

Acquisition and batch analysis cannot run simultaneously for the 
same worklist. However, a worklist acquisition can be running 
while a different worklist batch analysis is running.

You can start an acquisition run and simultaneously analyze the 
results of a selected tube or entry in the same worklist. 

See topics in the following sections about analyzing entries and 
tubes in a worklist, and working with assay reports.

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data
Shut down
the system
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Typical analysis 
workflow

The following table describes the typical worklist analysis 
workflow stages.

Before you begin You need to have acquired data from at least one entry or tube. 
Batch analysis is performed only on entries or tubes that have an 
associated FCS file. A worklist batch analysis run skips tubes that 
do not have an FCS file. 

Stage Description

1 Create a new worklist and import entry run packages, or 
open an existing worklist.

See Using the Manage tab (page 223) and Building a worklist 
(page 237).

2 Modify worksheet or report elements, or instrument settings 
(as permitted). 

See Worklist tab overview (page 227).

3 Run the worklist.

See Worklist run options (page 254).

4 Approve the results.

See Approving entries in a worklist (page 264).

5 Print or export results, FCS files, or entry run packages.

See Exporting entries and worklists (page 268).
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Analyzing selected 
entries or tubes in 
a worklist

To run analysis on selected entries or tubes in the worklist:

1. Click an entry or tube in the worklist that has been acquired 
and includes an FCS file. 

This is indicated by a Complete status in the Status column for 
the entry or tube.

2. Click Run Selected on the Worklist control bar. 

Analysis begins.

3. The analysis preview opens in the assay worksheet.
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Performing analysis 
on an entire 
worklist

To run analysis on an entire worklist:

1. Click Run All on the Worklist control bar. 

Batch analysis begins and analyzes entries and tubes with 
acquired data.

More information • Acquiring data in a worklist (page 249)

• Working with assay reports (page 273)

Working with assay reports
Introduction This topic describes how to view assay reports and how to modify 

report elements and save the assay as a new user-defined assay. 

About assay 
reports

Reports must be created in an experiment. When you create a user-
defined assay from an experiment, the report is included in the new 
user-defined assay. If your user-defined assay includes a report, the 
plots and statistics automatically display data when you acquire or 
analyze a worklist. 

If you are using a BD-defined assay, reports are included in the 
assay. The plots and statistics automatically populate with data 
when you acquire or analyze a worklist.

If you want to modify an assay report, you must create a new 
experiment from the assay, modify the report, then create a new 
user-defined assay from the modified experiment. When you create 
an experiment from a BD-defined assay, the reports and data are 
removed. When you create an experiment from a user-defined 
assay, the report and data is included.

See Creating a new experiment from an assay (page 144) for 
information about modifying assays.

Reports are automatically saved with the worklist.
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Viewing reports in 
the worklist

After you run a worklist, the report is displayed in the Entry 
Details panel. The plots and statistics are populated with acquired 
data.

Viewing saved 
reports

To review a saved assay report:

1. In the navigation bar, click Worklists.

2. In the Manage tab, double-click a worklist in the Worklist 
Information table.

The saved worklist opens and the saved report is displayed in 
the Entry Detail panel.
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3. If an E-signature box is displayed at the bottom of the report, 
the report might require approval or electronic signature. 
Perform your typical procedure for approval.

Modifying user-
defined assay 
report elements

See Creating experiment analysis reports (page 206) and 
Formatting and printing a report (page 213).

More information • Worklist analysis (page 270)

• Editing assay properties (page 284)

• Approving entries in a worklist (page 264)

• Using ESignature (page 266)
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Part 3: Software
reference

This part includes the following sections:

• Library (page 279)

• Plots (page 307)

• Gates and populations (page 343)

• Statistics (page 399)

• Expressions (page 419)

• Data analysis example (page 433)

• Keywords (page 453)
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8
Library

This section includes detailed information about the library and procedures that are not 
typically part of the daily workflow. Use this section to learn about adding, editing, 
importing, exporting, and managing shared resources in the library. 

This section includes the following topics:

• Library overview (page 280)

• Importing and exporting assays (page 283)

• Editing assay properties (page 284)

• Working with bead lots in the library (page 289)

• Working with reagents in the library (page 290)

• Importing and exporting tube settings (page 294)

• Working with tube settings in the library (page 296)

• Understanding keywords (page 297)

• Importing and exporting keywords (page 298)

• Working with keywords in the library (page 299)

• Working with labels in the library (page 302)

• Locating library resources (page 303)

• Changing resource sharing settings (page 306)
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Library overview 
Introduction This topic describes the Library workspace.   

About the library The library serves as the repository for shared and frequently used 
resources. You can add resources to the library, manage them, and 
modify details. 

Most resources are shared and visible to all users. Some library 
resources are editable within the library and others are defined in 
different workspaces and are read-only in the library.

The library workspace stores the following resources:

• BD-defined and user-defined assays

• Bead and reagent information

• BD-defined (LW/LNW) and user-defined tube settings

• All keywords

• Labels

The following table describes where library resources are created 
and used by other functions in BD FACSuite software.

Resource Created in Used with

Assays BD-defined assays are 
installed. User-defined 
assays are created from 
experiments.

 Assay and Tube settings setup 
(Setup & QC)

 Worklist tasks (Worklist)

 Assay properties (Library)

Beads and 
Reagents

Bead lots and reagents are 
imported or installed.

 Characterization QC 

 Performance QC 

 Assay and Tube settings setup 

(all in Setup & QC)
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The Library workspace includes the following panels:

• Library. This panel includes the library tree which lists the 
categories of library resources that you can view in the 
workspace.

• Information. When you select a category in the Library panel, 
this panel displays a table that lists all items in the category. 

Keywords Library  Tube properties (Experiment)

 Entry and tube details (Worklist)

Labels BD labels are included with 
BD FACSuite software. 
User-defined labels are 
created in the library.

 Tube properties (Experiment)

 Creating reference settings 
(Experiment)

Tube settings Experiments  Assay and Tube settings setup 
(Setup & QC)

 Tube properties (Experiment)

 Creating reference settings 
(Experiment)

Resource Created in Used with
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• Detail. When you select an item in the table, the Detail panel 
displays the details for the selected item.

Library viewing 
options

You can click the view selector to change how you view 
information and detail panels for library resources. 

Library panel

Detail panel

Information panel

Information panel above the detail panel

Information panel only

Detail panel only

View selector
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More information • Importing and exporting assays (page 283)

• Working with bead lots in the library (page 289)

Importing and exporting assays 
Introduction This topic describes how to import and export assays. 

About importing 
and exporting 
assays

You can import assays from other folders or network locations 
into the BD FACSuite library. Imported assays include all pre-
defined properties, tube-settings, worksheets, reports, keywords, 
expressions, statistics, and results that were saved with the original 
assay. 

You can export user-defined assays from the library to other 
folders or network locations. You cannot import or export BD-
defined assays. BD-defined assays are installed using installer 
software that is included with the assay or kit.

Importing an assay To import an assay:

1. On the navigation bar, click Library.

2. In the Library panel, double-click Assays, then click User-
defined.

3. From the menu bar, select File > Import.

The Import Assay dialog opens.

4. Navigate to the folder or network location that contains the 
assay you want to import. 

5. Select the assay and click Open. 

If an assay with the same name already exists in the library, a 
dialog opens and prompts you to name the imported assay.
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The assay is imported and is displayed in the Assays table.

Exporting an assay To export an assay:

1. In the Library panel, double-click Assays, then click User-
defined.

Available assays are displayed in the Assays table.

2. In the Assays table, click the user-defined assay you want to 
export.

3. From the menu bar, select File > Export. 

The Export Assay dialog opens.

4. Navigate to the folder that contains your exported assays (for 
example, C:\BDExport\Library\Assays).

5. Click Save. 

The assay is exported. 

More information • Library overview (page 280)

• Editing assay properties (page 284)

Editing assay properties 
Introduction This topic describes how to edit assay properties in the library. You 

can modify properties for user-defined assays only.

Renaming user-
defined assays

To rename user-defined assays in the Assays table:

1. On the navigation bar, click Library. 

2. In the Library panel, double-click Assays, then click User-
defined.
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3. Right-click a user-defined assay in the Assays table, then select 
Rename to enable editing.

4. Type a new name over the existing name, then click the field to 
apply the new name.

Editing assay 
results approval 
criteria

To edit assay results approval criteria:

1. Click an assay in the Assays table.

The assay details are displayed in the Details panel.

2. Click the General tab.

3. Under Approve Results, select the Automatically Approve 
checkbox to automatically approve results when acquisition 
completes and there are no acquisition errors.

4. Click Save.

Editing results 
exporting 
properties

You can automatically export assay results and keywords as CSV 
files.

To edit results exporting properties:

1. Click an assay in the Assays table, then click the Export 
Results tab.
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2. In the Keywords & Expressions, Statistics, and Selected boxes, 
complete one of the following options.

The results file displays the results in the same order as they appear 
in the Export Results tab.

To... Then do this...

Add one item to the Selected 
box

Click the item in the list, then click 
Select.

Add all available items to 
the Selected box

Ctrl+click each item, then click 
Select All.

Remove one item from the 
Selected box

Click an item in the Selected list, 
then click Remove.

Remove all items from the 
Selected box.

Ctrl+click each item in the Selected 
list, then click Remove All.

Reorganize the list of 
selected items

Click an item in the Selected list, 
then click Move Up or Move 
Down to move the item.
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Important note 
about results data

The results data displayed in the Export Results tab must be 
defined when you create a worksheet or report. 

See Exporting statistics from statistics views (page 416) for 
instructions about including this results data in the user-defined 
assay.

Editing assay 
report preferences

BD FACSuite software generates user-defined reports based on the 
report layout. You can specify which assay reports are 
automatically printed or e-signed, and whether to display a report 
when running a worklist or export a report after running a 
worklist. 

If you select the checkboxes in this tab, you override the default 
worklist preferences for printing and exporting.

To edit assay report preferences:

1. Click an assay in the Assays table, then click the Reports tab.

2. Select the Print report checkbox to automatically print the 
entire report after you run the assay.

3. Select the Include e-Signatures checkbox to enable electronic 
signatures in the worklist entry and the signature box on the 
report. 
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You can electronically sign entries in the worklist after data 
has been acquired. The signature box is displayed on the 
report. 

This is an optional report element. However, you should 
include it for your assay report if supervisor or administrator 
signature is required in your laboratory.

4. Select the Display report when running assay checkbox to 
display the report and worksheets while the assay runs.

5. Select the Export report to checkbox, then click Change to 
select an export location.

6. Click Save.

More information • Modifying experiment worksheets and reports (page 208)
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Working with bead lots in the library 
Introduction This topic describes how to add, edit, and delete bead lots in the 

library. To import or add a CS&T bead lot into the library, see 
Importing or adding a CS&T bead lot (page 82).

Importing FC bead 
lots

You need to import or add bead lots when you get a new bead lot 
or when beads expire. Beads are shared resources and are visible to 
all users. 

To import FC beads:

1. On the navigation bar, click Library. 

2. In the Library panel, double-click Beads and Reagents, then 
click FC Beads.

3. From the main menu, select File > Import.

The Import dialog opens.

4. Navigate to the folder that contains the bead lot files.

5. Click Open.

A table for the selected subcategory displays the lot or file.

Adding a new FC 
bead lot

To add a new FC bead lot using the barcode scanner:

1. On the navigation bar, click Library. 

2. In the Library panel, double-click Beads and Reagents, then 
click FC Beads. 

3. In the FC Bead Lots table, click Scan Barcode and scan the 
new bead lot barcode. 

The information is automatically displayed in the FC Bead 
Lots table. 
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Deleting bead lots To delete bead lots:

1. In the Library panel, double-click Beads and Reagents, then 
click CS&T or FC Beads.

2. Click a bead lot in the Bead Lots table.

3. In the table title bar, click Delete.

A delete confirmation dialog opens.

4. Click Yes.

The bead lot is deleted from the Bead Lots table.

More information • Library overview (page 280)

• Working with reagents in the library (page 290)

Working with reagents in the library 
Introduction This topic describes how to add, edit, and delete reagents in the 

library. Reagents are shared resources and are visible to all users.

Adding reagents in 
the library

You need to import existing reagents or manually add reagents 
when required by a BD-defined assay, when reagents expire, or 
when you want to use specific reagents with an experiment. 

To manually add reagents:

1. On the navigation bar, click Library. 

2. In the Library panel, double-click Beads and Reagents, then 
click Reagents. 

3. In the Reagents table, click Add. 
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The New Reagent details panel is displayed.

4. In the New Reagent details panel, type the reagent information 
in the fields, then click Done.

See your reagent package insert or data sheet for the 
information.

The new reagent is displayed in the Reagent table.

Reagent details
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Adding a new 
reagent lot

Create a new reagent lot ID as needed after you add a new reagent.

To add a new reagent lot:

1. Click a reagent in the Reagents table. 

The reagent details are displayed in the Details panel.

2. Click Add New Lot.

The Add/Edit Lot ID dialog opens.

3. If the reagent is a single-color reagent, select the Single Color 
checkbox.

4. In the Lot ID field, type a new lot ID.

5. In the Expiration Date field, click the calendar and select an 
expiration date for the new reagent lot. The expiration date for 
reagents is listed on the vial or on the box.

6. Click OK.

The reagent lot ID is displayed.
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Editing reagent lot 
ID expiration dates

To edit the expiration date for an existing reagent lot ID:

1. In the Details panel, click Edit Lot.

The Add/Edit Lot ID dialog opens.

2. In the Expiration Date field, click the calendar and select an 
expiration date for the new reagent lot.

3. Click OK.

Editing reagent 
details

To edit existing reagent details:

1. Click a reagent in the Reagents table. 

The reagent details are displayed in the Details panel.

2. Click Edit to enable editing in the fields.

3. Edit the fields as needed, then click Done.

Deleting reagents To delete reagents:

1. Click a reagent in the Reagents table.

2. In the table title bar, click Delete.

A delete confirmation dialog opens.

3. Click Yes.

The reagent is deleted from the Reagents table.

Exporting reagent 
information

You can export reagent information so that it can be imported by 
other users on different workstations. This can be helpful in 
reducing the amount of data entry if you are adding numerous 
reagents to the library.

To export reagent information:

1. In the Reagents table, click a reagent. 

2. From the menu bar, select File > Export.
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The Export dialog opens.

3. Navigate to the folder that contains your exported tube 
settings (for example, C:\BDExport).

4. Click Save. 

The reagent information is exported as an XML file. 

Importing reagent 
information

To import reagent information:

1. From the menu bar, select File > Import.

The Import dialog opens.

2. Navigate to the folder that contains your exported reagent 
information.xml file and select a file to import.

3. Click Open.

The reagent information is imported into the Reagents table.

More information • Working with bead lots in the library (page 289)

• Working with tube settings in the library (page 296)

Importing and exporting tube settings
Introduction This topic describes how to import and export tube settings in the 

library.

Tube settings are defined in the Experiment workspace. By default, 
tube settings are visible to authors only. You can change the 
sharing preference to share tube settings with all users.
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Importing tube 
settings

To import tube settings:

1. On the navigation bar, click Library.

2. In the Library panel, double-click Tube Settings, then click 
User-defined.

3. From the menu bar, select File > Import.

The Import Tube Setting dialog opens.

4. Navigate to the folder that contains previously exported tube 
settings files (for example, C:\BDExport\Library\TubeSettings).

5. Select the tube setting you want to import, then click Open.

The table for the selected subcategory displays the tube 
settings file.

Exporting tube 
settings

To export tube settings:

1. On the navigation bar, click Library. 

2. In the Library panel, double-click Tube Settings, then click 
User-defined.

3. In the table, click a tube setting you want to export.

4. From the menu bar, select File > Export.

The Export Tube Setting dialog opens.

5. Navigate to the folder that contains your exported tube 
settings (for example, C:\BDExport\Library\TubeSettings).

6. Click Save.

The tube settings file is exported as an XML file.

More information • Working with tube settings in the library (page 296)
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Working with tube settings in the library
Introduction This topic describes how to view, print, or delete tube settings files 

in the library.

Tube settings are defined in the Experiment workspace. By default, 
tube settings are visible only to authors. You can change the 
sharing preference to share tube settings with all users.

Viewing and 
printing tube 
settings details

To view and print tube settings details:

1. On the navigation bar, click Library.

2. In the Library panel, double-click Tube Settings, then click BD 
or User-defined.

3. In the table, click the tube settings you want to view.

The Tube Settings detail panel is displayed. 

4. Click Print to print the current tube settings details.

Deleting user-
defined tube 
settings

Authors can delete only their own user-defined tube settings. You 
cannot delete BD-defined or LW/LNW default tube settings.

To delete a user-defined tube setting:

1. Click a tube setting in the Tube Settings table.

2. In the table title bar, click Delete.

A delete confirmation dialog opens.

3. Click Yes.

The tube setting is deleted from the Tube Settings table.

Any tube that used the deleted tube settings will have the 
default tube settings and any associated reference settings 
applied to it.
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More information • Working with reagents in the library (page 290)

• Working with keywords in the library (page 299)

Understanding keywords
Introduction This topic provides a description of keywords, how they are used 

in BD FACSuite software, and keyword rules. 

About keywords Keywords provide additional information (metadata) about your 
sample. This information can identify samples, differentiate the 
samples from each other, or group them based on a similar trait. 
Keywords can be system-defined (which include FCS standard 
keywords) or user-defined. Keywords are shared resources and are 
stored in the library.

When you assign keywords to a tube (in an experiment) or an 
entry or tube (in a worklist), they are displayed in the text header 
of exported FCS files and have a name (for example, $DATE) and 
a value (for example, Jan-1-00). The form of a keyword value 
depends on the nature of the keyword (for example, a character 
string or a number). 

You can also display any keywords that are already defined and 
assigned to the assay as a column in the worklist. The column 
displays specific values that apply to the entry or tube. You can 
modify values for many keywords.

Using keywords You can do the following with keywords:

• Assign keywords to one, several, or all tubes in an experiment 
or worklist entry. 

• Assign keywords to tubes in an experiment and use them in 
statistical expressions within the experiment.

• Add keywords to a statistics view header.
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• Specify keyword values in a column in the worklist or the Tube 
Properties dialog in an experiment. 

Keyword rules • All keywords are stored in the library. However, the keyword 
values are associated to the tube or entry. Once you assign a 
keyword and set a value for a tube or entry, it is disconnected 
from the keyword in the library (it’s a snapshot of the keyword 
and value). Any changes to the keyword in the shared library 
do not affect the keyword that is assigned to the tube or entry. 

• If you want to change the definition of an assigned keyword 
(for example, if you change the type from numeric to string) 
you need to unassign it in the tube or entry, reassign it.

More information • Working with keywords (page 176)

• Assigning keywords to entries and tubes (page 243)

• Importing and exporting keywords (page 298)

• Working with keywords in the library (page 299)

Importing and exporting keywords
Introduction This topic describes how to import and export keywords in the 

library. 

Importing 
keywords

To import keywords into the library:

1. On the navigation bar, click Library.

2. In the Library panel, click Keywords. 

3. From the menu bar, select File > Import.

The Import Keywords dialog opens.

4. Navigate to the folder that contains previously exported 
keywords files (for example, C:\BDExport\Library\Keywords).
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5. Select the keyword you want to import and click Open.

The keyword is added to the Keywords table.

Exporting 
keywords

Only user-defined keywords can be exported.

To export keywords:

1. On the navigation bar, click Library.

2. In the Library panel, click Keywords. 

3. From the menu bar, select File > Export.

The Export Keywords dialog opens.

4. Navigate to the folder that contains your exported keywords 
(for example, C:\BDExport\Library\Keywords).

5. Click Save.

The user-defined keywords are exported as an XML file.

More information • Understanding keywords (page 297)

• Working with keywords in the library (page 299)

Working with keywords in the library 
Introduction This topic describes how to add, edit, and delete user-defined 

keywords in the library.

System-defined and user-defined keywords are shared resources 
and visible to all users. Only keyword authors can edit their user-
defined keywords.
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Creating a new 
keyword

To add a new keyword to the Keywords table:

1. On the navigation bar, click Library.

2. In the Library panel, click Keywords. 

3. In the Keywords table, click Add on the table title bar.

The New Keyword details panel is displayed.

4. Type the appropriate information into each field.

5. Click Save. 

The new keyword is added to the table.

Editing an existing 
keyword

To edit an existing keyword:

1. In the table, click the keyword you want to edit.

The Keyword detail panel is displayed. 

2. Click Edit to enable the fields.
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3. Edit the fields as needed.

4. Click Save. 

The edited keyword is displayed in the table.

5. (Optional) Click Print to print the current keyword details.

Deleting user-
defined keywords

Authors can delete only their own user-defined keyword. System-
defined keywords cannot be deleted. 

To delete a user-defined keyword:

1. Click a keyword in the Keywords table.

2. In the table title bar, click Delete.

A delete confirmation dialog opens.

3. Click Yes.

The keyword is deleted from the Keywords table.

More information • Understanding keywords (page 297)

• Working with tube settings in the library (page 296)

• Working with labels in the library (page 302)
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Working with labels in the library
Introduction This topic describes how to import, create, and delete 

fluorochrome labels (for example, CD3) in the library.

Labels are shared resources and are visible to all users. BD labels 
are authored by BD. User-defined labels can be created, edited, or 
deleted only by the label author. 

Importing labels To import the list of labels into the library:

1. On the navigation bar, click Library. 

2. In the Library panel, click Label. 

3. From the menu bar, select File > Import.

The Import Labels dialog opens.

4. Navigate to the folder that contains label files (for example, 
C:\BDImport\Library\Labels).

5. Click Open.

The labels are added to the Labels table.

Creating a user-
defined label

To create a user-defined label:

1. In the table title bar, click Add.

A new line is added to the bottom of the Labels table.

2. In the Name column, type the label name, then press Enter.

The new label is added to the table. Your user ID is displayed 
as the author in the Author column.

Deleting a user-
defined label

Authors can delete only their own user-defined labels. BD labels 
cannot be deleted. 

To delete a user-defined label:

1. Click a label in the Labels table.
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2. In the table title bar, click Delete.

A delete confirmation dialog opens.

3. Click Yes.

The label is deleted from the Labels table.

Exporting labels You can export a list of labels only if the list includes user-defined 
labels.

To export a list of labels:

1. From the menu bar, select File > Export.

The Export Labels dialog opens.

2. Navigate to the folder that contains your export labels (for 
example, C:\BDExport\Library\Labels).

3. Click Save.

The file is exported as an XML file.

More information • Working with keywords in the library (page 299)

• Locating library resources (page 303)

Locating library resources
Introduction This topic describes how to sort, search to locate resources, and 

print lists of resources after you locate them. The following 
procedures apply to all library resources.

Sorting items in the 
table

To sort items in the resource table:

1. On the navigation bar, click Library.

2. In the Library panel, click a category. 
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In any resource table, click any column header.

3. Select a sort mode button. 

The resources are sorted by category. Names (text) are sorted 
in alphabetical order. Numeric values are sorted in ascending 
or descending order.

Defining search 
criteria

To define search criteria:

1. Click the search filter mode button to define the search.

2. Select one of the following options.

– Begins with. This mode is not case sensitive. This searches 
by the first letter of the word, or the number in a numeric 
value.

– Equals. This mode is case sensitive. This searches for the 
exact form of the word (for example, FSC, Assay 1, Br), or 
the exact form of the numeric item (for example, 12, 14.5, 
12,056).

– Contains. This mode is not case sensitive. This searches for 
text or numeric value that might be included in a file name 
(for example, assay, 126, tube).

– Ends with. This mode is not case sensitive. This searches 
for the last letter of the word, number in a numeric value, 
or a string.
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3. In the Search field, type the text or number you want to use as 
the search keyword.

4. Click OK to filter.

The table displays the filtered items in the column.

Printing lists of 
library resources

To print a list of library resources:

1. Display the resource table that contains the resource you want 
to print. 

• To print a single row of a resource table, right-click the 
row, then select Print.

• To print multiple rows of a resource table, Ctrl+click 
multiple rows, then select Print.

A print preview is displayed.

2. Click the Print icon, then complete your typical printing 
procedure.

More information • Library overview (page 280)
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Changing resource sharing settings
Introduction This topic describes how to change the sharing setting for assays 

and tube settings in the library.

About library 
resource sharing 
settings

Library resources are private by default. Only administrators or 
resource owners (authors) can change a resource from private to 
shared, or rename or delete private or shared resources.

• Private library resources are unique only within the library 
resources for a specific user. Resources can have the same 
name if they are not shared. 

• Shared library resources are unique and cannot have the same 
name as other public resources.

Procedure To change the sharing setting for a resource:

1. On the navigation bar, click Library. 

2. In the Library panel, double-click Assays or Tube Settings. 

3. Display the assay or tube setting table that contains the 
resource you want to change. 

4. Right-click a row in the resource table, then select a share 
setting.

• For assays, select Share Assay or Make Private.

• For tube settings, select Share Tube Setting.

Note that you can share tube settings, but you cannot make 
them private once you have shared them.

More information • Locating library resources (page 303)

• Library overview (page 280)



9
Plots

This section includes detailed information about plots and plot procedures that are not 
typically part of the daily workflow. Use this section to learn about different plot types 
and how to change plot properties.

This section includes the following topics:

• Plot overview (page 308)

• Plot types (page 309)

• Drawing plots (page 314)

• Viewing plot coordinates (page 316)

• Setting general plot properties (page 317)

• Changing the primary data source (page 320)

• Changing plot axis parameters (page 324)

• Setting plot display properties (page 328)

• Setting plot-specific display properties (page 330)

• Managing layers for a plot overlay (page 338)

• Displaying the legend for an overlay plot (page 341)

Other related sections:

• See Experiment acquisition and analysis (page 129) for information about creating 
plots in an experiment.
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Plot overview 
Introduction This topic describes plots and plot parameters. 

About plots Plots graphically represent the data acquired from tubes and are 
used to compare and analyze acquired data. Each plot is associated 
to a specific tube or to the run pointer.

Plot parameters BD FACSuite software automatically selects X and Y parameters 
for all newly created plots. If you draw a new 2D plot, FSC-A is 
automatically selected as the X parameter and SSC-A is 
automatically selected as the Y parameter. If you draw a histogram 
plot, FSC-A is automatically selected as the X parameter. You can 
change these parameters as needed.

More information • Modifying plot parameters (page 160)

• Changing plot axis parameters (page 324)

• Plot types (page 309)

• Statistics (page 399)

• Expressions (page 419)
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Plot types
Introduction This topic describes the plot tools and the different plot types you 

can use to visualize and analyze data. 

Plot types There are four basic plot types, as well as overlays and hybrids.

• Dot plot. This plot is a graphical representation of two-
parameter data, where each axis displays the signal intensity of 
one parameter and each dot represents one or more events 
(cells or particles). 

• Histogram. This plot is a graphical representation of single-
parameter data, where the horizontal axis represents the 
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increasing signal intensity of the parameter, and the vertical 
axis represents the number of events (count).

• Density plot. This plot is a graphical representation of two-
parameter data where each axis displays the signal intensity of 
one parameter and colors indicate the number of events in a 
cluster.

Density plots are similar to dot plots, except colors are used to 
represent the accumulation of events (density) for events with 
the same signal intensity. A density plot simulates three- 
dimensional event display.
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• Contour plots. This plot is a graphical representation of two-
parameter data, where each event has a position in the plot 
according to its intensity values for both parameters.

Contour lines provide a third dimension by joining x- and y-
coordinates with similar event counts. These plots are similar 
to topographic maps, which use contour lines to show points 
at the same elevation.

• Overlay plots. Overlays are used to compare similar data. 
When the scales for all overlay layers are the same, then tick-



BD FACSVerse System Reference312

marks are displayed. When the scales are not the same for all 
layers, the tick-marks are not displayed.

• Hybrid plots. These plots combine dot plots with density or 
contour plots. See Density plot display properties (page 335) 
and Contour plot properties (page 337) for information about 
how to create hybrid plots.   

Dot plot overlay

Histogram overlay
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In a hybrid plot, the individual dots are displayed like a dot 
plot, but the dots display the color gradients from a density or 
contour plot. 

Dot + density hybrid plot

Dot + contour hybrid plot
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More information • Drawing plots (page 314)

• Previewing data in plots (page 161)

• Modifying experiment worksheets and reports (page 208)

Drawing plots
Introduction This topic describes how to use the plot tools to create plots with 

default parameters or with specified parameters.

Creating plots with 
default parameters

Use the plot tools on the Worksheet toolbar to create plots on a 
worksheet or report with the default (scatter) parameters.

Tool Description

Dot plot Click this tool to create a dot plot on a worksheet 
or report.

Histogram plot Click this tool to create a histogram plot on a 
worksheet or report.
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You can change the x- and y-axis parameters if needed. See 
Changing plot axis parameters (page 324) for more information.

Creating plots with 
specific parameters

To create plots with specific parameters:

1. Click a plot tool on the Worksheet toolbar.

2. Right-click in the worksheet or report. 

The Select Plot Parameters dialog opens.

Contour plot Click this tool to create a contour plot on a 
worksheet or report.

Density plot Click this tool to create a density plot on a 
worksheet or report.

Tool Description

X-axis parameter

Y-axis parameter
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3. Select an x-axis parameter, then select a y-axis parameter from 
the list (for example, FITC-A and PE-A). Note that the first 
parameter you select is the x-axis parameter.

The new plot displays in the worksheet or report.

More information • Plot types (page 309)

• Viewing plot coordinates (page 316)

• Changing plot axis parameters (page 324)

• Setting plot display properties (page 328)

Viewing plot coordinates 
Introduction This topic describes how to view plot coordinates.

Procedure To view the coordinates of the current mouse position in a plot:

1. Click in the plot.

2. Move the mouse within the plot. 
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Plot x- and y-coordinates for the current mouse position are 
displayed in the lower-left corner of the plot. The coordinates 
are displayed as rounded integers.

More information • Creating plots in a worksheet (page 158)

• Previewing data in plots (page 161)

Setting general plot properties 
Introduction This topic describes how to set general properties for plots after 

you add them to a worksheet. 

General plot properties define the plot type and which data 
categories are displayed in the plot title.

Changing the plot 
type

To change the plot type:

1. Right-click a plot and select Properties. 

The Plot Editor dialog opens and displays the General tab.
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2. Click the Plot Type field and select a different plot type.

Modifying the plot 
title

To modify the plot title:

1. Under Plot Title Content, select the checkboxes for the 
elements you want to include in the plot title.
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The default plot title is the name of the primary data source 
(tube) that you selected and the current population(s).

2. (Optional) Select the Custom checkbox to enable a custom 
title, then type a custom title in the field. 

More information • Changing the primary data source (page 320)

• Creating plots in a worksheet (page 158)

• Previewing data in plots (page 161)
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Changing the primary data source
Introduction This topic describes how to change the primary data source for a 

plot. 

The primary data source determines which tube is associated to a 
plot or plots in the worksheet.

About data sources You can change the data display behavior of plots in a worksheet 
by assigning the run pointer or a specific tube as the primary data 
source for the plot. 

For example, when the run pointer points to Tube_001, all plots 
that are assigned to the run pointer display data from Tube_001. 
The plot titles change to match the tube that is selected by the run 
pointer. When the run pointer points to Tube_002, all plots that 
are assigned to the run pointer display data from Tube_002.
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If you have more than one tube in an experiment, you can assign a 
specific tube as the primary data source for one plot and display 
one plot per tube within the same worksheet and compare plots 
side-by-side on the same worksheet.

The following illustration shows plots for two separate tubes in the 
same worksheet. When Tube_001 is assigned as the primary data 
source, only the data for plots assigned to Tube_001 is displayed. 

Assigning the 
primary data 
source

To assign a specific tube as the primary data source:

1. In the Data Sources panel, set the run pointer on a tube (for 
example, Tube_001).

2. In the worksheet, right-click a plot displaying Tube_001 data, 
then select Properties. 

The Plot Editor dialog opens.
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3. Under Primary Data Source, clear the Run Pointer checkbox.

4. Select the tube you want to assign as the primary data source 
for this plot (for example, Tube_001).

5. Close the dialog.

6. Set the run pointer to a different tube. 
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Notice that the data does not update in the plot because the 
plot primary data source has been assigned to Tube_001. 

Note that even though the run pointer is no longer assigned as 
the primary data source, you use the run pointer in the Data 
Sources panel to indicate the tube you want to select or 
preview.

You can re-assign the run pointer as the primary data source at 
any time.

Displaying specific 
populations

To display a specific population:

1. Under Primary Data Source, click one or more populations in 
the Population(s) tree.

The updated plot displays the selected populations for the 
current data source. If the plot included overlays, then only the 
primary data source updates. The overlays are not affected.

See Working with gates (page 352) for additional topics related to 
creating gates and defining populations.

Tube_001 data Tube_002 data
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More information • Creating plots in a worksheet (page 158)

• Drawing gates in plots (page 164)

• Changing plot axis parameters (page 324)

Changing plot axis parameters 
Introduction This topic describes how to set the parameters and scale for x- and 

y-axes.

About plot axis 
parameters and 
scaling

Most often flow cytometry data exhibits a log-normal distribution 
and is displayed using a logarithmic scale. However, when data is 
compensated, the data might display event distributions that 
extend below zero. Logarithmic displays can not accommodate 
zero or negative values. Zero or negative values cause the events to 
pile-up on the baselines of the plots (commonly referred to as the 
“log artifact”). 

Linear scaling is more appropriate for displaying data that is close 
to zero or below zero. However, linear scaling does not 
accommodate data that is much brighter (which should be 
displayed using a log scale). 

To address the log artifact, BD FACSuite software plots utilize a 
data transformation for scaling purposes. This allows the use of a 
linear scale for near zero or below zero data and a logarithmic 
scale for data with larger signals on the same plot. The 
transformation is for display only and does not affect the raw data. 

Autoscaling automatically determines the extent of negativity 
based on the compensated data for all events in the data file. 
Advanced users can select manual scaling and adjust the range of 
the negative scale using the Biexponential R values. This is referred 
to as manual biexponential scaling. The minimum and maximum 
values for R are 0 and 50000 respectively.
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Procedure To change the parameter and scale for an axis:

1. Right-click a plot and select Properties. 

The Plot Editor dialog opens.

2. Click the Parameters tab.

3. In the Label fields, select a parameter for each axis.

Note that you can also change axis parameters by right-
clicking a parameter label in a plot and selecting a new 
parameter.

4. In the Scale fields, select Log, Linear, or Biexponential scale for 
each axis. 

The default for scatter parameters is linear. The default for 
fluorescence parameters is biexponential.
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Setting automatic 
biexponential 
scaling

To set automatic biexponential scaling:

1. In the Parameters tab, under Bi-exponential Global Scaling, 
select Use Automatic Scaling.

2. Select a population to scale.

This is the default biexponential scaling for all tubes that 
automatically scales the selected events. 

Setting manual 
biexponential 
scaling for a tube

To set manual biexponential scaling for a tube:

1. In the Data Sources panel, set the run pointer on the tube you 
want to scale.

2. Right-click a plot and select Properties. 

The Plot Editor dialog opens.



Chapter 9: Plots 327

3. Click the Parameters tab.

4. Under Bi-exponential Global Scaling, select Use Manual 
Scaling to enable the R Value data slider. 

5. Use the data slider to set an R value for the selected tube. Note 
that manual scaling is tube specific.

Changing log 
display

The log scale can be displayed using 4 or 5 decades. A 4 decades 
log display removes the first decade (0 to 10) of data from display. 
A 5 decade log display includes the first decade.

To change log display:

1. From the menu bar, select View > Change Log Display to 
toggle between 4 and 5 decade log display.

This selection applies to all plots.
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More information • Creating plots in a worksheet (page 158)

• Managing layers for a plot overlay (page 338)

Setting plot display properties
Introduction This topic describes how to set plot display properties which 

determine how plot colors, fonts, labels, gridlines, and tick marks 
are displayed.
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Procedure To set plot display properties:

1. In the Plot Editor dialog, click the Display tab.

2. Under Colors, click and select colors for the plot background 
or drawing surface. 

3. Under Size, select the measurement units and set the size for 
the selected dot plot.

4. Under Grid & Outline, select the Show Log Scale/Zero Point 
Gridlines checkbox to display gridlines for the log scale 
parameters and a line on zero for the biexponential 
parameters.
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5. Select the Show Border Outline checkbox, then select Full or 
Half to display a plot border outline.

6. Under Fonts, select the font family, color, and the font sizes for 
the plot title, tick marks, and axis labels. 

You can also select show or hide plot titles, tick marks, or axis 
labels.

More information • Creating plots in a worksheet (page 158)

• Density plot display properties (page 335)

Setting plot-specific display properties 
Introduction This topic describes how to set the display properties for specific 

plot types. These properties control how the population data and 
plot display in a worksheet.

Procedure To set plot-specific display properties:

1. Right-click a plot and select Properties. 

The Plot Editor dialog opens. The tabs that open are based on 
the type of plot you selected (for example, dot, histogram, 
contour, or density plot).

2. Select the plot-specific tab (for example, DotPlot, Histogram, 
Contour, or Density).

3. Set the properties for the plot type.
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Dot plot properties Use the DotPlot tab to set dot plot properties.

Histogram 
properties

Use the Histogram tab to set histogram properties.

To... Then do this...

Change the dot size Under Plot Properties, click the Dot Size field 
and select a dot size.

Change which data 
is displayed in the 
plot

Under Show Data, click % Events or # Events 
to enable the display of this data.

Type a percentage or number of events in the 
field for the enabled data.

To... Then do this...

Change the 
histogram 
resolution

In the Resolution field, select a resolution of 64, 128, 256, or 512. The 
default is 256.

Higher resolution displays a more solid (less pixelated) image. You can 
combine higher resolution with higher smoothing to generate the most 
detailed histogram plot.

Set the y-axis 
scale

Under Y Axis, click the Y Axis Scale field and select a logarithmic, 
linear, percent, or normalized percent scale. The default is linear.

You can select a percent scale when using overlays. If you select 
Percentage, the following steps are performed:

 The highest peak in each layer is identified.

 A percentage is calculated. The number of events in the peak are 
divided by the total number of events in the layer.

 A maximum percentage among all the layers is calculated and used 
as the maximum value for the y-axis.
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Set y-axis max 
height

Under Y Axis, select one of the following:

 If you selected multiple populations using the primary data source 
population (in the General tab), then select Global Maximum to 
normalize each of the populations. 

 Select Use Manual Y Height to apply the y-axis maximum value in 
the Max. Height field. You can modify the max height value 
manually by typing a new value.

Smooth the 
data

Under Smoothing, select the Use Smoothed Data checkbox to enable 
both the Clear Smooth Edges checkbox and the Smoothing Level 
controls.

Smoothing captures trends and patterns from the individual data bins 
and applies it to a curve—while filtering noise or outliers. Higher 
smoothing levels filter out more noise.

Hide edges of 
data

Under Smoothing, select the Clear Smooth Edges checkbox to make the 
edges of the rendered data invisible.

Adjust 
smoothing

Under Smoothing, drag the Smoothing Level slider to select a higher or 
lower smoothing level (1–8), or type a value. The default value is 4.

To... Then do this...
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Set how the 
histogram is 
displayed

 Under Histogram Visualization, select the Fill Histogram checkbox 
to fill the histogram area.

 Select the Draw Curve checkbox to draw a curve instead of 
individual bins.

To... Then do this...
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 Select the Display Stacked View checkbox to display data in vertical 
stacks.

You can stack data to show multiple populations in separate 
sections in the same histogram. For example, if you display stacked 
view for a plot that includes three populations, each population is 
displayed separately within the histogram. When stacked view is 
disabled, the three populations display on top of each other. 

Note that in an overlay, different datasets are layered on top of each 
other.

To... Then do this...
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Density plot display 
properties

Use the Density tab to set density plot properties.

 In the Edge Percent Ignore field, enter the percentage of the 
histogram edge that you want to ignore. This helps to reduce edge 
effects. The default value is 5%.

Ignoring edge effects excludes negative events when using 
automated scaling of the y-axis. For example, if you display a 
histogram with a log parameter, many negative events can 
accumulate at “0” on the y-axis. You can ignore these events on the 
extreme edges of the scale so that accumulated negative data does 
not influence the overall data results.

Set population 
properties

Under Population Properties: 

 In the Population field, select a population.

 In the Line Style field, select a line style. This style is applied to the 
gate frame that surrounds the population. 

 In the Transparency field, enter a transparency value between 0 and 
100 (0 = transparent, 100 = opaque).

To... Then do this...

To... Then do this...

Change the density 
resolution

In the Resolution field, select a resolution of 64, 128, 256, or 512. 
The default is 128. 

Higher resolution displays a more solid (less pixelated) image. You 
can combine higher resolution with higher smoothing to generate 
the most detailed density plot.

Smooth the data Under Smoothing, select the Use Smoothed Data checkbox to 
enable both the Clear Smooth Edges checkbox and the Smoothing 
Level controls.

Smoothing captures trends and patterns in the data and applies it to 
density level while filtering noise or outliers. Higher smoothing 
levels filter out more noise.

Hide edges of data Under Smoothing, select the Clear Smooth Edges checkbox to make 
the edges of the rendered data invisible.
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Adjust smoothing Under Smoothing, drag the Smoothing Level slider to select a 
smoothing level (1–8), or type a value. The default is 4.

Change how 
density is displayed

Under Density Visualization, in the Scale Mode Type field, select 
either Logarithmic, Linear, or Probability.

Change the level of 
density to display

Under Density Visualization, in the Percentage field, enter a value 
between 2 and 90. The default is 10.

When displaying density, the values of the density levels must be 
determined. Depending on the algorithm, the levels are calculated 
differently. The percentage value is the input into the algorithm. 
Values include the following:

Linear. Percentage of peak height of density levels with equal 
spacing between levels.

Log. Percentage of peak height of density levels with log spacing.

Probability. Percentage of matching events in each density level.

Change the color 
of the density data

Under Density Visualization, in the Color Type field, select 
MultiColor, Grayscale, or Single Color.

Show outlier events Under Density Visualization, select the Show Outliers checkbox.

Show a dot/density 
hybrid plot

Under Density Visualization, select the Show as Dot/Density 
Hybrid checkbox to display data as a hybrid plot. Clear this 
checkbox to display data as a normal density plot.

You can use this option to see a dot plot applied with a mask of the 
density plot. The density plot obscures the individual event dots 
while the hybrid view shows just the event dots colored by the 
density mask colors.

To... Then do this...
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Contour plot 
properties

Use the Contour tab to set contour plot properties.

To... Then do this...

Change the density 
resolution

In the Resolution field, select a resolution of 64, 128, 256, or 512. 
The default is 128. 

Higher resolution displays a more solid (less pixelated) image. You 
can combine higher resolution with higher smoothing to generate 
the most detailed contour plot.

Smooth the data Under Smoothing, select the Use Smoothed Data checkbox to 
enable both the Clear Smooth Edges checkbox and the Smoothing 
Level controls.

Smoothing captures trends and patterns in the data and applies it 
to a contour level while filtering noise or outliers. Higher 
smoothing levels filter out more noise.

Hide edges of data Under Smoothing, select the Clear Smooth Edges checkbox to 
make the edges of the rendered data invisible.

Adjust smoothing Under Smoothing, drag the Smoothing Level slider to select a 
smoothing level (1–8), or type in a value. The default value is 4.

Change how 
contour data is 
displayed

Under Contour Visualization, in the Scale Mode Type field, select 
either Logarithmic, Linear, or Probability.

Change the level of 
contour to display

Under Contour Visualization, in the Percentage field, enter a value 
between 2 and 90. The default value is 10.

When drawing a contour, the values of the contour levels must be 
determined. Depending on the algorithm, the levels are calculated 
differently. The percentage value is the input into the algorithm. 
Values include the following:

Linear. Percentage of peak height of contour levels with equal 
spacing between levels.

Log. Percentage of peak height of contour levels with log spacing.

Probability. Percentage of matching events in each contour level.

Change the color of 
the contour data

Under Contour Visualization, in the Color Type field, select 
Multicolor, Grayscale, or SingleColor.
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More information • Creating plots in a worksheet (page 158)

Managing layers for a plot overlay 
Introduction This topic describes how to add, organize, define, or remove the 

layers of data that you can overlay on a dot plot or histogram. 

About layers and 
overlays

Layers are individual data sets from tubes or FCS files (for 
example, all events and gates populations displayed in a plot). You 
can layer data from different tubes or FCS files to create a quick 
visual comparison of data.

All layers in the Layers table are applied to the plot. In a dot plot, 
the layer with the most events is always the back-most layer. The 
layer with the fewest events becomes the front-most layer. All other 
layers are sorted according to event count and positioned between 
the front and back layers.

Show outlier events Under Contour Visualization, select the Show Outliers checkbox 

Fill the contours Under Contour Visualization, select the Fill Contours checkbox.

Show contour lines 
in the plot

Under Contour Visualization, select the Show Contour Lines 
checkbox.

Select the Is Contour Line Colored checkbox to apply the contour 
color to the contour outline.

Show a dot/contour 
hybrid plot

Under Contour Visualization, select the Show as Dot/Contour 
Hybrid checkbox to display data as a hybrid plot. Clear this 
checkbox to display data as a normal contour plot.

You can use this option to see a dot plot applied with a mask of 
the contour plot. The contour plot obscures the individual event 
dots while the hybrid view shows just the event dots colored by the 
contour mask colors.

To... Then do this...
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In a histogram, the overlay sequence is based on the order in which 
the data source was added.

The primary data source populations are the base of the plot and 
are not displayed as a layer. You specify which layers are visible, 
the percentage of transparency, and the color of the population 
data.

Adding overlay 
layers

To add layers to a plot overlay:

1. In the Plot Editor, click the Overlay tab.

2. Under Overlay, select a tube and click Add.

The new overlay layer is displayed in the Layers table. You can 
drag rows in the table to organize where layers appear in the 
table. The plot updates to display the layers.

Modifying layer 
properties

To modify overlay layer properties:

1. In the Layers table, select a layer.

The Edit Layer group is displayed.
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2. To change the tube for a layer, click a layer in the table, then 
under Edit Layer, click Tube and select a different tube for the 
layer.

3. Click the Population field and select a population for this layer.

4. Click the X Parameter field and select an X parameter for the 
layer.

5. Select the layer in the table, then select the Visible checkbox to 
make the overlay visible or clear the checkbox to make the 
layer invisible.

6. Click the Color box to select a color for the data in this 
overlay.
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7. In the Transparency % field, enter a transparency value 
between 0 and 100 (0 = transparent, 100 = opaque).

8. For dot plots, click the Dot Size field and select a dot size for 
the events in the layer. For histogram overlays, select an option 
from the Line Style field.

Deleting a layer 
from an overlay

To delete a layer from an overlay:

1. In the Layers table, select a layer.

2. Click Delete. 

The layer is removed from the Layer table and the overlay.

Subtracting a 
histogram layer

Subtracting a histogram layer shows the difference between the 
two histogram lines. This is enabled only when you select two 
layers with the same scale.

To subtract a histogram layer:

1. In the Layers table, click a histogram row.

2. Ctrl+click a different histogram row, then click Subtract Layer. 

More information • Creating plots in a worksheet (page 158)

• Setting plot display properties (page 328)

Displaying the legend for an overlay plot 
Introduction This topic describes how to display a plot legend in the worksheet.

The following overlay options are available for dot plot and 
histogram overlay layers. The overlay legend displays the list of 
tubes (data sources) that are assigned to the layer.
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Procedure To display the plot legend:

1. Use the Plot Editor dialog to create at least two layers in an 
overlay.

2. Click on a histogram in the worksheet. 

3. Right-click and select Legend.

The Legend dialog opens.

The overlay legend displays the list of tubes (data sources) that 
represent layers, the x-axis parameter, the layer order of 
appearance, color, and line style.

More information • Managing layers for a plot overlay (page 338)



10
Gates and populations

This section includes detailed information about gates and populations. Use this section 
to learn about gating guidelines, different gate types, and how to add or modify the 
different gate types. This section also describes gating and population hierarchies.

This section includes the following topics:

• Introduction to gates (page 345)

• Gating tools (page 347)

• Gating guidelines (page 350)

• Working with gates (page 352)

• Resizing and reshaping gates (page 354)

• Modifying gate properties (page 357)

• About gates and population hierarchies (page 359)

• Working with the gate hierarchy (page 363)

• Finding and highlighting populations (page 367)

• Creating logical gates (page 371)

• Making gates unique (page 373)

• Creating adaptive (snap-to) gates (page 374)

• Creating auto gates (page 379)

• Creating and adjusting interval gates (page 380)



BD FACSVerse System Reference344

• Quad gates overview (page 384)

• Creating quad gates (page 388)

• Staggered quad gate overview (page 392)

• Creating staggered quad gates (page 394)

• Statistical quad gates (page 395)
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Introduction to gates
Introduction This topic provides an overview of the different gate types. 

About gates A gate is a boundary in a plot that defines a subset of the total 
sample population. Gating identifies cells of interest, classifies 
events in the gated population, and calculates population statistics. 

Gate types You can create the following gates within dot, density, or contour 
plots:

• Rectangle

• Ellipse

• Polygon, snap-to polygon, and auto polygon

• Quad and staggered quad

• Freehand

• Interval, auto-interval, snap-to interval

• Logical (AND, NOT, OR)

You can create interval gates within histograms.
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More information • Drawing gates in plots (page 164)

• Gating guidelines (page 350)

Rectangle gate Polygon gate

Ellipse gate Freehand gate

Quad gate Interval gate
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Gating tools
Introduction This topic describes the gating tools on the Worksheet toolbar.

Worksheet tools The following table describes the gating tools on the Worksheet 
toolbar and how to use them to draw gates in plots.

To draw a... Then do this...

Rectangle gate 1. Click this tool on the Worksheet toolbar.

2. Click in the plot and drag diagonally to create 
and size the rectangle around specific events in 
the plot.

3. Release the mouse button to set the gate.

Polygon gate 1. Click this tool on the Worksheet toolbar.

2. Click on the plot to specify a starting point to 
display a vertex.

3. Move the cursor to another position and click 
to add another vertex. Repeat this step to 
create a minimum of three vertices around 
specific events in the plot.

4. Click the first vertex or double-click to set the 
last vertex and close the gate.

Ellipse gate 1. Click this tool on the Worksheet toolbar.

2. Click in the plot and drag diagonally to create 
and size the ellipse around specific events in the 
plot.

3. Release the mouse button to set the gate.

Interval gate 1. Click this tool on the Worksheet toolbar.

2. Click on a cluster of events in the plot to 
display the interval gate.

See Creating and adjusting interval gates 
(page 380) for more information.
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Quadrant gate 1. Click this tool on the Worksheet toolbar.

2. In the plot, position the cursor to specify the 
quadrant intersection point.

3. Click to set the quad gate.

See Creating quad gates (page 388) for more 
information.

Staggered 
quadrant gate

1. Click this tool on the Worksheet toolbar.

2. In the plot, position the cursor to specify the 
quadrant intersection point.

3. Click to set the staggered quad. 

4. Click the center point in the quad and drag to 
create a staggered quadrant.

5. See Creating staggered quad gates (page 394) 
for more information.

Freehand gate 1. Click this tool on the Worksheet toolbar.

2. In the plot, click and hold the mouse button, 
then move the cursor to draw a freehand shape 
around specific events.

3. Release the mouse button to set and close the 
gate.

Snap-to polygon 
gate

1. Click this tool on the Worksheet toolbar.

2. Click on a cluster of events in the plot. 

The polygon snaps to the nearest cluster of 
events in the population.

See Creating adaptive (snap-to) gates (page 374) 
for more information.

To draw a... Then do this...
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More information • Gating guidelines (page 350)

• Working with gates (page 352)

• Resizing and reshaping gates (page 354)

• Modifying gate properties (page 357)

Snap-to interval 
gate

1. Click this tool on the Worksheet toolbar.

2. Click on a cluster of events in the plot. 

The polygon snaps to the nearest cluster of 
events in the population.

See Creating adaptive (snap-to) gates (page 374) 
for more information.

Auto interval 
gate

1. Click this tool on the Worksheet toolbar.

2. Click on a specific population in the plot. 

The auto gate adapts to the population data, 
then becomes a fixed interval.

See Creating auto gates (page 379) for more 
information.

Auto polygon 
gate

1. Click this tool on the Worksheet toolbar.

2. Click on a specific population in the plot. 

The auto gate adapts to the population data, 
then becomes a fixed polygon.

See Creating auto gates (page 379) for more 
information.

To draw a... Then do this...
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Gating guidelines
Introduction This topic describes the rules and guidelines for general gating 

procedures.

What is affected by 
modifying gates

When you create, delete, or modify gates, the gates and 
populations are updated in the following panels and fields:

• Gate hierarchy

• Population view

• Experiment

• Stopping Rules

• Statistics view

• Expression Editor

• Plots

You can undo all gating selections at any time.

Guidelines for 
deleting gates

You can delete a gate in a plot or within the hierarchy view.

• If the gate is unique, you cannot delete it. Use Remove Unique 
to convert the gate back to a regular gate. 

• If the selected gate is not unique and the population has 
subpopulations or dependents, (for example, it is used to form 
a logical gate), then a confirmation message is displayed. 
When you delete a gate that is not unique:

– The gated population and its descendants are deleted from 
the plot(s).

– All gates that depend on the deleted entity are removed 
from the plot and hierarchy. 

– The population and gate hierarchy are updated.

– The ungated events revert to the parent event colors.

You can delete quads. However, you cannot delete individual 
quadrants and bins.
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Guidelines for 
copying and 
pasting gates

The following guidelines apply when you copy and paste single 
gates in a plot: 

• If you paste a gate into a plot, a new gate is created (with the 
same shape) using the gate properties. The gate has the same 
definition (except for its parameters, which reflect the 
parameters of the plot). The gate’s dependents are not added. 

• If a gate with the same name exists, the new gate is renamed 
with the next available number in the naming sequence. 

• If a gate with the same color exists, the new gate is assigned a 
new color and is displayed with its outline shown in the plot. 
In the hierarchy view, it is placed under the parent population 
displayed in the plot. 

• If the plot has a different scale (log, linear, or biexponential), 
parameter space, file resolution, or histogram resolution, the 
gate shape is preserved and the gate maintains the same 
relative size and location in the plot. Gates are not converted if 
the scaling changes.

• After you paste the gate and a new gate is created, the gate 
hierarchy is updated and the new gate definition is applied to 
all tubes in the panel.

Guidelines for 
moving gates

The following guidelines apply when moving gates:

• After you move a gate, the population updates and all events 
are re-classified. 

• If you move a snap-to polygon or snap-to interval gate, it does 
not automatically snap to the new closest cluster. 

If you want the snap-to gate to revert back to its snap-to 
behavior after moving it, right-click the gate and select 
Recalculate.

• The gate labels move with the gate, but you can move the 
labels anywhere in the plot if you prefer. 
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More information • Introduction to gates (page 345)

• Working with gates (page 352)

Working with gates
Introduction This topic describes how to perform basic gating procedures that 

you can use for most gate types. 

Deleting gates To delete gates from a plot:

1. In the worksheet, right-click a gate in a plot then select Delete.

Copying, cutting, 
and pasting gates

To copy, cut, or paste a gate in a plot:

1. Right-click a gate in a plot. 

2. Select Copy, Cut, or Paste.

Moving gates You can move a gate within a plot without altering its shape.



Chapter 10: Gates and populations 353

To move a gate:

1. Click on a gate in a plot to highlight the gate boundary.

2. Click the gate boundary and drag it to a new location within 
the same plot.

More information • Gating guidelines (page 350)

• Resizing and reshaping gates (page 354)
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Resizing and reshaping gates
Introduction This topic describes how to resize, reshape, and rotate gates. 

You can resize or reshape a gate by adjusting the boundary that 
encloses it. 

Toggling between 
gate modes

Use bounds mode (boxed image area) for resizing rectangular and 
elliptical gates. Toggle to vertex mode when you want to modify 
any of vertices for a polygon or freehand gate.

To toggle between bounds mode and vertex mode:

1. Ctrl+click on a polygon or freehand gate in the plot.

A polygon gate in bounds mode. A polygon gate in vertex mode.
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Resizing or 
reshaping in vertex 
mode

To resize or reshape a gate in vertex mode:

1. Toggle to vertex mode. 

Click on any vertices on the gate outline and drag to resize or 
reshape.

The gate remains in vertex mode after you resize or reshape it. 
If you need to make more adjustments, toggle to bounds mode 
and resize or reshape the gate.

Proportional 
resizing in bounds 
mode

To proportionally resize the gate in bounds mode:

1. Toggle to bounds mode.

2. Click and drag any of the handles in the box to proportionally 
resize the gate.
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3. Click in the gate to set the edited gate.

After you resize or reshape a gate, the gates update and re-
classify all events within the same panel. 

Rotating a gate To rotate a gate:

1. Click on a gate in a plot.

2. Move the cursor over a gate handle until the rotation cursor is 
displayed.

3. Drag the handle in the desired direction. 

4. Release the mouse button to set the gate position.

More information • Working with gates (page 352)

• Making gates unique (page 373)

Rotation cursor
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Modifying gate properties
Introduction This topic describes how to modify gate properties and how gate 

modifications are applied to gates. 

About modifying 
gate properties

Gates are associated with a tube data source. When you create or 
modify a gate, modifications are applied to all plots that are 
assigned to the tube data source and all tubes that include this gate. 
For example, if you have multiple plots on a worksheet and the run 
pointer is the primary data source, all plots display a modified 
gate.

Use the gate Properties dialog to inspect and modify properties of a 
selected gate.

Procedure To modify gate properties:

1. Right-click on a gate in a plot and select Properties.

The Properties dialog opens.

2. The current name is displayed in the Name field. 

You can type a different name if you prefer.

3. Click the color block next to the Name field and select a color 
for the gate outline.
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4. Select any of the following gate properties.

More information • Making gates unique (page 373)

• About gates and population hierarchies (page 359)

Option Description

Statistics Only Select this checkbox to display gate 
statistics only. If you select this 
checkbox, you cannot use this gate as the 
source population for another plot or use 
it in a logical gate. 

Events in this gate are not colored. This 
is the default for quad gates only.

Show Outline Select this checkbox to display the 
outline of the gate in the plot. This is the 
default for all gates.

Strict Parameter 
Matching

Select this checkbox to apply the gate 
across all plots and tubes that match the 
long parameter name. 

Clear this checkbox to use the less 
restrictive short parameter name in the 
matching. Strict parameter matching is 
the default for all gates.

Show Label(s) Select this checkbox to display labels on 
all plots containing the gate. This is the 
default for all gates.
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About gates and population hierarchies
Introduction This topic describes gate and population hierarchy information 

and gate relationships.

Viewing a gate 
hierarchy

To view a gate hierarchy:

1. Click Display Hierarchy on the Worksheet toolbar.

The hierarchy view opens.

2. Under Gate Hierarchy, expand All Events to view all gates 
from the experiment in the hierarchy.

By default, gated populations are identified in the hierarchy by 
color boxes and population labels (P1, P2, P3, etc.). You can 
rename these labels to include any name or description.
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Gate and 
population 
hierarchy statistics

The hierarchy view includes the following information:

• Gate Hierarchy. Contains the hierarchy of all gates for the 
selected experiment. The hierarchy shows the name, color, and 
relationships with other gates.

Each experiment has a gate hierarchy. The All Events gate is 
always the root in the hierarchy. 

If you select a single gate in the hierarchy, the corresponding 
gate on the plot is displayed in bounds mode.

If you select a single gate on a plot, the corresponding gate in 
the hierarchy is highlighted. 
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• Population View. This section displays the hierarchy of 
populations that applies to each tube for the selected 
experiment.

The Gate Hierarchy and Population View update when you 
create, delete, and modify gates. 
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Relationship of 
gates in the 
hierarchy

The relative position of each gate in a hierarchy can be expressed 
in terms of its relationship to other gates within the same 
hierarchy. 

• All Events. This is the parent gate. This gate is the parent 
population of all populations.

• P1. In this example, this gate defines a subset of events as the 
population, P1. P1 is a child population of All Events.

• P2. In this example, this gate defines the population P2. P2 is 
subset of events of the population P1, thus making P2 a child 
population of P1 and a descendant of All Events.

More information • Working with the gate hierarchy (page 363)



Chapter 10: Gates and populations 363

Working with the gate hierarchy 
Introduction This topic describes how to copy, paste, reorder, and delete gates 

within the hierarchy view.

About copying and 
pasting in the gate 
hierarchy

You can only copy, cut, and paste regular (not unique) gates from 
the gate hierarchy. Note the following:

• If you copy and paste a gate into a gate hierarchy, a new gate is 
created with a new name (using the next available number in 
the naming sequence) and new color.

• If you cut and paste a gate into the gate hierarchy, a new gate 
is created with the same name and color. The gate's children 
are also added to the hierarchy.

Copying gates To copy gates:

1. Under Gate Hierarchy, right-click a gate, then select Copy.

Pasting gates into 
the hierarchy

To paste gates into the hierarchy view:

1. Under Gate Hierarchy, click the parent gate.

2. Right-click to display a menu, then click Paste.

The gate is pasted as a child of the selected gate.

Changing the 
relationship of 
gates

To change the relationship of gates in the Gate Hierarchy:

1. Under Gate Hierarchy, create a child gate by dragging one gate 
onto another gate.

For example, if you want to make the P2 gate a child of the P1 
gate, drag P2 onto P1.
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When changing the relationship of gates:

• You can change the relationship of quads in the gate hierarchy 
by dragging the parent quadrant gate. You cannot change the 
relationship of individual quadrants and bins.

• You cannot place any gate above All Events (the parent gate) 
in the gate hierarchy.

Deleting gates 
from the hierarchy

To delete gates from the hierarchy view:

1. Under Gate Hierarchy, right-click the gate you want to delete, 
then select Delete. If the gate is unique, right-click and select 
Remove Unique.

Showing statistical 
gates or 
populations

Statistical gates display statistics for all events within the gate. All 
events appear as the same color. Typically, quad gates are used for 
statistics gates. However, you can display statistics for any gate by 
modifying the gate properties. See Modifying gate properties 
(page 357) for more information.

To show statistical gates or populations in a hierarchy:

1. Under Gate Hierarchy, select the Show Statistical Gates/
Populations checkbox.

You can toggle this checkbox to show or hide gates or 
populations that are used for statistics only.

Showing 
population 
statistics

To show population statistics in the population view:

1. Under Population View, select the Show Population Statistics 
checkbox.
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The hierarchy view expands and displays the population 
statistics.

Pinning the 
hierarchy to a 
worksheet or 
report

To pin the hierarchy to a worksheet or report:

1. Move the hierarchy view inside the worksheet or report.

2. Click the Pin icon at the top of the hierarchy view.
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The hierarchy pins to the worksheet.

You cannot unpin a hierarchy. To remove a pinned hierarchy, 
right-click in the hierarchy, then select Delete.

More information • Creating adaptive (snap-to) gates (page 374)
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Finding and highlighting populations
Introduction This topic describes how to find and highlight populations in dot 

plots. 

About finding 
events

You can find and graphically isolate a particular population in one 
or more dot plots. You can also highlight populations to make the 
population easier to identify.

You can find events for only one population at a time across all dot 
plots in an experiment. If you want to focus on a particular 
population without making other populations unavailable, you 
can highlight all events in tubes that contain a specific population. 
You can highlight multiple populations at the same time within an 
experiment.

Finding events To find events across all plots:

1. Click Display Hierarchy on the Worksheet toolbar.

The hierarchy view opens

2. If you want to find events for a population in all tubes in an 
experiment, under Gate Hierarchy, right-click a population 
and select Find Events.

The selected events are isolated and displayed in the 
population color.

The following figures show plots for four tubes before Find 
Events is performed and after the P1 population is isolated in 
the plots. 
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Before Find Events is performed
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If you use Find Events, then delete the specific population, all 
events in the plot revert to the default population colors.

Turning off Find 
Events

To turn off Find Events:

1. In the hierarchy view, under Gate Hierarchy, right-click a gate 
and select Turn Off Find Events.

Highlighting a 
specific population

If you want to focus on a particular population without making 
other populations unavailable, you can highlight all events in tubes 
that contain a specific population. 

After Find Events is performed
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To highlight a specific population in a dot plot:

1. Under Gate Hierarchy, right-click a gate and select Highlight.

The populations are highlighted. During highlighting, gate and 
population hierarchies do not change, but the events of the 
highlighted populations display larger in the plot.

Turning off event 
highlights

To remove highlighting:

1. Under Gate Hierarchy, right-click a highlighted gate and select 
Turn Off Highlight.

More information • Modifying gate properties (page 357)

• About gates and population hierarchies (page 359)
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Creating logical gates
Introduction This topic describes the different types of logical gates and how 

they are applied to the population hierarchy. It also describes how 
to create logical gates by combining existing gates from the gate 
hierarchy to form a single gate. 

Types of logical 
gates

Logical gates are created by combining non-statistical gated 
populations to form gates based on AND, OR, NOT, or REST OF 
criteria. 

Procedure To create a logical gate:

1. View a plot with gates. 

2. Select Display Hierarchy on the Worksheet toolbar.

3. Under Gate Hierarchy, select one or more descendant gates 
under All Events (for example, Ctrl+click P1 and P2).

• For AND and OR gates, select at least two gates.

Gate type Description

AND This gate contains the intersection of two or more 
existing gates. This gate is added to the hierarchy 
under the first common ancestor of the selected gates.

OR This gate joins two or more existing gates to include 
events in either gate. This gate is added to the 
hierarchy under the first common ancestor of the 
selected gates.

NOT This gate contains all events that are in the parent 
population, but not in an gate itself. This gate is 
added to the hierarchy at the same level as the 
previously selected gate.

REST OF This gate contains all events that are in the selected 
gate, but not in any of its children. This gate is 
updated when a child is added or removed from its 
parent.
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• For NOT and REST OF gates, select only one gate. REST 
OF gates are only available when a child gate exists for a 
gate.

4. Right-click the selected gates and select an available logical 
gate option (for example, select AND).

A new gate definition is created based on your specified 
existing gate(s) and it is added to the gate hierarchy under the 
first common ancestor. The new gate definition is applied to all 
tubes, and the population hierarchies are updated to identify 
the new logical population. 

The plots (that contain the existing gates) are updated to 
graphically show the logical gate with no outline.

More information • Creating adaptive (snap-to) gates (page 374)

• Quad gates overview (page 384)
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Making gates unique
Introduction This topic describes how to make gates unique to a specific tube.

About making 
gates unique

When gates are made unique, the population hierarchy is updated 
and the unique gate is identified by a tube icon. The associated gate 
is also marked in the plot as unique. 

Since a unique gate is specific to one tube, any modifications are 
not applied to other tubes within the experiment. 

Making a gate 
unique

To make a gate unique: 

1. In the hierarchy view, under Population View, select a tube. 

2. Right-click the gate that you want to make unique to the tube, 
then select Make Unique. 

The gate is defined as unique in the Population View of the 
Hierarchy.

Removing unique To remove unique from a gate: 

1. In the hierarchy view, under Population View, right-click the 
unique gate, then select Remove Unique. 

Tube icon indicates a unique gate
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The gate reverts to its original definition (before the gate was made 
unique). The tube icon is removed from the plot and population 
view.

More information • Resizing and reshaping gates (page 354)

• Modifying gate properties (page 357)

Creating adaptive (snap-to) gates
Introduction This topic describes how to create snap-to polygon and snap-to 

interval gates, and describes how to recalculate adaptive gates 
when the event data changes.

Adaptive gate 
behavior

Adaptive gates include snap-to polygon and snap-to interval gates. 
An adaptive gate conforms its shape and location to the underlying 
data on the plot, and applies the same start point, sizing factor, and 
movement factor to all tubes or files that use this adaptive gate. 

If you move, resize, or reshape an adaptive gate, it stops adjusting 
to the underlying data. After you resize or reshape an adaptive 
gate, you must recalculate to restart the adaptive behavior. 

If the gate snaps to another cluster after it is recalculated, then any 
plots that use the recalculated snap-to gate, a descendent, or 
dependent logical gate are updated. 
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Creating a snap-to 
polygon gate

To create a snap-to polygon gate:

1. Click on a plot.

2. Click the Snap-To Polygon Gate tool on the Worksheet 
toolbar.

3. Click on a cluster of events in the plot. 

The polygon snaps to the nearest cluster of events in the 
population.

If a cluster is not found, a message is displayed and a default 
small pentagon gate is created in the plot. If this occurs, try 
using an ellipse or polygon gate instead.
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Creating a snap-to 
interval gate

To create a snap-to interval gate: 

1. Click on a plot.

2. Click the Snap-To Interval tool on the Worksheet toolbar.

3. Click on a specific population in the plot. 

A snap-to interval gate is displayed around the closest cluster 
that is within the default range.

If a cluster is not found, a message is displayed and a default 
narrow interval gate is created. If this occurs, try using an auto 
interval gate instead.
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Re-calculating 
(restarting) 
adaptive gate 
behavior

To re-calculate adaptive gate behavior after the gate has been 
resized or reshaped:

1. Right-click the adaptive gate in a plot and select Recalculate.

Resized snap-to gate before recalculation
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If the gate snaps to another cluster after it is recalculated, then any 
plots that use the recalculated snap-to gate, a descendant, or 
dependent logical gate is updated. 

More information • Creating auto gates (page 379)

Resized snap-to gate after recalculation
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Creating auto gates
Introduction This topic describes auto gate behavior and how to create auto 

gates. Auto gates include auto polygon and auto interval gates.

Auto gate behavior Auto gates adapt to the underlying data only during creation. After 
you create an auto gate, it behaves like a regular polygon or 
interval and does not adapt.

When an auto polygon gate is created on an overlay, it adapts to 
the top layer only. 

Procedure To create an auto gate:

1. Click on a plot.

2. Click the Auto-polygon Gate or Auto Interval Gate tool on the 
Worksheet toolbar.

3. Click on a specific population in the plot. 

The auto gate adapts to the population data, then becomes a 
polygon or interval.
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More information • Creating adaptive (snap-to) gates (page 374)

• Creating and adjusting interval gates (page 380)

Creating and adjusting interval gates
Introduction This topic describes how to create interval gates in plots and adjust 

their size and position. 

Use interval gates to indicate and measure an x-axis data interval 
in a plot.

Interval gate 
behavior

When you create an interval gate on a histogram for a tube, all 
events in related dot plots for the tube are displayed with the 
population color (with no visible outline). 

When you create an interval gate on a dot plot, all events on 
related histograms are not displayed until you configure the plots 
to display the newly created gate. Once the histogram is 
configured, the histogram curve is displayed in the population 
color.

Creating an interval 
gate

To create an interval gate:

1. Click on a plot.

2. Click the Interval Gate, Auto Interval Gate or Snap-to Interval 
Gate tool on the Worksheet toolbar.

3. Click on a cluster of events in the plot. The interval gate is 
displayed.
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Adjusting an 
interval gate

To adjust an interval gate: 

1. Click on the left or right boundary in an interval gate. 

Crosshairs are displayed.
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2. Drag the boundary of the interval (to increase or decrease the 
interval size). 

Crosshairs
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Moving an interval 
gate

To move an interval gate:

1. Click and drag the entire gate to the left or right. 

The directional cursor and vertical location indicators are 
displayed.

More information • Creating auto gates (page 379)

• Creating logical gates (page 371)

Vertical location 
indicators
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Quad gates overview
Introduction This topic describes quad gates, different quad gate modes, and 

how to align, pivot, and reset the gates.

In addition to the quad gates described in this topic, you can create 
staggered quad gates. Staggered quad gates are an alternate type of 
basic quad gate, with two center points (or handles). See Staggered 
quad gate overview (page 392) for more information.

About quad gates A quad gate consists of four segments that divide a plot into four 
quadrants (sections). The default name for a quads is Qn, where n 
is the quad number.

The default names for its quadrants are: 

• UL (upper-left quadrant)

• UR (upper-right quadrant)

• LL (lower-left quadrant)

• LR (lower-right quadrant)

By default, the gate is created as a statistics-only gate.
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There are four different quad gate modes:

• Basic 

• Vertical offset

• Horizontal offset

• Hinged

Basic mode All new quad gates start in basic mode. This mode has a single 
center point, four offset handles, and four pivot handles. Any 
segment in the quad can move in the x or y direction (using the 
offset handles). You can use the pivot handles to change the slope 
of any segments.

Vertical offset 
mode

Enable this mode by dragging the offset handle on a vertical 
segment. You can move the vertical segments individually in the x-
dimension, but you cannot move the individual horizontal 
segments or pivot them in the plot. 

Intersection (carrier) point

Offset handle

Pivot handle
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If you want to enable horizontal offset or hinged mode, you need 
to reset the quad to basic mode. Resetting re-aligns the vertical and 
horizontal segments.

Horizontal offset 
mode

Enable this mode by dragging the offset handle on a horizontal 
segment. You can move the horizontal segments individually in the 
y-dimension, but you cannot move the individual horizontal 
segments or pivot them in the plot. 

If you want to enable vertical offset or hinged mode, you need to 
reset the quad to basic mode. Resetting re-aligns the vertical and 
horizontal segments.
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Hinged mode Enable this mode by dragging a pivot handle to change the slope of 
any segment. A segment cannot be pivoted past another segment in 
either direction. The pivot stops when it reaches the bounds of 
another segment.

No segments can be offset in this mode. The left and bottom 
segments are attached to their respective sides. The left segment 
can only be moved on the left edge and the bottom segment can 
only be moved along the bottom edge. The other segments can be 
moved to all sides. 

More information • Creating quad gates (page 388)

• Staggered quad gate overview (page 392)

• Creating staggered quad gates (page 394)

• Creating logical gates (page 371)

• Resetting quads to basic mode (page 390)
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Creating quad gates
Introduction This topic describes how to create a basic quad gate and how to 

modify the quad segments.

Creating a quad 
gate

To create a quad gate:

1. Click a plot.

2. Select the Quad tool on the Worksheet toolbar.

3. In the plot, position the cursor to specify the quadrant 
intersection point.

4. Click to set the quad.
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Modifying quad 
segments

To modify quad segments:

1. Click any quad segment to display the outline and handles for 
the current quad mode. 

2. Drag the segment.
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The intersection (center) point of the gate is shown in each 
mode. You can reposition the intersection at any time by 
clicking and dragging in the plot area.

Resetting quads to 
basic mode

To reset modified quads:

1. Double-click the quad in the plot.

Viewing quads in 
the hierarchy

To view quads in the hierarchy:

1. In a worksheet, select a plot with quad gates.

2. Click Display Hierarchy on the Worksheet toolbar.

3. Select the Show Statistical Gates/Populations checkbox.
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4. Under Gate Hierarchy, expand All Events to view all quads in 
the hierarchy. 

Quads are identified in the hierarchy as UL (upper left), UR 
(upper right), LL (lower left), and LR (lower right).

More information • Quad gates overview (page 384)

• Creating staggered quad gates (page 394)

• Statistical quad gates (page 395)
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Staggered quad gate overview
Introduction This topic describes staggered quad gates. 

About staggered 
quad gates

A staggered quad gate is an alternate version of the basic quad 
gate, with two center points (or handles). 

All staggered quads start in basic mode with the first center point 
positioned on top of its second center point. 

New staggered quads look similar to a basic quad until you drag 
one of the two center points in the plot.

Starting center points
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The right and top segment form a right angle with the first center 
point, while its left and bottom segment form a right angle with the 
second center point. 

A line connects the two center points. You can click on any 
segment to display the outline and handles for the current mode. 

More information • Creating staggered quad gates (page 394)

• Quad gates overview (page 384)

• Statistical quad gates (page 395)

Center points
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Creating staggered quad gates
Introduction This topic describes how to create staggered quads in plots and 

how to reset them from staggered mode to basic mode.

Creating a 
staggered quad 
gate

To create a staggered quad gate:

1. Click the Staggered Quad tool on the Worksheet toolbar.

2. In the plot, position the cursor to specify the quadrant 
intersection point.

3. Click to set the staggered quad. 

4. Click a center point in the quad and drag it to create a 
staggered quadrant.

By default, the gate is created as statistics-only. The 
intersection (center) points of the gate are shown in each 
mode, and can be repositioned at any time by clicking and 
dragging in the plot area.

Resetting a 
staggered quad 
gate

To reset a staggered quad gate:

1. Double-click the gate in the plot. 

Resetting a staggered quad moves the bottom center point to 
the top center point.
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More information • Resizing and reshaping gates (page 354)

• Statistical quad gates (page 395)

Statistical quad gates
Introduction This topic describes statistical quad gates and how to display 

statistics in them.

About statistical 
quad gates

Quad gates are statistical gates by default. Statistical quad gates 
display statistics for all events in the plot. All events are displayed 
in the same color and cannot be used as a parent population. These 
gates are only used for statistics are not used for other gating 
functions (for example, to gate another plot or as part of a logical 
gate).

Non-statistical quad gates display statistics and event counts for 
populations in each quadrant. Each quadrant displays a different 

Statistical quad gate
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population color and can be used as parent populations or in 
logical gates.

Procedure To show statistics in quad gates:

1. Right-click a quad gate in a plot and select Properties.

The Properties dialog opens.

Non-statistical quad gate
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2. Select the Statistics Only checkbox to display a statistical quad 
gate or clear this checkbox to display a non-statistical quad.

3. (Optional) Select the Strict Parameter Matching checkbox to 
apply the gate across all plots that match the long parameter 
name (full name of the parameter or fluorochrome). 

Clear this checkbox to use the less restrictive short parameter 
name (less specific parameter name, for example, FITC) in the 
matching.

4. (Optional) Select the Show Percent of Parent checkbox to 
show the percent of the parent population for each quadrant.

5. (Optional) Select the Show Label(s) checkbox to display bin 
labels on all plots containing the gate.

More information • Creating staggered quad gates (page 394)

• Gating guidelines (page 350)
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11
Statistics

This section includes detailed information about statistics views. Use this section to 
learn about creating, modifying, and exporting statistics views. 

This section includes the following topics:

• Working with statistics views (page 400)

• Setting statistics view properties (page 401)

• Selecting populations for statistics views (page 405)

• Selecting statistics for statistics views (page 406)

• Editing and deleting percentile formulas for statistics (page 407)

• Adding expressions to statistics views (page 409)

• Adding keywords to statistics views (page 411)

• How gate modifications affect statistics views (page 413)

• Rearranging elements in a statistics view (page 414)

• Exporting statistics from statistics views (page 416)
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Working with statistics views
Introduction This topic describes how to create, rename, and delete statistics 

views. 

About statistics 
views

Statistics are associated with all gates and populations in plots on a 
worksheet. The calculated statistics are displayed in a view that 
includes a title, keywords, expressions, and statistics for one or 
more populations and/or parameters.

You need to set the statistics properties to display the worksheet 
statistics in this view.

Creating statistics 
views

To create a statistics view:

1. Click Statistics on the Worksheet toolbar.

2. On the worksheet, click to draw the statistics view.

A new statistics view is displayed in the worksheet.
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Renaming statistic 
views

To rename a statistics view:

1. Double-click in the statistics title in the header to enable edit 
mode.

2. Type a new title for the statistics view.

3. Click the header to exit edit mode.

Deleting statistics 
views

To delete a statistics view from a worksheet:

1. Right-click the statistics view and select Delete.

The statistics view is deleted.

More information • Setting statistics view properties (page 401)

Setting statistics view properties
Introduction This topic describes how to set properties for a specific statistics 

view. You must set the properties for each statistics view after you 
create it. 

All modifications to statistics view properties are automatically 
applied. No additional saving or applying is required.

Selecting statistics 
view options

To set statistics view properties:

1. Right-click the statistics view and select Properties. 
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The Statistics View Properties dialog opens.

2. In the General tab, under Display, select the checkbox to 
display populations in columns.

3. Under Acquisition, select the checkboxes to acquire 
cumulative statistics and include the statistics in the auto-
exported file.

See Exporting statistics from statistics views (page 416) for 
more information.
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Setting font 
properties

To select font properties for a statistics view:

1. Click the Colors and Fonts tab.

2. Set the color, font family, title, and font size properties for the 
statistics view.
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Setting statistics 
formats

To set the decimal place format for statistics:

1. Click the Decimal Places tab.

2. In the Digits column, specify the decimal place for each 
statistic in the table.

More information • Working with statistics views (page 400)

• Selecting populations for statistics views (page 405)
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Selecting populations for statistics views
Introduction This topic describes how to select populations for statistics views.

Make sure to add tubes to your experiment first so that they are 
available for selection.

Procedure To select populations for a statistics view:

1. Right-click the statistics view and select Edit Populations. 

The Edit Populations dialog opens.

This dialog includes all tubes and all populations (all events 
and gated events).

2. Click a tube in the tree to expand a population category.

3. Select the checkboxes for all population categories you want to 
display in the statistics view (for example, select All Events).

If the dialog includes numerous tubes, files, and populations, 
type a tube, file, or population name in the Filter field to locate 
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a specific tube, file, or population (for example, type %). All 
population names that contain % are displayed in the list.

More information • Setting statistics view properties (page 401)

• Selecting statistics for statistics views (page 406)

Selecting statistics for statistics views
Introduction This topic describes how to select which statistics display in 

statistics views.

Procedure To select which statistics to display in a statistics view:

1. Right-click the statistics view and select Edit Statistics. 

The Edit Statistics dialog opens.
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2. Click the Statistic tab.

Top-level parameters include parameters contained in the 
experiment.

3. Click a parameter in the tree to expand a parameter statistics 
category, then select the checkboxes for all of the statistics you 
want to display in the statistics view. 

You can filter the populations by typing a population name or 
part of a name, or multiple words in the Filter field. For 
example, if you type Min, all population names that contain 
Min are displayed in the list.

4. At the bottom of the dialog, select the Population Statistics 
checkbox to display the population statistics (Events, % Total, 
% Parent, % Grandparent) in the statistics view.

5. (Optional) Click the Percentile tab to edit the percentile 
formulas.

More information • Selecting populations for statistics views (page 405)

• Editing and deleting percentile formulas for statistics 
(page 407)

Editing and deleting percentile formulas for 
statistics
Introduction This topic describes how to edit or delete percentile formulas for a 

statistics view.

Use the Percentile tab to set a value for a percentile of event 
distribution in a plot.

Editing percentile 
formulas

To edit percentile formulas for percentile statistics:

1. Right-click the statistics view and select Edit Statistics. 
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2. Click the Percentile tab.

3. Click Add to add a new percentile formula. 

4. In the Percentile column, type a value for the percentile (for 
example, 95).

5. (Optional) In the Decimals column, add or remove decimal 
places.

The new percentile is now available as a statistics function for all 
parameters. To display the percentile, click the Statistic tab and 
select the new percentile statistic.

Deleting existing 
percentile formulas

To delete an existing percentile formula from the table:

1. Click a row in the Percentile table.

2. Click Delete.

The percentile formula is deleted.
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More information • Selecting statistics for statistics views (page 406)

• Adding expressions to statistics views (page 409)

Adding expressions to statistics views
Introduction This topic describes how to display existing expressions in the 

statistics view header. 

You must define expressions before you can add them to the 
statistics view.

Procedure To display existing expressions in the statistics view header:

1. Right-click the statistics view and select Edit Expressions. 

The Edit Expressions dialog opens.

2. Select the checkboxes for all expressions you want to display 
in the statistics view header. 

You can filter the expressions by typing a name, part of a 
name, or multiple words in the Filter field.

3. Close the dialog to apply the changes.
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The expressions are added to the statistics view.

More information • Modifying expressions (page 430)

• Editing and deleting percentile formulas for statistics 
(page 407)

• Adding keywords to statistics views (page 411)
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Adding keywords to statistics views
Introduction This topic describes how to display existing keywords in the 

statistics view header. 

These keywords provide descriptions which help you identify the 
statistics on the worksheet or in a final report.

Procedure To select keywords to display in a statistics view:

1. Right-click the statistics view and select Edit Keywords. 

The Edit Keywords dialog opens.
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2. Click a parameter in the tree to expand a keyword statistics 
category.

You can search the keywords by typing a name, part of a 
name, or multiple words in the Search field.

3. Select the checkboxes for all of the keywords you want to 
display in the statistics view header. 

4. Close the dialog to apply the changes.

The keywords are added to the statistics view.
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More information • Adding expressions to statistics views (page 409)

• How gate modifications affect statistics views (page 413)

How gate modifications affect statistics views
Introduction This topic describes how statistics for populations are affected 

when you make modifications to gates.

Effects of 
modifying gates

• If you modify the size, shape, or position of a gate, all statistics 
views (containing the population) display the new computed 
statistics for the modified gate, and dependent and descendant 
populations.

• If you modify a gate hierarchy, the statistics view updates to 
reflect the new hierarchical structure and all included 
populations.

• If you delete a gate from a plot, the population and its 
statistical data are removed from the statistics view.

• If you add or remove a layer from an overlay plot, or change 
the order of layers, the associated statistics are displayed in the 
same order as the layers displayed in the plot.

More information • Adding keywords to statistics views (page 411)
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Rearranging elements in a statistics view 
Introduction This topic describes how to rearrange elements in a statistics view. 

You can rearrange all columns except the Name column (when 
populations are displayed in the row headers).

Rearranging 
columns

To rearrange columns in a statistics view:

1. Drag a column header to a new location in the table and 
release the mouse button.

.

Rearranging rows To rearrange the rows in a statistics view:

1. Click a row in the table and drag it to a new location.
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A marker indicates the new target location.

2. Release the mouse button.

Rearranging header 
elements

To rearrange header elements:

1. Click an item in the header and drag it to a new position in the 
header. 

A marker indicates the target position. 

2. Release the mouse to drop the item. 

Displaying header 
elements in side-
by-side lists

To display expressions and keywords in two side-by-side lists:

1. Click an item in the header and drag it to the right. 

A marker indicates the target position in the right list.

2. Release the mouse button.

The header elements are moved to a second column.

Marker
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More information • Exporting statistics from statistics views (page 416)

Exporting statistics from statistics views
Introduction This topic describes how to export statistics from a statistics view 

to a file. You can open the file in third-party software (for example, 
a spreadsheet application) and format the data as needed.

Procedure To export statistics:

1. Click the statistics view on the worksheet (or report).

2. Right-click the statistics view and select Export Statistics.

The Save As dialog opens.

3. In the File name field, type a specific export file name. 

4. In the Save as type field, select a CSV (default) or XML file 
type.

5. Click Save. 

Including statistics 
in user-defined 
assays 

The exported results data for user-defined assays is displayed in the 
Library. You can view this data by opening the Library workspace, 
then selecting Assays > User-defined > Export Results tab.

The following figure shows the Export Results tab in a user defined 
assay in the Library.
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The exported data that appears in the Keywords and Expressions 
and Statistics boxes must be defined in a statistics view in an 
experiment before you create the user-defined assay.
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The following table describes the steps you need to perform to 
generate the keywords, expressions, and statistics data.

More information • Rearranging elements in a statistics view (page 414)

• Working with statistics views (page 400)

Step Description

1 In an experiment worksheet or report, add a statistics view.

See Working with statistics views (page 400) for more 
information.

2 In the statistics view, select the statistics and populations as 
needed. 

See Selecting populations for statistics views (page 405) and 
Selecting statistics for statistics views (page 406) for more 
information.

3 Add expressions and keywords to the statistics view header.

See Adding expressions to statistics views (page 409) and 
Adding keywords to statistics views (page 411) for more 
information.

4 In the Statistics View Properties dialog, select the Include in 
Auto-Export checkbox.

See Setting statistics view properties (page 401) for more 
information.

5 Create an assay from the experiment. 

See Creating a user-defined assay from an experiment 
(page 218) for more information.

6 Manage the exported results in the user-defined assay.

See Editing results exporting properties (page 285) for more 
information.
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Expressions

This section includes detailed information about expressions and procedures that are 
not part of the daily workflow. Use this section to learn about building expressions. 

This section includes the following topics:

• Expressions overview (page 420)

• Building expressions (page 424)

• Modifying expressions (page 430)

Other related topics:

• Working with statistics views (page 400)

• Adding expressions to statistics views (page 409)
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Expressions overview
Introduction This topic describes the BD FACSuite tools used to create custom 

expressions and add them to a worksheet or report.

About expressions An expression is a mathematical formula made up of results and 
operators, including acquisition or analysis statistics, populations, 
keywords, constants, and other expressions. 

Expressions are items on the worksheet, such as plots and 
statistics, and include a prefix, result, suffix, and a unique name 
(the key identifier of the expression). You can also add expressions 
to the header of the Statistics view or add them to a text box.

About the 
Expression 
Properties dialog

Use the Expression Properties dialog to create and edit expressions. 
The following figure shows the Expression Properties dialog with 
the Search Results panel collapsed.

Expression
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The following figure shows the Expression Properties dialog with 
the Search Results panel expanded. Click to expand each category 

Formula field

Operators

Expression description

Expression comments

Search results
collapsed
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to view and select options. You can also type a name in the Search 
field to locate specific results.

Search results
expanded

Results categories

Search field



Chapter 12: Expressions 423

You can create and edit expressions in the worksheet to calculate 
results. When you create an expression, you can use results from 
following different categories.

More information • Modifying expressions (page 430)

• Adding expressions to statistics views (page 409)

Result category Description

Worksheet Displays the analysis elements that appear on the 
current worksheet or report. Results are grouped 
first by existing element type (expression, statistics, 
plots), then by specific elements that exist on the 
current worksheet or report. 

Note that you can also select statistics and 
expressions from their own results categories.

Statistics Displays the analysis results grouped first by 
statistic (for example, mean, max, CV), then by 
tube, then by events parameter.

Populations Displays the analysis results grouped first by 
population, then by tube, then by events.

Expressions Displays the existing expressions in a worksheet or 
report (for example, Expression 1).

Constants Displays constants (for example, pi and e).
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Building expressions
Introduction This topic describes different ways to build expressions. 

Building 
expressions from 
results

To build expressions from results:

1. In a worksheet, click Create Expression on the Worksheet 
toolbar.

2. Click in the worksheet to create a new blank expression. 

The Expression Properties dialog opens.

The default expression formula is empty and its result displays 
as NaN (not a number). If a formula is invalid and cannot be 
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calculated, the expression is displayed on the worksheet with a 
red background.

3. In the Expression Properties dialog, click Search Results.

4. Locate available results by performing one of the following 
actions:

• Type your search string into the Search field.
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• Select a category from the Results tree, then expand the tree 
items to locate and select tubes, parameters, and 
populations.

• Locate specific statistics in a statistics view.

5. Create a formula using one of the following methods:

• Select a result from the Results tree to add it to the Formula 
field.

• Type numerical values and operators in the Formula field.

• Drag statistics from a row in a statistics view into the 
Formula field.

6. Use operands on the toolbar to perform specific calculations. 

Click the operator buttons to add them to the Formula field.
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 The calculated expression is displayed in the worksheet.

7. Click the Search Results arrow to display the expression 
details.

8. In the Name field, specify a name for this expression. 

The name must be unique within the experiment. 

9. (Optional) Type in the Prefix or Suffix field to create a 
displayed name for the expression.

10. Specify the decimal place display in the Decimal Places Shown 
field.

11. Under Comments, add any comments that describe this 
expression.

Example of the new expression
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12. Close the Expression Properties dialog to save the expression.

The process for building expressions from results is the same for all 
categories. The following examples provide more specific 
instructions.

Example: Building a 
compound 
expression formula

The following example describes how to create a basic expression 
that adds the mean of P1 from Tube 1 and Tube 2. 

To build a compound expression by using results of another 
calculated expression:

1. In the Name field, create a unique name for your expression.

2. In the Prefix field, type the text that you want to display on the 
worksheet (for example, Mean + Median from P1).

3. Click Search Results.

4. In the Results tree, select Expressions.

5. Select an existing expression (for example, select Mean of P1).

6. Select an operand (for example, click the plus sign (+)).

7. In the Results tree, select Statistics.
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8. Select a statistical category, tube, parameter, and population 
(for example, select Median > Tube_001 > FITC-A > P1).

9. Repeat for additional tubes if needed.

The selected result is displayed in the Formula field. The 
calculated compound expression is displayed in the worksheet.

The formula updates each time the individual statistic changes 
and updates the expression. 

More information • Modifying expressions (page 430)

New compound expression
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Modifying expressions
Introduction This topic describes how to modify existing expression properties 

and how to resize, move, and delete expressions. This topic also 
describes how to modify text font, size, and weight.

Modifying existing 
expression 
properties

To edit existing expression properties:

1. Right-click an expression and select Properties to open the 
Expression Properties dialog.

2. Edit the fields.

3. Click X to save the properties and close the dialog.

Resizing an 
expression

To resize the expression display:

1. In a worksheet, click an expression. 

2. Drag a handle to re-size the expression.

Moving an 
expression

To move an expression within a worksheet:

1. In a worksheet, drag the expression to a new location in the 
worksheet.

Deleting an 
expression

Before you delete an expression, make sure that it is not used 
elsewhere. Deleting an expression can invalidate all references in 
formulas, reports, and statistics views that depend on the deleted 
expression. This can include references that might exist in other 
worksheets.

To delete an existing expression:

1. Right-click an expression and select Delete Expression.
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Modifying the 
expression format

To modify the expression format:

1. In the Expression Properties dialog, click the Formatting tab.

2. Select a font, size, and weight for the expression.

More information • Expressions overview (page 420)

• Building expressions (page 424)
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13
Data analysis example

This section includes the following topics:

• Analyzing data acquired in an experiment (page 434)

• Creating a new analysis report (page 436)

• Selecting an FCS data source (page 437)

• Creating plots for analysis (page 438)

• Defining populations for analysis (page 440)

• Showing the populations of interest (page 444)

• Creating a statistics view (page 446)

• Formatting and printing a report (page 448)

• Analyzing multiple FCS files in an experiment (page 451)
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Analyzing data acquired in an experiment
Introduction This topic describes how to use BD FACSVerse System analysis 

tools to create plots, gates, and statistics views on an experiment 
worksheet or report and analyze the acquired data. 

In this example Since experiment analysis and gating strategies can be unique to 
each sample, laboratory, or operator, this example does not suggest 
an analysis strategy. Instead, it demonstrates how to use specific 
BD FACSVerse System tools to create a basic analysis worksheet 
and report. 

This example uses one FCS file and fluorescence data collected 
from beads. This example compares and analyzes fluorescence 
data from four different parameters. You can substitute cells and 
different fluorescence parameters as needed. 

Example workflow The following table describes a basic example of an analysis 
workflow.

Stage Description

1 Create or open an experiment in the Experiment workspace.

See Creating and opening experiments (page 142) for more 
information.

2 Create a new report in the experiment.

See Creating a new analysis report (page 436) for more 
information.

3 Acquire tubes, or add existing FCS files to the Data Source 
panel.

See Selecting an FCS data source (page 437) for more 
information.

4 Create plots in the worksheet or report for each scatter or 
fluorescence parameter you want to analyze.

See Creating plots for analysis (page 438) for more 
information.
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More information • Selecting an FCS data source (page 437)

• Analyzing multiple FCS files in an experiment (page 451)

5 Draw gates to define the populations you want to analyze.

See Defining populations for analysis (page 440) for more 
information.

6 Display or isolate specific populations.

See Showing the populations of interest (page 444) for more 
information.

7 Create a Statistics view in the worksheet or report and add 
statistics and populations.

See Creating a statistics view (page 446) for more 
information.

8 Format the report by adding headers, footers, text, then print 
or export the report.

See Formatting and printing a report (page 448) for more 
information.

Stage Description
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Creating a new analysis report
Introduction This topic describes how to create a new analysis report and 

rename it.

Procedure To create a new analysis report:

1. In an experiment, click the Add Report tool on the Worksheet 
toolbar.

A new Report tab opens. 

2. Click the text in the Report tab, then type a new name (for 
example, Example Report_001).

The report is automatically saved with the experiment.

Next step Selecting an FCS data source (page 437)

More information • Creating plots for analysis (page 438)

• Analyzing data acquired in an experiment (page 434)
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Selecting an FCS data source
Introduction This topic describes how to select an FCS file as the data source for 

plots in a report. This example uses an FCS file created by 
acquiring a tube of beads. You can substitute any FCS file as 
needed.

Procedure To select an FCS data source:

1. In the Data Sources panel, click Import FCS Files.

The Open dialog opens. 

2. Navigate to the folder that contains your FCS files.

3. Select an FCS file, then click Open.

A new (filled) tube is created for the FCS file in the Data 
Sources panel.

The run pointer indicates the current (selected) FCS file.

Next step Creating plots for analysis (page 438)
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More information • Creating a new analysis report (page 436)

• Analyzing data acquired in an experiment (page 434)

Creating plots for analysis
Introduction This topic describes how to create plots for analysis in a report. 

Procedure To create plots for analysis:

1. Create four dot plots on the report.

a. Click the Dot Plot tool on the Worksheet toolbar.

b. Click in the report to create a plot. 

2. Change the X and Y parameters for each plot. 

In this example, the following parameters are used for the 
plots on the analysis report:

• FSC vs SSC

• FITC vs PE

• FITC vs PerCP-Cy5.5

• FITC vs APC
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Your report should look like the following example.

Note that the FSC vs SSC plot is displayed in linear scale (by 
default). Subsequent plots are displayed in biexponential scale 
(by default).

Next step After you create the plots with data, you need to draw gates to 
define the populations of interest. See Defining populations for 
analysis (page 440).

More information • Analyzing data acquired in an experiment (page 434)

• Selecting an FCS data source (page 437)
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Defining populations for analysis
Introduction This topic describes how to draw and name gates to define 

populations in an analysis plot in a report. 

Before you begin You need to create the plots with data so you can draw gates to 
define and identify the populations of interest.

Procedure To define populations for analysis:

1. In the FSC vs SSC plot, draw a gate around the singlets.

See Drawing gates in plots (page 164) for more information.

2. Right-click the gate and select Properties.

The Properties dialog opens.

3. In the Name field, type Singlets, then press Enter.

4. Right-click the plot and select Properties. 

The Plot Editor dialog opens.
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5. In the General tab, under Parent Population, select the Singlets 
checkbox to display only singlet events in the selected plot.

6. Close the Plot Editor dialog.

7. Repeat steps 4 through 6 for the remaining plots.

8. In the FITC vs PE plot, create gates to define the FITC-positive 
and PE-positive populations, then name the populations. 

For example, complete the following steps:

a. Select the plot, then click a gate tool on the Worksheet 
toolbar and draw a gate around a positive population.

b. Right-click the gate and select Properties.

c. Type a name (for example, FITC-positive), then close the 
dialog to rename the population.
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d. Repeat steps a through c for the other positive populations.

9. In the FITC vs PerCP-Cy5.5 plot, create gates to define the 
PerCP-Cy5.5 positive population, then name the population. 

10. In the FITC vs APC plot, create gates to define the APC-
positive population, then name the population. 

Your report should look like the following example.

11. Click Display Hierarchy on the Worksheet toolbar.
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The gate hierarchy should look like the following example.

Next step After you draw gates, define, and identify the populations, you can 
isolate the populations in each plot. See Showing the populations 
of interest (page 444).

More information • Analyzing data acquired in an experiment (page 434)

• Creating plots for analysis (page 438)

• Drawing gates in plots (page 164)
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Showing the populations of interest
Introduction This topic describes how to show the populations of interest in a 

report. Note that if you want to show both a negative and a 
positive population, you need to create gates for both populations. 

Before you begin You need to draw gates, define, and identify the populations, 
before you can isolate the populations in each plot.   

Procedure To show the populations of interest:

1. Right-click the FSC vs SSC plot, then select Properties.

The Plot Editor dialog opens.
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2. Under Plot Title Content, verify that the Tube and Populations 
checkboxes are selected. 

This displays their names in the plot titles.

3. Under Primary Data Source, select the Singlets checkbox in the 
Population(s) tree.

This displays only the singlet population in the selected plot 
and statistics view.

4. Close the Plot Editor dialog.

5. Repeat steps 2 and 3 for each plot to select only the positive 
population to display in each plot.

Your report should look like the following example.
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Next step Create a statistics view for each plot to display the population 
statistics. See Creating a statistics view (page 446).

More information • Analyzing data acquired in an experiment (page 434)

• Defining populations for analysis (page 440)

Creating a statistics view
Introduction This topic describes how to create a statistics view in a report and 

how to view the gate and population hierarchies.

Before you begin You should define and isolate populations in each plot before you 
create a statistics view to display the population statistics for all 
plots.

Creating a statistics 
view

To create statistics views for all plots in the report:

1. Click the Statistics tool on the Worksheet toolbar.

2. Click in the worksheet or report to add the statistics view.

3. Drag the statistics view below a plot on the report.

4. Right-click the statistics view and select Edit Populations.

5. In the Edit Populations dialog, select all of the populations you 
want to include in the statistics view, then close the dialog.

6. Right-click the statistics view and select Edit Statistics.

7. In the Edit Statistics dialog, select the statistics you want to 
display for each parameter (for example, RCV), then close the 
dialog.
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The statistics view updates and displays the selected 
populations and statistics.

Next step Add report headers and footers, and format the report before you 
print it. See Formatting and printing a report (page 448).

More information • Analyzing data acquired in an experiment (page 434)

• Showing the populations of interest (page 444)
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Formatting and printing a report 
Introduction This topic describes how to format a report and set header and 

footer properties. 

You can customize the header and footers to include specific 
information and images, and create a custom report layout. Once 
you have an appropriate format, you can print the report.

Formatting headers 
and footers 

To format report headers and footers:

1. Open an experiment or assay report.

2. Click the Header & Footer tool on the Worksheet toolbar.

The Header/Footer dialog opens.

3. Set the cursor in the upper left corner of a header (Left, Center, 
or Right section). 

4. Under Elements, double-click an element you want to add to 
the header section (for example, Cytometer Name).

Note that you can type custom text in any of the sections if 
you prefer.

5. Continue to add header elements or type text in each section as 
needed.

6. Set the cursor in the bottom left corner of a footer (Left, 
Center, or Right section). 

7. Continue to add footer elements or type text in each section as 
needed.
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The Preview box shows the layout of the elements you 
selected.

8. Once you have added elements to the report, you can perform 
the following optional actions.

9. You can also perform the following optional formatting 
actions.

10. Click OK.

The report layout is displayed.

To... Then do this...

Move elements 
from one section to 
another

Drag elements from one section to another 
section.

Delete elements 
from the report 
header or footer

Click an element in a section and press 
Delete to delete it from the section.

To... Then do this...

Display a border 
around the elements 
in the header or 
footer

Select the Show Border checkbox.

Add a logo or other 
image to the report

1. Click Add Image.

The Add Image dialog opens.

2. Navigate to the folder that contains the 
image, then click Add.

The image is added to the section, and 
the header or footer is displayed under 
Preview.

Format the report 
text

Select a font, font size, color, or style for all 
the text in the report.
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Printing the 
analysis report

To print the analysis report:

1. Click the Report tab.

2. From the menu bar, select File > Print. 

3. Preview the report and make sure that all analysis items are in 
the print area of the page.

4. Click Print on the Print Preview bar.

5. Complete your typical printing process.
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More information • Analyzing data acquired in an experiment (page 434)

• Creating plots in a worksheet (page 158)

• Drawing gates in plots (page 164)

• Analyzing multiple FCS files in an experiment (page 451)

Analyzing multiple FCS files in an experiment 
Introduction This topic describes how to perform analysis on data from multiple 

acquired tubes (FCS files) in a single experiment by creating 
separate report pages for each tube.

Before you begin You need to have acquired data from more than one tube. 

Procedure To analyze data from multiple FCS files in an experiment:

1. Open an experiment and create and format a report. 

2. In the Data Sources panel, click Import FCS Files.

The Open dialog opens. 

3. Select the FCS files you want to add, then click Open.

New (filled) tubes are added for the FCS files in the Data 
Sources panel.

4. Click the Report tab.

5. Click Add Page on the Worksheet toolbar.

6. Set the run pointer to a tube in the Data Sources panel.

7. On a report page, create plots based on the new FCS file. 

• If you are using the same fluorochromes in all tubes (FCS 
files), create plots on the same page of the report.
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• If you are using different fluorochromes for each tube, set 
up each plot with the specific fluorochrome parameters 
that match the FCS file parameters. Consider adding report 
pages and organizing plots by fluorochrome or by tube.

After you add a report page for each FCS file you want to 
analyze, you can optimize the report display by adjusting the 
display percentage so you can view the pages side by side, 
magnifying the view, or changing the report orientation to 
view reports vertically. 

See Modifying experiment worksheets and reports (page 208) 
for more information.

More information • Creating a new analysis report (page 436)

• Formatting and printing a report (page 448)

• Creating plots in a worksheet (page 158)

• Drawing gates in plots (page 164)

• Analyzing data acquired in an experiment (page 434)
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Keywords

This section includes the following topics:

• BD FACSuite generated FCS keywords (page 454)

• Optional FCS keywords (page 455)

• BD created keywords (page 456)

• Setup and QC keywords (page 458)

• CBA keywords (page 460)

• Keywords used by BD FACSuite software (page 461)
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BD FACSuite generated FCS keywords
Introduction This topic describes the FCS keywords generated by BD 

FACSVerse System. These keywords are used with the FCS 3.0 
format.

Keywords

More information • Modifying tube properties (page 167)

• Assigning keywords to entries and tubes (page 243)

• Understanding keywords (page 297)

Keyword Description

$BEGINANALYSIS Begin analysis segment offset

$BEGINDATA Begin data segment offset

$BEGINSTEXT Begin text segment offset

$BYTEORD Byte order

$DATATYPE Floating point data type

$ENDANALYSIS End analysis segment offset

$ENDDATA End data segment offset

$ENDTEXT End text segment offset

$MODE List-mode data

$NEXTDATA Offset to next data set

$PAR Number of parameters for acquired data

$PnB Bits for parameter n

$PnE Amplification type for parameter n

$PnR Range of parameter n

$TOT Number of events
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• Importing and exporting keywords (page 298)

• Working with keywords in the library (page 299)

Optional FCS keywords
Introduction This topic describes FCS 3.0 keywords that are optional.

Keywords
Keyword Description

$BTIM Time at beginning of acquisition

$CYT Flow cytometer type

$CYTSN Flow cytometer serial number

$DATE Acquisition date

$ETIM Time at end of acquisition

$EXP Creator of experiment or worklist

$FIL FCS file name

$INST Institution

$OP Operator

$PnN Short name of parameter n

$PnS Name of parameter n

$PnV Voltage of parameter n

$PROJ Name of experiment or worklist

$SMNO Tube ID

$SRC Sample ID

$SYS Computer type and operating system

$TIMESTEP Time step
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More information • Modifying tube properties (page 167)

• Assigning keywords to entries and tubes (page 243)

• Understanding keywords (page 297)

• Importing and exporting keywords (page 298)

• Working with keywords in the library (page 299)

BD created keywords
Introduction This topic describes the BD created keywords.

Keywords
Keyword Description

ADDRESS1 Address (for example, patient, or 
institution)

ADDRESS2 Address (for example, patient, or 
institution)

ADDRESS3 Address (for example, patient, or 
institution)

ADDRESS4 Address (for example, patient, or 
institution)

APPLY 
COMPENSATION

Compensation enabled

CHARSET Character set

CREATOR Application name and version number 
that created the data file

DIRECTOR Director name (for example, for the 
institution, department, or study)

EXPORT TIME Export time stamp
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EXPORT USER NAME Export user name

FLUIDICS MODE Current fluidics mode

FSC ASF FSC area scaling factor

GUID Unique ID for an exported FCS file

LASERnNAME Name of laser n

LASERnDELAY Laser delay for laser n

LASERnASF Area scaling factor for laser n

PLATE ID Plate ID for manually loaded tube 
(keyword is not written to the FCS file)

AUTOBS Auto Biexponential Scale enabled

PnBS R-value for parameter n

PnDISPLAY Display for parameter n

PnMS Manual R-values for parameter n

SPILL Spillover matrix

THRESHOLD Threshold

TUBE NAME Tube name

VOL Sample volume consumed during 
acquisition (using the BD Flow Sensor)

WELL ID Well ID for manually loaded tube 
(keyword is not written to the FCS file)

WINDOW EXTENSION Window extension value

Keyword Description
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More information • Modifying tube properties (page 167)

• Assigning keywords to entries and tubes (page 243)

• Understanding keywords (page 297)

• Importing and exporting keywords (page 298)

• Working with keywords in the library (page 299)

Setup and QC keywords
Introduction This topic describes the setup and QC keywords.

Keywords
Keyword Description

TUBE SETTINGS NAME Name of the tube settings that were used 
when data was acquired

TUBE SETTINGS ID ID of the tube settings that were used 
when data was acquired

CYTOMETER 
CONFIGURATION 
NAME

Name of the cytometer configuration that 
was current at the time data was acquired

CYTOMETER 
CONFIGURATION 
DATE CREATED

Date and time when the cytometer 
configuration was created

CYTOMETER 
CONFIGURATION 
DATE MODIFIED

Date and time when the cytometer 
configuration was last modified

CYTOMETER 
CONFIGURATION 
REGULATORY STATUS

Regulatory status of the current 
cytometer configuration at the time data 
was acquired

CST BEAD LOT ID Lot ID of the CS&T beads that were used 
during the last performance QC
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CST BEAD LOT 
EXPIRATION DATE

Expiration date of the CS&T beads that 
were used during the last performance 
QC

CST BEAD LOT 
REGULATORY STATUS

Regulatory status of the CS&T beads that 
were used during the last performance 
QC

CHARACTERIZATION 
QC DATE

Date and time when characterization QC 
was last run for the cytometer 
configuration that was current at the time 
data was acquired

PERFORMANCE QC 
DATE

Date and time when performance QC was 
last run for the cytometer configuration 
that was current at the time data was 
acquired

PERFORMANCE QC 
STATUS

Status of the last performance QC for the 
cytometer configuration that was current 
at the time data was acquired. Possible 
values: Pass, Fail.

PERFORMANCE QC 
ERROR MESSAGEn

Performance QC Error Message n 

PERFORMANCE QC 
WARNING MESSAGEn

Performance QC Warning Message n

LW REFERENCE 
SETTING DATE 
CREATED

Date and time when lyse/wash reference 
settings were created

LW REFERENCE 
SETTING DATE 
MODIFIED

Date and time when lyse/wash reference 
settings were last updated

LNW REFERENCE 
SETTING DATE 
CREATED

Date and time when lyse/no-wash 
reference settings were created

LNW REFERENCE 
SETTING DATE 
MODIFIED

Date and time when lyse/no-wash 
reference settings were last updated

Keyword Description
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More information • Modifying tube properties (page 167)

• Assigning keywords to entries and tubes (page 243)

• Understanding keywords (page 297)

• Importing and exporting keywords (page 298)

• Working with keywords in the library (page 299)

CBA keywords
Introduction This topic describes the keywords used when you run CBA assays 

with BD FACSuite software. These keywords are used with FCAP 
Array software to build plexes. 

See the FCAP Array Software User’s Guide for more information.

Keywords
Keyword Description

CBA PLEX 
NAME

The name of a plex. Used as part of the 
information transfer to FCAP Array software.

CBA TYPE Identifies the sample type as either standard or 
control. Used as part of the information transfer to 
FCAP Array software.

CBA 
STANDARD ID

The number of the standard. The value can also be 
“Pos” or “Neg” to identify positive or negative 
populations for qualitative CBA assays. Used as 
part of the information transfer to FCAP Array 
software.
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More information • Modifying tube properties (page 167)

• Assigning keywords to entries and tubes (page 243)

• Understanding keywords (page 297)

• Importing and exporting keywords (page 298)

• Working with keywords in the library (page 299)

Keywords used by BD FACSuite software
Introduction This topic describes the keywords used by BD FACSuite software. 

Keywords

CBA CONTROL 
ID

ID of the control in the tube or well. Used as part 
of the information transfer to FCAP Array 
software.

CBA DILUTION Used to specify the dilution of the sample. Used as 
part of the information transfer to FCAP Array 
software.

Keyword Description

Keyword Description

$SRC The value for this keyword is assigned to the 
sample ID of the entry. 

$SMNO The value for this keyword is assigned to the 
tube ID of the entry. If this keyword is not 
available, the Tube ID of the entry is blank.

$PnN The value for this keyword is parsed and 
assigned to the parameter name. If this keyword 
is not available, the parameters is named “Pn.”
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$PnS The value for this keyword is parsed and used to 
determine the labels of the parameters. If this 
keyword is not available, the labels for the 
parameters are blank.

$PnV The value for this keyword is parsed and 
assigned to the voltage of parameter. If this 
keyword is not available, the voltage for the 
parameter is 0.

$TIMESTEP This value is used to determine the step for the 
time parameter. If this keyword is not available, 
BD FACSuite software assumes a time step of 
0.01.

APPLY 
COMPENSATION

This value for this keyword is parsed and 
assigned to the flag for applying compensation 
for the tube. If this keyword is not available, 
compensation for the tube is disabled. 

AUTOBS Auto Biexponential Scale enabled

CHARSET-
AUTOBS

Character set for Auto Biexponential Scale

PnBS R-value for parameter n

PnDISPLAY Display for parameter n

PnMS Manual R-values for parameter n

Keyword Description
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More information • Modifying tube properties (page 167)

• Assigning keywords to entries and tubes (page 243)

• Understanding keywords (page 297)

• Importing and exporting keywords (page 298)

• Working with keywords in the library (page 299)

SPILL The value for this keyword is parsed and 
assigned to the spillover matrix for the tube. If 
this keyword is not available in an FCS 3.0 file, 
the spillover matrix for the tube uses the default 
matrix.

THRESHOLD The value for this keyword is parsed and 
assigned to the threshold for the tube. If this 
keyword is not available, the threshold for the 
tube is disabled.

TUBE NAME The value if this keyword is assigned to the tube 
name of the entry. If this keyword is not 
available, the tube name of the entry uses the 
default tube name creation for the entries.

Keyword Description
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Part 4: System reference

This part includes the following sections:

• Maintenance (page 467)

• BD FACS Universal Loader (page 501)

• BD FACSVerse system options (page 523)

• Cytometer configurations (page 537)

• BD FACSVerse technical specifications (page 547)

• Troubleshooting (page 555)

• Glossary (page 575)
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15
Maintenance

This section includes the following topics:

• Maintenance overview (page 468)

• Running the daily clean procedure (page 469)

• Refilling the sheath tank (page 471)

• Emptying the waste tank (page 473)

• Performing the monthly clean procedure (page 475)

• Replacing the sheath filters (page 478)

• Generating a system health report (page 481)

• Using the fluidics commands (page 482)

• Cleaning the manual tube port (page 483)

• Preparing for long term shutdown (page 484)

• Replacing the sample line (page 485)

• Replacing the sample line in a system with a flow sensor (page 491)

• Managing your database (page 498)
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Maintenance overview
Introduction This topic provides a list of daily, unscheduled, and scheduled 

maintenance.

Daily maintenance Daily maintenance is part of the shutdown procedure.

Unscheduled 
maintenance

The following table lists unscheduled maintenance that you might 
have to perform.

Procedure When

Running the daily clean procedure (page 469) Daily

Performing manual system shutdown 
(page 113)

Daily

Procedure When

Refilling the sheath tank (page 471) As needed

Emptying the waste tank (page 473) As needed

Using the fluidics commands (page 482) As needed

Cleaning the manual tube port (page 483) As needed

Preparing for long term shutdown (page 484) As needed

Replacing the sample line (page 485) As needed

Replacing the sample line in a system with a 
flow sensor (page 491)

As needed
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Scheduled 
maintenance

Scheduled maintenance should be performed according to the 
following table.

Running the daily clean procedure
Introduction This topic describes how to run the daily clean procedure. This 

procedure is included when you perform system shutdown. You 
can also use this procedure to clean the system whenever it is 
needed.

Required materials • 2 mL of 10% bleach solution

• 3 mL of DI water

Procedure

To run the daily clean procedure:

1. From the menu bar, select Cytometer > Daily Clean. 

Procedure When

Performing the monthly clean procedure 
(page 475)

Monthly

Replacing the sheath filters (page 478) Every 3 months

Caution!  Do not use the same tube repeatedly for DI water or 
bleach during the daily clean procedure. Repeated use can cause 
wear on the tube, and resulting particles can damage the tube 
sensor in the manual tube port.
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The following dialog opens.

2. Place a tube containing 2 mL of 10% bleach solution on the 
manual tube port, then click Continue.

3. When prompted, place a tube containing approximately 3 mL 
of DI water on the manual tube port, then click Continue.

The dialog closes when the process is complete.

Note:  You must complete this entire procedure. If the procedure is 
interrupted or not completed, the system prevents any other 
actions from happening. This is to avoid the possibility of bleach 
remaining in the fluidics path.

More information • Fluidics components (page 28)

• Performing manual system shutdown (page 113)
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Refilling the sheath tank
Introduction This topic describes how to check the sheath fluid level, illustrates 

sheath tank components, and describes how to refill the sheath 
tank.

The sheath and waste tanks must be placed at a level even with, or 
below, the cytometer. Placing the tanks higher than the cytometer 
can cause uncontrolled siphoning.

Checking the 
sheath fluid level

The standard sheath tank is translucent so you can visually check 
the fluid level. In addition, a message in the software alerts you 
when the tank is close to empty and starts a 10-minute timer. You 
must refill the tank before the 10 minutes elapses to avoid 
acquisition being interrupted. The system stops operation when the 
timer expires.

Required materials • BD FACSFlow sheath fluid to fill the sheath tank (5 L or 10 L, 
depending on which tank is being used)

Sheath tank 
components

The following figure shows the parts of the standard sheath tank.

Standard sheath 
tank in dock

 Connector

Filler cap
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Procedure To refill the sheath tank:

1. Disconnect the connector from the sheath tank by turning it 
counter-clockwise.

2. Remove the sheath tank from the dock and take it to a filling 
station.

3. Remove the filler cap and fill the tank with BD FACSFlow 
sheath fluid.

Do not use sheath fluid with surfactant.

4. Re-install the filler cap and place the tank in the dock.

5. Re-install the connector and turn clockwise to tighten it.

More information • Replacing the sheath filters (page 478)

• Fluidics components (page 28)

• Emptying the waste tank (page 473)

Connector 
disconnected from 
sheath tank
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Emptying the waste tank
Introduction This topic describes how to check the waste tank level, illustrates 

the waste tank components, and describes how to empty the waste 
tank.

The sheath and waste tanks must be placed at a level even with, or 
below, the cytometer. Placing the tanks higher than the cytometer 
can cause uncontrolled siphoning.

Checking waste 
tank level

The standard waste tank is translucent so you can visually check 
the fluid level. In addition, a message in the software alerts you 
when the tank is close to full, and starts a 10-minute timer. If the 
tank is not emptied within 10 minutes, the system prevents further 
operation.

Required materials • Enough bleach solution to equal 10% of volume of waste tank

Waste tank 
components

The following figure shows the parts of the standard waste tank.
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Procedure To empty the waste tank:

1. Verify that the system is not processing any samples. 

2. Disconnect the connector from the waste tank by turning it 
counter-clockwise.

3. Remove the tank from the dock and take it to a dumping 
station.

Standard waste 
tank in dock

Filler cap

Connector

Caution! All biological specimens and materials can transmit 
potentially fatal disease. To prevent exposure to biohazardous 
agents, expose waste container contents to bleach (10% of total 
volume) before disposal. Dispose of waste in accordance with 
local regulations. Use proper precautions and wear suitable 
protective clothing, eyewear, and gloves.

Connector disconnected 
from waste tank
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4. Remove the filler cap and empty the tank.

Hold the tank at an angle as you empty it and pour slowly to 
avoid splashing the contents.

5. Add bleach to the tank to equal 10% of the volume. 

6. Re-install the filler cap and install the tank in the dock.

7. Re-install the connector and turn clockwise to tighten it.

More information • Fluidics components (page 28)

• Refilling the sheath tank (page 471)

Performing the monthly clean procedure
Introduction This topic describes how to perform the monthly clean procedure. 

This procedure should be performed at least once per month. It can 
be performed more often if the system is heavily used or if any 
contamination is suspected.

Description The monthly clean procedure rinses the fluidics system with a 10% 
bleach solution, followed by another rinse with DI water and 
sheath fluid. The procedure takes about 20 minutes to complete.

Required materials • 2 mL of 10% bleach solution

• 3 mL of DI water

• 2 L of 10% bleach solution

Caution! All biological specimens and materials can transmit 
potentially fatal disease. To prevent exposure to biohazardous 
agents, expose waste container contents to bleach (10% of total 
volume) before disposal. Dispose of waste in accordance with 
local regulations. Use proper precautions and wear suitable 
protective clothing, eyewear, and gloves.
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• Sheath filter bypass assembly

• BD FACSFlow sheath fluid to fill the sheath tank (5 L or 10 L)

Procedure To perform the monthly clean procedure:

1. From the menu bar, select Cytometer > Monthly Clean.

The following dialog opens.

2. Load a tube with 2 mL of 10% bleach onto the manual tube 
port.

3. Fill a tank with 2 L of 10% bleach solution.

• We recommend using an extra tank dedicated for 10% 
bleach for this procedure. If you have this tank, remove the 
connector from the sheath tank and install it on the 
dedicated bleach tank.

• If you do not have a dedicated bleach tank, then empty the 
sheath fluid from the sheath tank and fill it with 10% 
bleach solution.

4. Empty the waste tank.

5. Remove the sheath filter and store it carefully for replacement 
at the end of this procedure. See Replacing the sheath filters 
(page 478) for a figure showing the details.

a. Open the door on the left side of the chassis.
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b. Disconnect the vent line on the top of the filter by 
unscrewing the connector nut.

c. Press the quick-disconnect tabs at the top and bottom of 
the filter and remove the filter from the chassis.

6. Install the sheath filter bypass assembly onto the two quick-
connects and the vent line connector. 

The bypass assembly is shown installed in the following figure.

7. Click Continue in the dialog to start the cleaning process.

A progress bar in the dialog shows the status of the process.

8. When the bleach cycle is done, remove the tube that contained 
bleach and replace it with a tube containing 3 mL of DI water.

9. Remove the bleach tank and connect the sheath tank.

• If you are using a dedicated bleach tank, disconnect it and 
install the connector on the sheath tank.

Caution! Installing the bypass assembly is a critical step. 
Failure to do this can damage the system.

Bypass assembly 
installed
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• If you are not using a dedicated bleach tank, empty any 
remaining bleach from the sheath tank, rinse it thoroughly 
with DI water, and refill it with sheath fluid.

10. Click Continue to continue the cleaning process.

A message is displayed when the process is complete, and the 
software records the time and date of the completed 
procedure.

11. Remove the bypass assembly and re-install the sheath filter. 

12. Select Cytometer > Fluidics > Purge Sheath Filter and run this 
command twice to remove any air bubbles that might have 
formed during the process.

More information • Fluidics components (page 28)

• Replacing the sheath filters (page 478)

Replacing the sheath filters
Introduction This topic describes how to replace the sheath filter on the side of 

the cytometer. It also describes how to replace the sheath supply-
line filter in the sheath tank. You should replace these filters every 
three months.

Required materials • 1 new sheath filter

• 1 new sheath supply-line filter

Replacing the 
sheath filter

To change the sheath filter:

1. From the menu bar, select Cytometer > Shutdown to turn off 
power to the cytometer. 

2. Open the door on the left side of the chassis.

You might have to move the fluidics tanks dock if it is 
positioned next to the cytometer.
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3. Disconnect the vent line on the top of the filter by unscrewing 
the connector nut.

4. Press the quick-disconnect tabs at the top and bottom of the 
filter and remove the filter from the chassis.

5. Discard the used filter.

6. Install a new filter assembly, with the flow arrow pointing up, 
by inserting each end into the connectors.

7. Reconnect the vent line on the top of the filter by screwing on 
the connector nut.

8. Select Cytometer > Fluidics > Purge Sheath Filter to bring 
sheath fluid into the new filter.

This process takes about one minute to complete. 

9. Repeat step 8 to fill the filter. 

You should see fluid in the vent line when it is done.

10. Close the door and resume normal operation.

11. Select Cytometer > Maintenance > Replace Sheath Filter.

Vent line

Vent line 
connector nut

Sheath filter
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12. Enter the information about the new filter, then click OK.

Replacing the 
sheath supply-line 
filter

The sheath supply-line filter is located inside the sheath tank in the 
tube that draws up the sheath fluid. 

To change the sheath supply-line filter:

1. Disconnect the connector from the sheath tank by turning it 
counter-clockwise.

2. Remove the base connector from the sheath tank by 
unscrewing it and pulling out the connector and supply-line 
assembly that includes the supply tube and the filter.

3. Place the connector and supply-line assembly on clean, lint-
free disposable towels so that you can work on it.

4. Twist open the supply-line filter holder and pull it apart to 
access the filter. See the following figure.

5. Remove the used filter and install a new filter.

6. Push the two halves of the filter holder back together and twist 
to close it.

7. Place the supply-line assembly back into the sheath tank and 
screw on the base connector until it is secure.

More information • Fluidics components (page 28)

• Refilling the sheath tank (page 471)

Supply-line filter holderBase connector
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Generating a system health report
Introduction This topic describes how to generate a system health report. This 

report is needed when contacting BD technical support for 
assistance.

About the system 
health report

The system health report consists of a text file containing the 
current status of the system. It also includes a ZIP file containing 
hardware and software configuration information and error logs 
that can be used that can be used by a BD technical support  
representative to analyze and troubleshoot the system.

Procedure To generate a system health report:

1. Select Cytometer > Maintenance > Generate System Health 
Report.

A dialog opens showing where the text and ZIP files are saved.

2. Open the text file to see the current information about the 
system.

More information • System technical support (page 16)
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Using the fluidics commands
Introduction The topic describes when to use the fluidics commands. They 

include Clean Cuvette, Drain and Fill Flow Cell, Purge Sheath 
Filter, and SIT Flush.

Command 
descriptions

Select Cytometer > Fluidics to access these commands.

More information • Replacing the sheath filters (page 478)

• Cleaning the manual tube port (page 483)

Command Description

Clean Cuvette Use this command to run cleaning solution through 
the flow cell. This action is also included during the 
shutdown process.

Drain and Fill 
Flow Cell

Use this command to remove persistent air bubbles 
from the flow cell. Place a tube of DI water on the 
manual tube port before starting this command.

Purge Sheath 
Filter

Use this command whenever you suspect air 
bubbles in the sheath path. 

This command is also executed twice after 
changing the sheath filter to fill the filter and 
remove air bubbles.

SIT Flush Use this command to clean the sample path by 
backflushing sheath fluid through the SIT. 

This command is also executed by default after 
each sample is acquired. The automatic SIT flush 
can be disabled by clearing the checkbox in the 
Acquisition Status panel.
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Cleaning the manual tube port
Introduction This topic describes the procedure for cleaning the manual tube 

port and the wash probe. 

Perform this action to keep the tube sensor from getting clogged 
due to sample collecting around the top of the manual tube port. 

Required materials • Lint-free, small-tipped cleaning swabs

• Lint-free tissues

• Cleaning solution (DI water, ethanol or bleach)

Procedure

To clean the manual tube port and the wash probe:

1. Remove any tubes from the manual tube port.

2. Use a lint-free, small-tipped cleaning swab dipped in DI water, 
ethanol, or bleach to clean the inner recessed area around the 
top of the manual tube port.

3. Use a lint-free tissue dipped in DI water, ethanol, or bleach to 
wipe down the exterior surface of the wash probe.

4. Dispose of all cleaning materials following biohazard 
precautions.

Caution! All biological specimens and materials can 
transmit potentially fatal disease. Use proper 
precautions and wear suitable protective clothing, 
eyewear, and gloves.

Manual tube port

Wash probe

Inner recessed area
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More information • Replacing the sheath filters (page 478)

• Replacing the sample line (page 485)

Preparing for long term shutdown
Introduction This topic describes how to prepare the cytometer for long term 

shutdown (one or more weeks).

Description The preparation process consists of running the monthly clean 
procedure and substituting DI water for sheath fluid near the end 
of the procedure.

Avoid storing a system filled with fluid in a location where it can 
encounter freezing temperatures. Fluid expansion due to freezing 
temperatures can damage fluidic components.

Procedure To prepare the cytometer:

1. Start the monthly clean procedure, see Performing the monthly 
clean procedure (page 475).

2. Stop when you reach the step that instructs you to refill the 
sheath tank with sheath fluid.

3. Instead, fill the sheath tank with DI water, then complete the 
procedure.

This will leave DI water in the system to prevent salt 
accumulation that can result if a sheath fluid-filled system is 
left idle for an extended period of time. 

4. Wipe down the exterior surfaces of the cytometer with a 10% 
bleach solution, then wipe it down again with DI water.

5. Dispose of all cleaning materials following biohazard 
precautions.
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More information • Maintenance overview (page 468)

Replacing the sample line
Introduction This topic describes how to remove the existing sample line, 

assemble the sample line for the flow cell, and re-install the new 
sample line. This procedure is required only if the sample line has 
become kinked from improper handling or clogged from running a 
sticky sample. 

If your system has a Flow Sensor, see Replacing the sample line in a 
system with a flow sensor (page 491).

Required materials • Replacement sample line

• Two plastic nuts, two lock rings, and two ferrules

• SIT length tool

• Lint-free tissue

Removing the 
existing sample 
line

To remove the existing sample line:

1. Turn off the power by pressing the Power button, then turn off 
the circuit breaker. 

Caution! All biological specimens and materials can 
transmit potentially fatal disease. To prevent exposure 
to biohazardous agents, use proper precautions and 
wear suitable protective clothing, eyewear, and gloves.
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2. Open the front door by pulling the grip area at the right side of 
the door.

3. Open the SIT door by using a Phillips screwdriver to release 
the SIT door interlock screw.

4. Remove the sample line from the SIT arm by unscrewing the 
nut and carefully pulling the nut and sample line out.

5. Remove the sample line from the bottom of the flow cell by 
unscrewing the nut and carefully pulling the nut and sample 
line out.

SIT door interlock screw

Grip area to open front door

Sample line

SIT arm

Nut

Flow cell

Nut

Sample line
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6. Discard the used sample line, nut, and fittings following 
biohazard precautions.

Assembling the 
new sample line

Handle the new sample line carefully and do not bend it at sharp 
angles or kink it. The interior of the line is fused silica and it will 
break internally if not handled correctly.

To assemble the new sample line:

1. Lay the new sample line on a clean surface.

2. Install a nut, lock ring, and ferrule on the sample line, as 
shown in the following figure.

The sample line has a label near the end of the line that goes to 
the flow cell. The other end of the line has a beveled cut, and 
that end must go to the SIT arm.

The tapered edge of the lock ring faces toward the ferrule.

Installing the 
sample line into the 
flow cell

During this process, you install the sample line into the bottom of 
the flow cell. This process establishes a critical junction between 
the flow cell and the sample line and must be performed carefully 
to ensure proper operation of the system. 

Flow Cell

Ferrule
Lock 
ring Nut

Label

To flow 
cell

Beveled end
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To install the new sample line into the flow cell:

1. Position the end of the sample line underneath the flow cell 
while holding it with both hands as shown in the following 
figure.

2. Slide the sample line up into the bottom of the flow cell until it 
contacts the inside surface, while holding the nut assembly 
with the other hand.

3. Slowly screw the nut up into the flow cell while holding the 
sample line steady against the inside surface.

4. Tighten the nut until it is securely seated in the flow cell.

As the nut is tightened, the ferrule is pushed into the lock ring. 
It is normal to feel extra resistance while turning the nut 
during this action. Once the nut is tightened, the lock ring and 
ferrule are bonded together into a single assembly and secured 
onto the sample line at a precise location. This action creates 
the proper seal between the flow cell and sample line.

5. Confirm that the sample line has been installed correctly by 
unscrewing the nut from the flow cell and visually inspecting 
the location of the lock ring and ferrule on the sample line.

The following figure shows a correct installation. Notice that 
the lock ring and ferrule are pressed together and the sample 
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line extends a short distance (approximately 1.5 mm) beyond 
the end of the ferrule.

6. Re-install the sample line by screwing the nut back into the 
flow cell until it is secure.

Installing the 
sample line into the 
SIT arm

During this process, you install the sample line into the SIT arm 
and down into the wash probe. This process sets the exact length 
of the sample line. This is a critical step for ensuring proper 
installation and minimizing dead volume in the sample tube. 

To install the sample line into the SIT arm:

1. Wipe off the wash probe with a lint-free tissue, then place the 
SIT length tool onto the manual tube port.

2. Install a nut, lock ring, and ferrule on the other end of the 
sample line, as shown in the following figure.

The tapered edge of the lock ring faces toward the ferrule.

Ferrule
Lock 
ringNut

Sample 
line

Beveled 
end to 
SIT arm



BD FACSVerse System Reference490

3. Slide the sample line (with the nut, lock ring, and ferrule in 
place) down into the threaded hole in the SIT arm.

4. Press the SIT arm down to its lowest position and hold it there, 
then slide the sample line down into the SIT length tool until it 
touches the bottom of the opening in the tool.

Pushing the sample line down too hard could displace the SIT 
length tool slightly. Make sure the SIT length tool is pushed all 
the way up into the manual tube port before proceeding to the 
next step.

5. Route the length of sample line to the left side of the SIT arm 
as it goes up towards the flow cell, so that it does not contact 
anything inside the chassis. 

This is especially important if the system has a Loader 
installed.

6. While holding the SIT arm down and the sample line in place, 
tighten the nut in the SIT arm hole until it is securely seated in 
the SIT arm.

Perform this action carefully so the sample line is installed in 
the correct position.

Sample line

Nut

SIT length tool

Location to 
press SIT arm 
down

SIT arm 
threaded hole



Chapter 15: Maintenance 491

7. Confirm that the sample line has been installed correctly by 
unscrewing the nut from the SIT arm and visually inspecting 
the location of the lock ring and ferrule on the sample line.

The following figure shows a correct installation. Notice that 
the lock ring and ferrule are pressed together.

8. Re-install the sample line by screwing the nut back into the SIT 
arm until it is secure.

9. Remove the SIT length tool from the manual tube port.

10. Close the SIT door and tighten the interlock screw, then close 
the front door.

More information • Cleaning the manual tube port (page 483)

• Running the daily clean procedure (page 469)

Replacing the sample line in a system with a flow 
sensor
Introduction This topic describes how to replace the sample line in a system that 

contains a BD Flow Sensor (the flow sensor). This procedure is 
required only if the sample line has become kinked from improper 
handling or clogged from running a sticky sample. 

The sample line is divided into lower and upper sections. The 
lower section is between the flow sensor and the SIT arm. The 
upper section is between the flow sensor and the flow cell. You 

Lock ring and ferrule 
pressed together
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should replace only the lower section to see if that solves the 
problem.

If you suspect a clog or kink in the upper sample line, contact your 
BD service representative. Do not attempt to replace the upper 
section of the sample line.

Required materials • Replacement sample line for the lower section (make sure to 
use a sample line labeled for use with a flow sensor)

• One plastic nut, lock ring, and ferrule

• One nut for the flow sensor

• SIT length tool

• Lint-free tissue

Location of upper 
and lower sections

The following figure shows the flow sensor and the upper and 
lower sections of the sample line.

Lower sample line

Upper sample line

Flow sensor
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Removing the 
lower sample line

To remove the lower sample line: 

1. Turn off the power by pressing the Power button, then turn off 
the circuit breaker. 

2. Open the front door by pulling the grip area at the right side of 
the door.

3. Open the SIT door by using a Phillips screwdriver to release 
the SIT door interlock screw.

4. Remove the lower sample line from the SIT arm by unscrewing 
the nut and carefully pulling the nut and sample line out.

Caution! All biological specimens and materials can 
transmit potentially fatal disease. To prevent exposure 
to biohazardous agents, use proper precautions and 
wear suitable protective clothing, eyewear, and gloves.

SIT door interlock screw

Grip area to open front door

Sample line

SIT arm

Nut
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5. Remove the lower sample line from the bottom of the flow 
sensor by unscrewing the nut and carefully pulling the nut and 
sample line out.

6. Discard the used sample line, nut, and fittings, following 
biohazard precautions.

Installing the lower 
sample line into the 
flow sensor

Handle the new sample line carefully and do not bend it at sharp 
angles or kink it. The interior of the line is fused silica and it will 
break internally if not handled correctly.

During this process you install the sample line into the bottom of 
the flow sensor. This process establishes a critical junction between 
the flow sensor and the sample line and must be performed 
carefully to ensure proper operation of the system. 

1. Lay the long piece of new sample line on a clean surface.

2. Install a black flow sensor nut on the sample line, as shown in 
the following figure.

The sample line has a label near the end of the line that goes to 
the flow sensor. The other end of the line has a beveled cut, 
and that end must go to the SIT arm.

Flow sensor 
nut

To flow sensor

Label
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3. Slide the sample line up into the bottom of the flow sensor 
until it contacts the inside surface, while holding the nut 
assembly with the other hand.

4. Slowly tighten the flow sensor nut while holding the sample 
line steady against the inside surface of the flow sensor.

5. Tighten the nut until it is securely seated in the flow sensor.

Installing the 
sample line into the 
SIT arm

During this process, you install the sample line into the SIT arm 
and down into the wash probe. This process sets the exact length 
of the sample line. This is a critical step for ensuring proper 
installation and minimizing dead volume in the sample tube. 

To install the sample line into the SIT arm:

1. Wipe off the wash probe with a lint-free tissue, then place the 
SIT length tool onto the manual tube port.

2. Install a nut, lock ring, and ferrule on the other end of the 
sample line, as shown in the following figure.

The tapered edge of the lock ring faces toward the ferrule.

Ferrule
Lock 
ringNut

Sample 
line

Beveled 
end to 
SIT arm
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3. Slide the sample line (with the nut, lock ring, and ferrule in 
place) down into the threaded hole in the SIT arm.

4. Press the SIT arm down to its lowest position and hold it there, 
then slide the sample line down into the SIT length tool until it 
touches the bottom of the opening in the tool.

Pushing the sample line down too hard could displace the SIT 
length tool slightly. Make sure the SIT length tool is pushed all 
the way up into the manual tube port before proceeding to the 
next step.

5. Route the length of sample line to the left side of the SIT arm 
as it goes up towards the flow cell, so that it does not contact 
anything inside the chassis. 

This is especially important if the system has a Loader 
installed.

6. While holding the SIT arm down and the sample line in place, 
tighten the nut in the SIT arm hole until it is securely seated in 
the SIT arm.

Perform this action carefully so the sample line is installed in 
the correct position.

Sample line

Nut

SIT length tool

Location to 
press SIT arm 
down

SIT arm 
threaded hole
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7. Confirm that the sample line has been installed correctly by 
unscrewing the nut from the SIT arm and visually inspecting 
the lock ring and ferrule on the sample line.

The following figure shows a correct installation. Notice that 
the lock ring and ferrule are pressed together.

8. Re-install the sample line by screwing the nut back into the SIT 
arm until it is secure.

9. Remove the SIT length tool from the manual tube port.

10. Close the SIT door and tighten the interlock screw, then close 
the front door.

More information • Cleaning the manual tube port (page 483)

• Running the daily clean procedure (page 469)

Lock ring and ferrule 
pressed together
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Managing your database
Introduction This topic describes the tasks involved in managing your database. 

The BD FACSuite Backup and Restore utility allows you to back 
up and restore your database. 

About the BD 
FACSVerse System 
Backup and Restore 
utility

Use the BD FACSuite Backup and Restore utility to back up or 
restore all data that is stored in the BD FACSuite database, along 
with all FCS files located in the application-defined directories. 

With this utility, you can create a single backup set which contains 
a backup of the database, along with experiment and worklist FCS 
files. The utility maintains backup sets indefinitely. It displays how 
much disk space each set is taking and how much disk space is left. 
You can discard existing backup sets to free up space.

Since the Experiment and Worklist workspaces save FCS files to 
different locations, these folders are handled separately when the 
backup is created.

You can also use any backup set to restore the BD FACSuite 
database and FCS files. When you restore, you erase any new data 
created since the backup was created.

Creating a new 
backup set

To create a new backup set:

1. Start the BD FACSuite Backup and Restore utility from the 
icon on the desktop. 

The BD FACSuite Backup and Restore window opens. 

2. Click Back Up. 

The Back Up window opens, indicating the required hard disk 
space. If the estimated space required is greater than the 
amount available, the software prompts you to free up 
additional space and try again.

3. Verify that adequate hard disk space is available and click 
Back Up. 



Chapter 15: Maintenance 499

The backup process starts and displays a progress bar. A 
completion dialog is displayed and indicates success or failure. 
If the backup succeeds, the timestamp of the new backup is 
provided. If the backup fails, the reason is indicated. 

4. Click Finish to close the window. 

Restoring a backup 
set

To restore a backup set:

1. Click the BD FACSuite Backup and Restore utility icon on the 
desktop. 

The BD FACSuite Backup and Restore window opens. 

2. Select the backup set to restore. 

3. Click Restore. 

The Restore window opens, indicating the timestamp of the 
selected backup set and the required disk space. If the 
estimated space required is greater than the amount available, 
the system prompts you to free up additional space and try 
again.

The estimated space required takes into account the files that 
will be removed during the process, and it is possible that this 
number could be negative. In that case, 0 KB is used.

4. Click Restore. 

A confirmation dialog is displayed. 

5. Click OK. 

The restore process begins and displays a progress bar. A 
completion dialog is displayed and indicates success or failure. 

6. Click Finish to close the window. 
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Deleting a backup 
set

To delete a backup set:

1. Click the BD FACSuite Backup and Restore utility icon on the 
desktop. 

The BD FACSuite Backup and Restore window opens. 

2. Select the backup set to delete. 

3. Click Delete. 

A confirmation dialog is displayed to verify that the selected 
backup set needs to be deleted. 

4. Click OK.

Changing settings To change settings:

1. Click the BD FACSuite Backup and Restore utility icon on the 
desktop. 

The BD FACSuite Backup and Restore window opens. 

2. Click Change Settings. 

The Settings window opens. 

3. Click Browse and navigate to the backup directory. 

The Browse for folder dialog opens. 

4. In the Browse for folder dialog, click OK. 

The Backup Directory value is updated to the selected 
location.

5. In the Settings window, click OK. 

The changes are saved and the window closes. 

More information • Maintenance overview (page 468)
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BD FACS Universal Loader

This section includes the following topics:

• BD FACS Universal Loader overview (page 502)

• Sample carrier specifications (page 505)

• Placing carriers into the Loader (page 506)

• Defining custom sample carrier layouts (page 508)

• About mixing settings (page 512)

• Selecting custom mixing settings (page 513)

• Cleaning the Loader (page 515)

• Barcode label specifications (page 516)
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BD FACS Universal Loader overview
Introduction This topic gives an overview of the components of the BD FACS 

Universal Loader (the Loader). 

About the Loader The Loader is an optional automated loading system that mixes 
samples and delivers tube racks and plates to the BD FACSVerse 
cytometer for acquisition. The Loader can be included as an option 
on a new system or it can be ordered and installed at a later time 
by a BD field service engineer.

External 
components

The following figure shows the location of the Loader’s external 
components.

Eject 
button

Cover

LoaderStatus indicator
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Status indicator The status indicator uses illumination and color to show the status 
of the Loader.

Eject button The Eject button should be used if there is a problem during 
operation. Pressing this button stops acquisition and moves the 
carrier out to the loading position. 

Internal 
components

The following figure shows the location of the internal 
components.

Condition Status

Off Ready to operate

Note: If main power to the system is off, this 
indicator is off.

Blue Cover is locked and system is running

Blinking blue Loading or unloading

Red Error condition

Carrier nest

Carrier 
release lever

A1 location Gripper mechanism
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Overhead imaging 
system

The Loader has an internal overhead imaging system that can 
detect:

• The presence and location of tubes in racks

• The correct type and orientation of carriers

• Lids on plates

Only compatible carriers can be used for this system to work.

Recommendations 
for using the 
Loader 

Follow these recommendations to ensure that the Loader operates 
correctly.

• Do not use any tubes, racks, or plates that are not listed as 
compatible carriers. See Sample carrier specifications 
(page 505).

• Do not use black plates.

• Keep the top surface of tube racks clean so that the camera 
imaging system works properly.

• Inspect the flange, upper lip, and barcode label on all tube 
racks for signs of wear and replace it if excess wear is found. 
See Placing carriers into the Loader (page 506).

• Inspect the numbers on the top surface of tube racks to make 
sure they are legible and not faded.

• Keep all barcode labels clean and dry.

• Do not use CONTRAD® detergents for any cleaning 
procedures when using the Loader.

• Do not autoclave tube racks.

More information • Worklist overview (page 222)
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Sample carrier specifications
Introduction This topic describes the types of sample carriers (tube racks and 

plates) that are compatible with the Loader.

Carrier type 
compatibility

The following tables list the carrier types that are compatible with 
the Loader. The tube racks are available only from BD. 

For information on part numbers and additional details on 
compatible carriers, see the BD FACSVerse section of the 
BD Biosciences website.

The minimum and maximum volumes for tubes and wells are 
shown. Volumes below the minimum may need additional mixing 
to resuspend the sample. Using volumes above the maximum could 
result in cross-contamination and spillage during mixing.

Carrier type for tubesa

a. For polystyrene, polypropylene, and BD Trucount tubes.

Recommended 
minimum 

volume (µL)
Maximum 

volume (µL)

30-tube rack (12 x 75 mm) 100 2,000

40-tube rack (12 x 75 mm) 100 2,000

Carrier type for plates
Bottom 
geometry Materiala

Recommended 
minimum 

volume (µL)
Maximum 

volume (µL)

BD 96 standard height Round PS 55 200

BD 96 standard height Flat PS 55 200

BD 96 standard height Round PP 55 200

BD 96 standard height Conical PP 55 200

384 standard height Flat PS 40 75

96 half deep Conical PP 55 500
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Barcode reading The system can read barcodes on plates, tube racks, and individual 
tubes in 30-tube racks. To confirm the identification and correct 
location of tubes in racks, the barcodes must first be entered into a 
worklist with the handheld barcode reader or entered manually. 
Then the readers in the Loader can confirm that the correct 
barcode has been recognized.

Placing carriers into the Loader
Introduction This topic describes how to place sample carriers into the Loader.

Before you begin Confirm that the carrier type you are using is compatible with the 
Loader. See Carrier type compatibility (page 505).

Procedure To place a carrier into the Loader:

1. Open the cover.

2. Push the carrier release lever toward the back and hold it open. 

3. Install the carrier into the carrier nest with the carrier centered 
on the nest, then release the lever as you continue to hold the 
carrier centered.

This is especially important with heavier carriers such as tube 
racks, deep-well plates, and matrix tube racks. Make sure that 

96 deep Conical PP 55 1,000

96 matrix tube rack N/A N/A 55 700

96 filter bottom Filter PP 150 200

a. PS = polystyrene, PP = polypropylene

Carrier type for plates
Bottom 
geometry Materiala

Recommended 
minimum 

volume (µL)
Maximum 

volume (µL)
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the flange along the perimeter of the carrier is held securely in 
the gripper mechanisms, as shown in the following figure.

The following figure shows a tube rack loaded onto the nest.

More information • Sample carrier specifications (page 505)

Gripper 
mechanism

Flange
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Defining custom sample carrier layouts 
Introduction This topic describes how to define custom sample carrier layouts 

for a worklist. This applies only to systems that include the Loader 
option. 

Custom layouts are saved with a worklist. You need to perform 
this procedure only if you want to define a layout different from 
the default. The default is set as a preference in the Preferences 
dialog.

Defining a plate 
layout

To define a plate layout:

1. Create a new worklist or open an existing worklist.

2. Navigate to the Loading Options panel.

3. Select a carrier type. For example, 96 Well Plate Standard flat 
bottom.

4. In the Layout View panel, right-click a tube or well and select 
Display Properties.

The Plate Properties dialog opens.

5. (Optional) In the General tab, click to select the location of the 
plate notches to set the plate orientation at the Loader.
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This setting is only required if you are using a plate that is not 
on the list of BD-qualified plates. 

6. (Optional) To read the plate barcode label during loading, 
select the Read Plate Bar Code Label checkbox.

7. Under Plate Layout, click the arrow and select a linear 
horizontal, linear vertical, serpentine horizontal, or serpentine 
vertical layout.

8. (Optional) Make the following selections:

• If you do not want to include the wells on the horizontal or 
vertical edges, select the Don’t use edge positions checkbox. 

• Select the number of empty positions in the layout between 
each well.

• Select the number of empty positions in the layout between 
worklist entries.

9. (Optional) If you want to apply these settings to multiple 
plates:

a. Click Apply settings to multiple carriers.
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b. Select the Apply to all carriers in list checkbox or select 
specific carriers in the list.

10. Click Apply Settings.

Defining a tube 
rack layout

To define a tube rack layout:

1. In the Loading Options panel, in the Carrier Type field, click 
and select a tube rack type. For example, 40 Tube Rack.

2. In the Tray Layout panel, right-click a tube and select Display 
Properties.

The Rack Properties dialog opens.

3. (Optional) To read the rack barcode label during loading, 
select the Read Rack Bar Code Label checkbox.



Chapter 16: BD FACS Universal Loader 511

4. Under Rack Layout, click the arrow and select a linear 
horizontal, linear vertical, serpentine horizontal, or serpentine 
vertical layout.

5. (Optional) Make the following selections:

• If you do not want to include the tubes on the horizontal or 
vertical edges, select the Don’t use edge positions checkbox. 

• Select the number of empty positions in the layout between 
each tube.

• Select the number of empty positions in the layout between 
worklist entries.

6. (Optional) If you want to apply these settings to multiple 
racks:

a. Click Apply settings to multiple carriers.

b. Select the Apply to all carriers in list checkbox or select 
specific carriers in the list.

7. Click Apply Settings.
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About mixing settings
Introduction This topic describes the mixing settings for systems equipped with 

the Loader. 

Types of mixing 
settings

You can set two types of mixing settings:

• Initial mixing. The first mix that happens when the carrier is 
run. The initial mixing setting is designed to resuspend the 
samples, even if they have been sitting overnight. Because of 
this, the initial mix is more aggressive than the interim mix.

• Interim mixing. Any subsequent mixes that are defined by time 
or interval.

Mix settings 
specifications

For information on mixing specifications and ranges for 
compatible carriers, see the BD FACSVerse section of the 
BD Biosciences website.

More information • Selecting custom mixing settings (page 513)

• Sample carrier specifications (page 505)
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Selecting custom mixing settings
Introduction This topic describes how to select custom mixing settings. 

Procedure Default mixing preferences are set in the Preferences dialog. You 
can specify custom mixing settings using the Rack Properties or 
Plate Properties dialog in the Worklist workspace.

To select custom mixing settings:

1. In the Rack Properties or Plate Properties dialog, click the 
Mixing tab.

2. Under Initial Mixing, select the Initial Mixing checkbox to 
enable initial mixing.

3. Set a custom mixing duration in the Duration (sec) field.

4. Set a custom mixing intensity in the Intensity (rpm) field.
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5. Under Interim Mixing, select the Interim Mixing checkbox to 
enable interim mixing.

6. Select a time or interval-based interim mixing type.

• If you select Time, then set a time interval between mixes in 
the Interval (sec) field.

• If you select Interval, then set a tube or well interval in the 
Interval (tubes or wells) field.

7. Set a custom interim mixing duration in the Duration (sec) 
field.

8. Set a custom interim mixing intensity in the Intensity (rpm) 
field.

9. (Optional) If you want to apply these settings to multiple 
racks:

a. Click Apply settings to multiple carriers.

b. Select the Apply to all carriers in list checkbox or select 
specific carriers in the list.

10. Click Apply Settings.

More information • About mixing settings (page 512)



Chapter 16: BD FACS Universal Loader 515

Cleaning the Loader
Introduction This topic describes how to clean the Loader. It is a good practice 

to perform this cleaning daily.

Required materials • 10% bleach solution in a squirt-type bottle

• DI water

• Disposable towels or wipes.

Caution

Procedure To clean the Loader:

1. Apply the 10% bleach solution to a disposable towel, then 
wipe down the following areas:

• Top surface of the carrier nest

• Inside surfaces of the cover

• Outside surfaces of the cover

• Outside surfaces of the Loader chassis

2. Use the DI water on the same areas to remove the bleach, then 
wipe them dry with a towel.

3. Dispose of used cleaning materials following biohazard 
precautions.

For any major spills of liquids down into the interior of the Loader, 
contact BD technical support.

Caution! Do not use a spray bottle to spray the 10% bleach 
solution because the mist can get into areas that can cause 
problems. Instead, use a squirt-type (squeeze) bottle to distribute 
the solution.

Caution! All biological specimens and materials can transmit 
potentially fatal disease. Use proper precautions and wear 
suitable protective clothing, eye wear, and gloves. Dispose of 
waste in accordance with local regulations. 
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More information • Performing manual system shutdown (page 113) 

Barcode label specifications
Introduction This topic describes the specifications for barcode labels for tubes, 

tube racks, and plates.

Tube label 
specifications

The following table lists the details for barcode labels that are used 
on tubes.

Specification Description

Supported symbologies (types) Code 128, Code 39, Codabar, Interleaved 2 of 5

You do not need to specify the type of symbols 
for labels on tubes. The barcode reader can sense 
differences automatically.

Narrow element (width of the narrowest 
bar in a label)

10 mil (0.25 mm, 0.01 in.) or greater

Dimensions a - Max label length: 44.45 mm (1.75 in.) This 
length should include the barcode symbol and 
quiet zone.

b - Max label height: Cannot exceed 10 mm more 
than the circumference of the tube.

c - Max symbol length: 37.45 mm (1.47 in.)

d - Minimum symbol height: 19.05 mm 
(0.75 in.). We recommend the maximum symbol 
height possible because this makes it easier to 
orient tubes within a rack. 

e - Minimum quiet zone: 3.5 mm (0.14 in.) at 
each end of the symbol.

Human readable f - Size and placement of the human readable to 
be determined by the user.

0001
f

a
c

d bee



Chapter 16: BD FACS Universal Loader 517

Tube rack loading 
requirements

Tubes in the 30-tube rack are arranged in a staggered 
configuration, providing a direct line of sight between tube 
barcode readers in the Loader and tube labels (tube barcode 
scanning is not available using the 40-tube rack). See the following 
figure.

Barcode labeled tubes in a rack should be oriented so that the 
labels on tubes in rows A and B are facing the long side of the tube 
rack between A1 and A8. The labels on tubes in rows C and D are 
facing the long side of the tube rack between D1 and D8, as shown 
in the following figure. 

Label thickness Thickness of label and adhesive not to exceed 3.9 
mil. (0.099 mm, 0.0039 in.)

Finish Print labels on material with a matte finish.

Placement of label on tube The label must be placed a minimum of 12 mm 
(0.47 in.) from the bottom of the tube. The label 
must be placed so the bars are perpendicular to 
the length of the body of the tube. 

Specification Description



BD FACSVerse System Reference518

Slots on the top surface of the rack can be used to help orient tubes 
in rows C and D. 

Row A

A1 A8

Slots to view 
tubes

D1 D8

Row B

Row C

Row D
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Plate label 
specifications

The following table lists the details for barcode labels that are used 
on plates.

Specification Description

Supported symbologies (types) Code 128, Code 39, Codabar, Interleaved 
2 of 5

You do not need to specify the type of 
symbol for labels on plates. The barcode 
reader can sense symbols automatically.

Narrow element (width of the narrowest 
bar in a label)

10 mil (0.25 mm, 0.01 in.) or greater

Dimensions a - Max label length: 47.63 mm (1.88 in.). 
This length should include the barcode 
symbol and quiet zone.

b - Label height: 6.35 mm (0.25 in.)

c - Max symbol length: 40.63 mm (1.60 
in.) without human readable value. 

d - Symbol height: 6.35 mm (0.25 in.). The 
symbol should bleed off the bottom and 
top of the label because this increases the 
likelihood of the label being decoded. 

e - Quiet zone: 3.5 mm (0.14 in.) at each 
end of the symbol

Human readable f - Size and placement of human readable 
to be determined by the user

Label thickness Thickness of label and adhesive not to 
exceed 3.9 mil. (0.099 mm, 0.0039 in.)

Finish Print labels on material with a matte finish.

0001

f

a
c

e e b,d



BD FACSVerse System Reference520

Placement of label 
on plate

The label should be placed on the side wall of the plate along the 
short side of the plate between A1 and H1/P1.

The bottom edge of the label must be placed directly above the 
plate flange. Use this edge to guide placement of the label.

The label must be placed so that the bars are perpendicular the 
plate flange. 

Label 
recommendations

Observe these recommendations for optimal performance.

• Labels must be clean and not yellowed.

• Use labels prior to expiration date.

• Label must not have defects such as spots, lines, missing 
sections, cuts, folds, or density problems.

• Bars must be well defined and bar edges must not be irregular.

Barcode error rate 
guidelines

• Code 128 and 39 are more accurate and have lower error rates 
than Codabar and Interleaved 2 of 5.

• CLSI recommends Code 128 because of its accuracy, compact 
form, and self-checking capabilities.

• A checksum greatly increases accuracy. If possible, use a 
checksum with Codabar and Interleaved 2 of 5 because they 
are less accurate symbologies. 

• If available, select the fixed length option since this is more 
accurate than variable length.

Placement of label 
on side wall

A1

H1

0001

Plate flange
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More information • Barcode reading (page 506)
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BD FACSVerse system options

This section includes the following topics:

• BD FACSVerse system options overview (page 524)

• About the BD Flow Sensor option (page 525)

• Using the BD Flow Sensor (page 526)

• Using an expression for volumetric measurement (page 528)

• Using the handheld barcode reader (page 531)

• Fluidics tank options (page 532)

• Using BD Assurity Linc software (page 534)
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BD FACSVerse system options overview
Introduction This topic lists the available options and upgrades for the 

BD FACSVerse system.

About options System options and upgrades described in this section have been 
validated and qualified for use with the BD FACSVerse system. If 
you plan to use other third-party hardware (for example, venting 
hood, or handlers) or software (for example, analysis software) 
that is not included in this list, you are responsible for validating 
the system and verifying the results.

Options The following table lists available options and upgrades.

Category Option For more information

System 
hardware

BD FACS Universal
Loader

See BD FACS Universal Loader overview 
(page 502).

Handheld barcode 
reader

See Using the handheld barcode reader 
(page 531).

BD Flow Sensor See About the BD Flow Sensor option 
(page 525).

Optics Laser upgrades Contact your BD representative.

Fluidics Large fluidics tanks 
(10-L capacity)

See Fluidics tank options (page 532).

BD FACSFlow 
cubitainer adapter

See Installing a cubitainer adapter (page 533).

Applications 
and assays

FCAP Array version 
3.0 software

See documentation included with FCAP Array 
software.

BD Assurity Linc 
software

See Using BD Assurity Linc software 
(page 534).

BD assays Contact your BD representative for a current 
list of available BD assays.
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About the BD Flow Sensor option
Introduction This topic describes the BD Flow Sensor option and how it 

measures flow volume.

The Flow Sensor is intended for Research Use Only (RUO). Not 
for use in diagnostic or therapeutic procedures.

About volumetric 
measurement

Volumetric measurement is performed by the optional Flow Sensor 
installed in the sample flow line. The Flow Sensor provides quick 
and accurate volume measurements for determining cell counts in a 
sample at medium and high flow rates.

The Flow Sensor works by adding a minimal amount of heat at a 
specific point along the flow path. The sample temperature is 
measured at the beginning and end of the flow path. The 
temperature difference is used to calculate the volumetric flow rate. 
The total volume appears in the software as a keyword. 

The following figure shows the location of the Flow Sensor.

Flow Sensor

Sample line

Sample line
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Volumetric 
measurement 
conditions

For proper reading, the Flow Sensor should be used only with the 
medium and high flow rates. 

More information • Using the BD Flow Sensor (page 526)

• Using an expression for volumetric measurement (page 528)

Using the BD Flow Sensor
Introduction This topic describes how to use the BD Flow Sensor on the 

BD FACSVerse system. The Flow Sensor works with any research 
application.

Setup No setup is necessary. When purchased with the cytometer, the 
Flow Sensor comes installed on the instrument. If the Flow Sensor 
is purchased after the cytometer, a BD service representative 
installs it.

The Flow Sensor turns on when the cytometer is on and 
automatically turns off when the cytometer is shut down. No 
adjustments to the Flow Sensor are necessary. The volume is 
automatically reported as a keyword for all acquisitions.

About sample flow 
rates

We recommend running samples at a high flow rate when using the 
Flow Sensor. The flow rate can be changed in the Acquisition 
Status panel before acquisition.

Reading the sample 
volume

To read the sample volume after data acquisition:

1. Right-click a tube and select Properties.

2. Click the Keywords tab and select the Show System Defined 
checkbox to see all keywords. 
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The volume is reported as a value (nL/min) next to the Sample 
Volume Acquired keyword.

If the value is NA, you might need to adjust the flow rate or 
decrease the viscosity of the sample before re-acquiring the 
sample. Flow issues such as air bubbles, clogs, or a low sample 
volume may result in an NA value.

You can add the Sample Volume Acquired keyword to 
statistics views so you don’t have to open the Tube Properties 
dialog to read the volume.

More information • About the BD Flow Sensor option (page 525)

• Using an expression for volumetric measurement (page 528)

• Adding keywords to statistics views (page 411)
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Using an expression for volumetric measurement
Introduction This topic describes how to create an expression to display 

volumetric measurement data. Volumetric measurement uses a 
standard keyword to generate this data.

Procedure To build expression formulas from results:

1. In a worksheet, click Create Expression on the Worksheet 
toolbar.

2. Click in the worksheet to create a new blank expression.

The Expression Properties dialog opens.

3. In the Expression Properties dialog, click Search Results.
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4. In the Results tree, select Populations > Tube_0x > Keywords > 
Default > Sample Volume Acquired (VOL).

The selected result is displayed in the Formula box above the 
search results. The calculated expression is displayed in the 
worksheet.

5. Click the Search Results arrow to display the expression 
details.

6. In the Name field, specify a name for the expression. 

The name must be unique within an experiment. 
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7. (Optional) Make entries in the Prefix or Suffix fields to create 
a displayed name for the expression.

8. Specify the decimal place display in the Decimal Places Shown 
field.

9. Under Comments, add any comments that describe the 
expression.

10. Close the Expression Properties dialog to save the expression.

More information • About the BD Flow Sensor option (page 525)

• Using the BD Flow Sensor (page 526)

• Expressions overview (page 420)

Example of the new expression
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Using the handheld barcode reader
Introduction This topic describes the optional handheld barcode reader. See the 

manufacturer’s documentation for details on safety and how to use 
the reader.

Description The handheld barcode reader plugs into the USB port on the 
computer workstation. 

The barcode reader reads most current barcode standards. See the 
manufacturer’s documentation for the complete list of standards.

When to use the 
reader

You can use the reader to scan the following labels when using 
BD FACSVerse system.

• Lot file labels on a CS&T bead vial

• Sample ID label on a sample tube

• ID label on a 30- or 40-tube rack

• ID label on a well plate

More information • Barcode label specifications (page 516)

Scan window

Scan trigger

LED indicators



BD FACSVerse System Reference532

Fluidics tank options
Introduction This topic describes the fluidics tank options for the system. These 

include the large volume sheath and waste tanks and the cubitainer 
adapter. The large volume tanks give you extended running times 
for the system.

Large volume 
fluidics tanks

The large volume fluidics tanks have a 10-L capacity and are 
available as an option to replace the standard tanks. The large 
volume tanks use the same connectors as the standard tanks and 
are normally placed on the floor near the cytometer.

The sheath and waste tanks must be placed at a level even with, or 
below, the cytometer. Placing the tanks higher than the cytometer 
can cause uncontrolled siphoning.

Installing large 
volume fluidics 
tanks

You can switch from a standard tank to a large tank by removing 
the connector base assembly from the standard tank and installing 
it on the large tank.

To install a large volume tank: 

1. Disconnect the connector from the standard tank.

2. Unscrew the connector base assembly from the standard tank.

Large volume 
waste tank

Large volume 
sheath tank

Connector 
base assembly
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3. Install the connector base assembly into the large tank and 
screw it in until it is secure.

4. Re-install the connector from the cytometer into the large tank 
and turn it to secure it.

Installing a 
cubitainer adapter

The cubitainer adapter can be installed on a BD FACSFlow 
cubitainer to serve as a higher volume sheath tank. 

The adapter can only be used for sheath fluid. It cannot be used on 
an empty cubitainer for waste.

To install a cubitainer adapter:

1. Remove the cap from a cubitainer.

2. Insert the adapter assembly into the opening in the cubitainer.

3. Screw the adapter onto the cubitainer.

4. Install the sheath line connector from the cytometer onto the 
adapter and turn it one-quarter turn to secure it.

Cap (inside)

Cap side view with sheath line

Supply-line filter holder
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Using BD Assurity Linc software
Introduction This topic describes how to establish a remote session with a BD 

technical representative using BD Assurity Linc software.

About BD Assurity 
Linc software

BD Assurity Linc is a highly secure remote systems management 
service that connects BD instruments to BD technical support 
personnel. Using the BD Assurity Linc Agent, BD support 
personnel can securely access your workstation through an 
enterprise server and diagnose problems remotely. You must grant 
access to the instrument to enable this remote diagnostics feature.

Description of 
functionality

BD Assurity Linc can continually monitor the health of your 
instrument and automatically communicate any changes to the BD 
Technical Support Server. When problems or questions arise, key 
data is already available for diagnosis by BD, which can speed up 
troubleshooting efforts.

With your explicit authorization, the BD support representative 
can see what you see on-screen, and in many cases, can make 
adjustments or suggestions that prevent downtime and the need for 
a service call.

When an on-site visit is needed from a BD Field Service or 
Technical Applications Support engineer, the system logs and 
alarms can be checked before they leave the BD office, helping to 
ensure that the right personnel and the right parts are dispatched to 
your site.

Procedure To grant access to a BD technical support representative:

1. Ensure that your workstation is connected to the internet.

2. Contact your local BD technical support representative.

If a remote session is required, the BD representative will 
initiate a session through a secure link.

A dialog opens once the connection is established.
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3. Acknowledge the request. 

The BD representative can now assist you.

More information • Generating a system health report (page 481)

• Setting administration preferences (page 50)
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Cytometer configurations

This section includes the following topics:

• Laser and detector configurations (page 538)

• Creating a new optical configuration (page 540)

• Creating reference settings for a new configuration (page 541)

• Working with configuration reports (page 543)
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Laser and detector configurations 
Introduction This topic describes the laser and detector configurations that are 

available and the optics and intended fluorochromes for each laser. 

Description There are two types of cytometer configurations: BD-defined and 
user-defined. The BD-defined configurations are based on the 
actual hardware components, including lasers and optics, that are 
installed on the system. The possible configurations are:

• 1-Laser (blue), 4-color (4-0-0)

• 2-Laser (blue, red), 6-color (4-2-0)

• 3-Laser (blue, red, violet), 8-color (4-2-2)

User-defined configurations are created when you install a new 
BD-approved filter holder. The system recognizes the new holder 
and automatically creates a new user-defined configuration. Only 
Administrators can create and manage user-defined configurations. 

Default detector 
array setup

The following table shows the default setup for the detector arrays.

Laser
Wavelength 
(nm) Detector Mirror Filter

Intended 
fluorochromes

Blue 488 A 752 783/56 PE-Cy7

B 665 700/54 PerCP-Cy5.5, 
PerCP, 7-AAD

C 605 Blank N/A

D 560 586/42 PE, Propidium 
Iodide

E 507 527/32 FITC, Alexa 
Fluor® 488

F N/A 488/15a SSC
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More information • Cytometer overview (page 23)

• Creating a new optical configuration (page 540)

Red 640 A 752 783/56 APC-Cy7, 
APC-H7

B 660/10 660/10 APC, 
AlexaFluor® 
647

C Blank Blank N/A

Violet 405 A 500 528/45 V500, AmCyan, 
Pacific Orange™

B 448/45 448/45 V450, 
Pacific Blue™

a. There is a 10% neutral density filter installed in front of the SSC filter.

Laser
Wavelength 
(nm) Detector Mirror Filter

Intended 
fluorochromes
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Creating a new optical configuration
Introduction This topic describes how to create a new optical configuration.

About creating 
configurations

You can create a new optical configuration by removing one of the 
existing filter holders from a heptagon and replacing it with an 
optional BD-approved filter holder. You must have administrator 
permissions to create new configurations.

Creating a new 
configuration

To create a new optical configuration:

1. In the Setup & QC workspace, click the Configurations tab.

2. Open the front door to access the heptagon detectors.

3. Remove the filter holder that you want to replace by pulling 
the holder out of the heptagon.

See the figure in Optical components (page 26).

4. Install a BD-approved filter holder by inserting it into the 
empty position in the heptagon.

The software creates a new configuration.

5. Close the front door.

6. Add the new fluorochromes to the fluorochrome list in the 
Configuration tab if necessary.

7. Assign the new fluorochrome to the correct detector by 
selecting the name from the fluorochrome list at the right and 
dragging it into the correct detector list.

The configuration is displayed in the list on the left under User 
configurations. Icons are displayed indicating that 
characterization QC and Reference Settings have not been 
performed for this configuration.

8. Select the Setup & QC tab and select the Characterization QC 
task, then follow the software prompts. 

See Running characterization QC (page 83).



Chapter 18: Cytometer configurations 541

9. Select the Performance QC task and follow the software 
prompts.

10. Create reference settings for the new configuration. 

See Creating reference settings for a new configuration 
(page 541).

Restoring the 
original 
configuration

To restore the original configuration:

1. Remove the new filter holder from the heptagon.

2. Install the original filter holder in the heptagon. 

The system detects the original holder and restores the 
configuration.

More information • Laser and detector configurations (page 538)

• Cytometer overview (page 23)

Creating reference settings for a new 
configuration
Introduction This topic describes how to create LW/LNW reference settings 

after you have created a new optical configuration.

Before you begin Prepare the FC beads single-color controls according to the 
instructions in the technical data sheet. Make sure the kit 
information is entered into the FC Bead reagent section in the 
library.

Procedure To create LW/LNW reference settings:

1. Log in to the software as Administrator.

2. Select the Setup & QC tab.
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3. In the Task menu select Create LW/LNW Reference Settings.

The Create LW/LNW Reference Settings task is only available 
to administrators after a new configuration has been created.

4. Select the correct lot IDs for the CS&T beads and the FC bead 
kits.

5. Click Start, follow all software prompts, and load the correct 
bead tube as required.

Progress is indicated in the Setup Tasks panel as shown in the 
following figure.

6. Click OK in the confirmation dialog.

Note that if the new fluorochrome has been added to the Blue 
detector array in position B when LW/LNW Reference Settings 
are created, only LW reference settings are created. LNW 
reference settings use PerCP, detector B, as the primary 
threshold. Since this PerCP will not be added to detector B for 
use with the new filter/mirror pair, the software cannot set the 
threshold required for LNW. 
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Working with configuration reports
Introduction This topic describes how to use the Configuration tab to view 

optical configurations, modify the display, and view configuration 
reports.

Viewing a 
configuration

To view the configuration:

1. In the Setup & QC workspace, click the Configurations tab.

The Configurations tab includes the following panels and 
dialogs:

– Configurations. This panel lists the current cytometer 
optical configuration and any user-defined configurations.

– Configuration Detail. This panel displays the optical 
configuration and shows the assigned detectors and 
fluorochromes.

– Fluorochromes. This panel lists the available 
fluorochromes. You can select fluorochromes from this list. 
This is for administrators only, not available to operators.

– Filters and Mirrors. This panel lists the filters and mirrors 
available in the system. This is for administrators only, not 
available to operators.
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Zooming in on a 
configuration

To zoom in on the Configuration Detail panel:

1. Double-click a heptagon to zoom in on it.

2. Click Return to Overview to return to the default size.

Adding comments 
to a configuration 
report

To add comments to a configuration report:

1. Click Comments on the Configuration Detail toolbar.

The Comments dialog opens.

2. In the Comments field, type a comment (up to 300 characters). 

3. Click Save to save your comment and close the dialog.

The comment is saved to the report. It cannot be modified or 
deleted.
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Viewing a 
cytometer 
configuration 
report

To view a cytometer configuration report:

1. In the Configuration Detail panel, click View Report.

The Report Preview dialog opens and displays the current 
configuration report.

2. To zoom the report in or out, use the slider at the bottom right 
of the dialog.

Selecting the 
number of lasers 
per page

To select the number of lasers to show on each page of the report:

1. Open a report in the Configuration Detail panel.

2. On the Report Preview toolbar, click in the Number of Lasers 
Per Page field and select 1, 2, or 3.

The report displays the selected number of lasers on each page 
of the report.

Zoom 
slider
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Exporting a report To export a report:

1. Open a report in the Configuration Detail panel.

2. On the Report Preview toolbar, click Export.

The Save As dialog opens.

3. Type a name for the file you want to export. 

4. Navigate to the target folder, then click Save.

The report is saved in PDF format.

More information • Laser and detector configurations (page 538)

• Creating a new optical configuration (page 540)
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BD FACSVerse technical specifications

This section includes the following topics:

• Optical specifications (page 548)

• Performance specifications (page 550)

• Fluidics specifications (page 551)

• Sample input formats (page 552)

• Electronics and software specifications (page 553)

• Physical specifications (page 553)
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Technical specifications
Optical 
specifications Parameter Value

Excitation optics

Excitation optical 
platform

Possible system configurations:

 1-Laser (blue), 4-color (4-0-0)

 2-Laser (blue, red), 6-color (4-2-0)

 3-Laser (blue, red, violet), 8-color (4-2-2)

Laser specifications Blue laser

 Wavelength: 488 nm

 Optical power: 20 mW

 Beam spot size: 9 µm x 63 µm

Red laser

 Wavelength: 640 nm

 Optical power: 40 mW

 Beam spot size: 9 µm x 63 µm

Violet laser

 Wavelength: 405 nm

 Optical power: 40 mW

 Beam spot size: 9 µm x 63 µm

Laser alignment Fixed, with auto-alignment on demand

Emission optics

Forward scatter 
detection

 Si-photodiode with built-in 488/10 band 
pass filter
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Fluorescence and 
side scatter 
detection

 Reflective optics with single transmission 
bandpass filter in front of each PMT

 High performance customized PMT 
modules for all fluorescence and SSC 
channels

 Light collected by objective lens is delivered 
by fiber optics to specially designed 
Heptagon detector arrays

 The cuvette flow cell is gel-coupled by 
refractive index-matching optical gel to the 
fluorescence objective lens (1.2 NA) for 
optimal collection efficiency.

Forward and Side 
Scatter Sensitivity

Enables separation of fixed platelets from 
noise.

Forward and Side 
Scatter Resolution

Scatter performance is optimized for resolving 
lymphocytes, monocytes, and granulocytes.

Side Scatter 
Resolution

Enables separation of 0.2-µm beads from noise.

Parameter Value
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Performance 
specifications Parameter Value

Nominal acquisition 
rate

10,000 events per second

Carryover less than or equal to 0.5%

Nominal 
fluorescence 
sensitivity in 
Normal mode

Channel Qr (x 1000)a

a. Qr is the relative fluorescence detection efficiency, used for de-
scribing the light collection efficiency of a detector, measured in
assigned BD units (ABD units). One ABD unit, for a given fluoro-
chrome, is defined as the fluorescence of one antibody bound to a
CD4+ cell.

FITC  20

PE 133

PerCP-Cy5.5 13

PE-Cy7 17

APC 10

APC-Cy7 7

V450 47

V500 17

Fluorescence 
resolution

Coefficient of variation PI: Area of <3%, full 
G0/G1 peak for propidium iodide (PI)-stained 
chicken erythrocyte nuclei (CEN)

Fluorescence 
linearity

Doublet/singlet ratio of 1.95–2.05 for CEN 
stained with PI and excited with the 488-nm 
(blue) laser
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Fluidics 
specifications Parameter Value

Flow cell Stainless steel with low coefficient of thermal 
expansion for predictable, stable performance

Cuvette internal 
cross-section

430 µm x 180 µm

Sample flow rates  Low: 12 µL/min

 Medium: 60 µL/min

 High: 120 µL/min

 High sensitivity: 50 µL/min

Fluid capacity Standard 5-L tanks, optional 10-L tanks, 20-L 
sheath cubitainer adapter available

Sheath core stream 
fluid velocity

 Normal: 5.4 m/s

 High sensitivity: 2.7 m/s

Sheath fluid 
consumption

 Normal: 13.6 mL/min

 High sensitivity: 6.6 mL/min

Integrated cleaning 
cycles

Daily Clean, Monthly Clean, SIT flush

BD Flow Sensor 
option

Used for volumetric measurement
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Sample input 
formats

For information on BD part numbers for tubes, racks, and plates, 
see the BD FACSVerse section of the BD Biosciences website.

a. When used with an adapter

Parameter Value

For use on the manual tube port

Tubes  BD Falcon 5 mL (12 x 75-mm) polystyrene

 BD Falcon 5 mL (12 x 75-mm) 
polypropylene

 BD Trucount™ 5 mL (12 x 75-mm)

 BD Falcon 15 mLa 

 BD Falcon 50 mLa

 Microcentrifuge 2 mLa

For use with the Loader

Tube racks  30-tube rack (12 x 75-mm tubes)

 40-tube rack (12 x 75-mm tubes)

Plates  96 standard height, round, polystyrene

 96 standard height, flat, polystyrene

 96 standard height, round, polypropylene

 96 standard height, conical, polypropylene

 384 standard height, flat, polystyrene

 96, half deep, conical, polypropylene

 96, deep, conical, polypropylene

 96, matrix tube

 96, filter bottom, polypropylene
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Electronics and 
software 
specifications

Physical 
specifications

Parameter Value

Software BD FACSuite software version 1.0 or later

Operating system Windows 7 Professional

Data resolution Uncompensated data has a range of 0 to 
262143, which is 18 bits

FCS format FCS 3.0 for export

FCS 2.0 and 3.0 for import

Parameter Value

Operating 
temperature

The cytometer has an operating range between 
15°C (59°F) and 30°C (86°F). We recommend 
that the lab temperature fluctuate less than 5°C 
within a day for best operation.

Humidity The operating humidity tolerance is between 
5% and 95% relative humidity (non-
condensing).

Dimensions (W x D x H) 

Cytometer 63.3 x 57.9 x 57.9 cm

(24.93 x 22.8 x 22.8 in.)

Cytometer with 
standard tanks

85.2 x 57.9 x 57.9 cm

(33.5 x 22.8 x 22.8 in.)

Cytometer with 
standard tanks and 
Loader

107.2 x 57.9 x 57.9 cm

(42.2 x 22.8 x 22.8 in.)

See the BD FACVerse System Site Preparation Guide for additional 
information on dimensions and clearances.

Weight Cytometer: 55.0 kg (121 lb)

Loader: 13.2 kg (29 lb)
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Voltage 100–240 ±10% VAC

Frequency 50–60 ±10% Hz

Current 2 A

Power 150 W

Heat dissipation Less than 430 BTU/hour at ambient 
temperature with the cytometer and Loader 
running.

Noise Less than 65 dBA over 8 hours under normal 
operating conditions with the cytometer and 
Loader running.

Parameter Value
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Troubleshooting

This section includes the following topics:

• Cytometer troubleshooting (page 556)

• BD FACSuite software troubleshooting (page 564)

• BD FACS Universal Loader troubleshooting (page 573)
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Cytometer troubleshooting
Introduction This topic describes possible problems and recommended solutions 

for cytometer issues.

Cytometer will not 
turn on

Cytometer on but 
no response to 
software 
commands

Possible causes Recommended solutions

Power cord disconnected 
from wall socket or 
cytometer

Reconnect the power cord to the wall 
socket or cytometer.

Cytometer circuit breaker 
off

Switch on the cytometer circuit breaker, 
followed by the cytometer power. See 
Cytometer overview (page 23) for a 
figure showing the location of the circuit 
breaker.

Possible causes Recommended solutions

Bad keyboard or mouse 
connection

Check the keyboard or mouse 
connections to computer.

Communication failure 
between computer and 
cytometer

1. Turn off the computer and the 
cytometer.

2. Reseat the Ethernet cable, located 
above the power cord on the right 
side of the cytometer.

3. Turn on the cytometer, then the 
computer.

User-installed firewall  Contact your system administrator 
to open a port in the firewall for the 
cytometer.

 Contact BD Biosciences technical 
support.

Cytometer initialization 
failed.

Run the Cytometer > Initialize 
command.
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Cytometer did not 
complete 
initialization when 
using pre-
programmed start 
up.

Tube does not fit 
securely on manual 
tube port

Possible causes Recommended solutions

BD FACSuite software was 
turned off

Leave BD FACSuite software running at 
the end of the day.

Cytometer circuit breaker 
off

Switch on the cytometer circuit breaker, 
followed by the cytometer power. See 
Cytometer overview (page 23) for a 
figure showing the location of the circuit 
breaker.

Possible causes Recommended solutions

Wrong tubes used Use only qualified tubes. See Qualified 
tubes (page 29).

Tube not seated properly Push the tube all the way up into the 
manual tube port.

Defective or cracked tube 
adapter

Replace the tube adapter.

Manual tube port is dirty Clean manual tube port. See Cleaning 
the manual tube port (page 483).
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Status indicator on 
manual tube port 
stays off when tube 
is removed

Low event rate

Possible causes Recommended solutions

Tube sensor could be stuck  Remove and reinsert the tube several 
times.

 Clean the manual tube port. See 
Cleaning the manual tube port 
(page 483).

1. Turn off the cytometer power.

2. Use a Phillips screwdriver to open 
the SIT door.

3. Push down gently on the tube 
detector tab to free it. See the 
following figure.

Tube detector 
tab

Possible causes Recommended solutions

Threshold too high Lower the threshold.



Chapter 20: Troubleshooting 559

High event rate

Improperly mixed sample Mix the sample to suspend cells.

Diluted sample  Concentrate the sample

 Increase the flow rate

Clogged or kinked sample 
injection tube

Perform tasks individually in this order, 
checking after each to see if the problem 
is resolved.

 Run a SIT flush several times.

 Run Drain and Fill Flow Cell.

 Run Daily Clean.

 Run Monthly Clean.

 Replace sample line. See Replacing 
the sample line (page 485).

Possible causes Recommended solutions

Possible causes Recommended solutions

Threshold too low Increase the threshold.

Threshold is set as OR 
instead of AND

Adjust the threshold, or select AND 
instead of OR.

Concentrated sample or 
flow rate too high

Decrease the sample flow rate or dilute 
the sample.
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Erratic event rate
Possible causes Recommended solutions

Air bubble in flow cell  Run a SIT flush (multiple times if 
needed)

 Run Clean Cuvette.

 Run drain and fill flow cell.

Sheath filter is dirty Replace the sheath filter.

Clogged, bent, or kinked 
sample injection tube

Perform tasks individually in this order, 
checking after each to see if the problem 
is resolved.

 Run SIT flush several times.

 Run Drain and Fill Flow Cell.

 Run Daily Clean.

 Run Monthly Clean.

 Replace the sample line. See 
Replacing the sample line 
(page 485).
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High CVs

Low laser power 
indication

Possible causes Recommended solutions

Air bubble in flow cell Perform tasks individually in this order, 
checking after each to see if the problem 
is resolved.

 Run a SIT flush (multiple times if 
needed)

 Run Clean Cuvette.

 Run Drain and Fill Flow Cell.

Sample flow rate too high Decrease the flow rate.

Dirty flow cell Perform tasks individually in this order, 
checking after each to see if the problem 
is resolved.

 Run clean cuvette.

 Run Daily Clean.

 Run Drain and Fill Flow Cell.

 Run Monthly Clean.

Improper sample 
preparation

Verify the sample preparation technique.

Air in sheath filter Run Purge Sheath Filter.

Problem with sheath 
pressure

Verify that the bypass assembly was not 
left in place after running Monthly 
Clean.

Laser alignment needed Run Laser Setup.

Possible causes Recommended solutions

Laser power output is 
below requirement

Contact BD Biosciences technical 
support.
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Performance QC 
fails after doing 
monthly clean

Fluidics error after 
replacing sheath 
fluid or emptying 
waste

Droplet forms at tip 
of SIT

Possible causes Recommended solutions

Bypass assembly still in 
place

Remove the bypass assembly and install 
the sheath filter.

Residual bleach in system 
because tank not rinsed 
thoroughly

Make sure to thoroughly rinse the 
bleach from the sheath tank during the 
procedure.

Possible causes Recommended solutions

Status change not yet 
detected by software

 After replacing or emptying fluids, 
wait until the software detects a 
status change before restarting 
acquisition.

 Check the waste tank connection.

Possible causes Recommended solutions

Air bubble in flow cell Perform tasks individually in this order, 
checking after each to see if the problem 
is resolved.

 Run a SIT flush (multiple times if 
needed)

 Run Drain and Fill Flow Cell.
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Liquid leakage 
around cytometer 
base

Barcode reader 
error

More information • BD FACSuite software troubleshooting (page 564)

• BD FACS Universal Loader troubleshooting (page 573) 

Possible causes Recommended solutions

Sheath filter connections 
not secure after changing 
filter.

Check connections at top and bottom of 
filter.

Interior valve failure 1. Turn off the cytometer power.

2. Clean up the liquid, using proper 
precautions.

3. Contact BD Biosciences technical 
support.

Possible causes Recommended solutions

Dirty barcode reader 
window

Clean the barcode reader window with 
isopropyl or ethyl alcohol and try again.

Blurred or damaged 
barcode label

Try scanning with a duplicate label (if 
available), or enter the data manually.
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BD FACSuite software troubleshooting
Introduction This topic describes possible problems and recommended solutions 

for software issues.

Software does not 
connect to 
cytometer

Software message 
“Security key not 
accessible...”

Possible causes Recommended solutions

Cytometer not turned on Turn on the cytometer.

Cytometer initialization 
failed

Run Cytometer > Initialize.

Internal firmware error Switch the cytometer power off and then 
on again.

Waste tank not connected 
properly

Check to see that waste tank connector 
is securely installed on the tank.

Undetermined cause Exit the software, shut down the 
computer and cytometer, and then 
restart them.

Possible causes Recommended solutions

Security key not installed 
in USB port

Install the security key in the USB port, 
then restart the software.

Security key damaged Contact BD Biosciences technical 
support.
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Software not 
responding

Excessive amount 
of debris in plots

Possible causes Recommended solutions

Saving or loading large 
data file

Look for screen activity. If there is no 
activity, wait 1–2 minutes, and then 
restart the software.

Calculating large number 
of statistics

Calculating statistics is memory 
intensive. When calculating many 
statistics on a large number of displayed 
events, wait 1–2 minutes before using 
the software. 

Waiting for response from 
cytometer

Wait until the cytometer action is 
complete. If after 2 minutes no time-out 
is received, restart the cytometer and 
software.

Software frozen 1. Press Ctrl+Shift+Esc. Locate 
BD FACSuite software in the 
Windows Task Manager. Click End 
Task.

If acquisition is in progress, data will 
be lost when you click End Task.

2. Restart the software. 

Possible causes Recommended solutions

Threshold too low Increase the threshold. 

Stained sample too old Improper sample preparation. Verify the 
sample preparation technique.
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Distorted 
populations or 
unexpected pattern 
in plot

Possible causes Recommended solutions

Cytometer settings 
adjusted incorrectly

Optimize the scatter or fluorescence 
parameters.

Air bubbles in flow cell Perform tasks individually in this order, 
checking after each to see if the problem 
is resolved.

 Run SIT flush (multiple times if 
needed)

 Run clean cuvette.

 Run drain and fill flow cell.

Flow cell dirty Perform tasks individually in this order, 
checking after each to see if the problem 
is resolved.

 Run clean cuvette.

 Run daily clean.

 Run drain and fill flow cell.

 Run monthly clean.

Flow rate is too low 
(sample is viscous or 
fluidics is overcoming an 
air bubble).

Raise to next highest flow rate until 
events are seen, then switch back to the 
desired rate.

Flow rate is too high Lower the flow rate.

Incorrect spillover values Verify that correct tube settings and 
reference settings are applied.

Incorrect gating Verify the gating.
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No events in plots 
after clicking 
Preview, 
acquisition 
indicator light is 
blinking as 
expected

Fluorescent signal 
missing

Fewer events than 
expected in gated 
population

Possible causes Recommended solutions

Current run pointer is not 
set on current tube

Set the run pointer on the appropriate 
tube.

Viewing plots for a 
different tube

The primary data source is set to a 
different tube in Plot Properties dialog. 
Set it to the correct tube or set the run 
pointer as the primary data source.

Threshold not set to 
correct parameter

Set the threshold to the correct 
parameter for your application. 

PMT voltage too low or 
too high

Adjust the voltage to bring events back 
on scale.

Threshold too high Adjust the threshold.

Improper sample 
preparation

Verify the sample preparation technique.

Possible causes Recommended solutions

Area scaling set incorrectly  Re-run performance QC.

 Adjust area scaling.

Laser delay incorrect Re-run performance QC.

Incorrect sample 
preparation

Re-stain and re-run samples.

Possible causes Recommended solutions

On-axis events left out of 
gate

Include events on the axis.

Gates improperly set Check the gating strategy.

Stopping criteria not set 
correctly

Verify that the stopping criteria are set 
correctly.
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High electronic 
abort rate (>10% 
of system event 
rate)

Increasing 
threshold results in 
decreased area 
signal

Area or height 
measurement off 
scale, while the 
other is on scale

Dirty flow cell Perform tasks individually in this order, 
checking after each to see if the problem 
is resolved.

 Run clean cuvette.

 Run drain and fill flow cell.

 Run daily clean.

 Run monthly clean.

Sheath filter is dirty Replace the sheath filter.

Incorrect sample 
preparation

Verify the sample preparation is correct.

Possible causes Recommended solutions

Possible causes Recommended solutions

Event rate too high Decrease the flow rate.

Sample too concentrated Dilute the sample.

Threshold set too low Increase the threshold.

Window extension could 
be set too high

Adjust the window extension.

Possible causes Recommended solutions

Window extension set too 
low

Increase the window extension.

Possible causes Recommended solutions

Area scaling not set 
correctly

Adjust the area scaling so area and 
height are equal.
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Optical filter holder 
not recognized

FCS files or Entry 
Run Packages are 
not exported 
automatically when 
running a Worklist

Possible causes Recommended solutions

Filter holder not installed 
completely after removal

Press the holder firmly into the heptagon 
to ensure that it is installed correctly.

Incorrect filter holder used Check the filter holder to confirm that it 
is an approved BD filter holder.

Filter holder broken Contact BD Biosciences technical 
support.

Possible causes Recommended solutions

Action not enabled in 
Preferences

 Ensure you enabled the preference to 
export files automatically through 
Tools > Preferences > Worklist 
Preferences > Export.

 Ensure the location you selected for 
the files exists and you have write 
access to it.

The entry is not approved Ensure that the entry is Approved. Files 
are only exported automatically when 
they are approved. You can enable 
automatic approval for your assays in 
the Library.
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Results are not 
exported 
automatically when 
running a worklist

Possible causes Recommended solutions

Various causes  Ensure that Include in Auto-Export 
is enabled for one of the statistics 
views in the experiment that is used 
to create the assay. You can enable 
this option through the General Tab 
in the Properties view of the 
Statistics view.

 Ensure you selected results to export 
for your assay in the assay properties 
in the Library.

 Ensure you enabled the preference to 
export results automatically through 
Tools > Preferences > Worklist 
Preferences > Export > Result.

 Ensure the location you selected for 
the result files exists and you have 
write access to it.

 Ensure that the entries are 
Approved. Results are only exported 
automatically when they are 
approved. You can enable automatic 
approval for your assays in the 
Library.
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Failed CRC value 
check error 
message when 
importing an FCS 
file

Incorrect password 
message

Incorrect cytometer 
settings for an 
imported assay

Possible causes Recommended solutions

BD FACSuite software uses 
a CRC value mechanism 
that is specified in the 
FCS 3.0 standard to ensure 
that the FCS file has not 
been modified through file 
transfers. 

When a BD FACSuite FCS file has been 
modified, the file cannot be read by 
BD FACSuite software. You must return 
to the original FCS file.

The FCS file does not 
adhere to the FCS 3.0 
standard, which requires a 
CRC value to be written 
with the data.

Export the FCS file from an FCS 3.0 
compliant application.

Possible causes Recommended solutions

Password has been 
forgotten

Contact your administrator to change 
your password. Your administrator can 
provide you with a new temporary 
password through Tools > User 
Management. When you log in again, 
you will be asked to provide your new 
password.

Possible causes Recommended solutions

Missing Assay Setup 
settings for your cytometer

After importing an assay you need to 
run Assay Setup for that assay using the 
Setup & QC workspace. 



BD FACSVerse System Reference572

Fluorochrome is 
not assigned to a 
configuration 
message during 
data acquisition

Cannot move an 
individual point of 
a polygon gate

Cannot paste the 
picture of statistics 
view into Excel

Non-BD FACSuite 
message displayed 
in system tray

Possible causes Recommended solutions

The fluorochrome is not 
assigned to a detector in 
the current configuration. 

1. Assign the fluorochrome to the 
configuration through Setup & QC 
> Configurations. This is an 
administrator-only task.

2. In an experiment, add the 
fluorochrome to the reference 
settings.

Possible causes Recommended solutions

Not selecting the gate 
correctly

Use Ctrl+click on the gate. This selects 
the gate and shows the individual points. 
Now you can drag a point to a different 
location.

Possible causes Recommended solutions

Wrong paste option In Microsoft Excel, use Paste Special and 
select to paste a bitmap.

Possible causes Recommended solutions

A message similar to this 
appears:

There could be a problem with one of 
the hard drives. Call BD Biosciences.
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More information • Cytometer troubleshooting (page 556)

• BD FACS Universal Loader troubleshooting (page 573)

BD FACS Universal Loader troubleshooting
Introduction This topic describes possible problems and recommended solutions 

for Loader issues.

Carrier does not 
load

System fails to 
initialize or nest 
does not return to 
home position

Possible causes Recommended solutions

Cover not closed Verify that the cover is fully closed.

Tube not fully seated in 
rack

Check all tubes to see they are seated in 
the rack and that the cover is fully 
closed.

Rack or plate not seated 
properly in the nest

Check that the rack or plate is centered 
in the nest and gripped securely at the 
corners.

Lid on plate Remove the lid and retry.

Barcode label on rack or 
plate is dirty or wet, 
causing misread

Verify the barcode label is clean, dry, 
and able to be read.

Possible causes Recommended solutions

Stray object inside Loader 
preventing movement

Check the interior region around the 
nest for stray objects (tubes, tube caps, 
etc). 



BD FACSVerse System Reference574

Tube not detected .

Tube runs dry, 
Loader not 
advancing to next 
sample

More information • Cytometer troubleshooting (page 556)

• BD FACSuite software troubleshooting (page 564)

Possible causes Recommended solutions

Top of tube rack is dirty Clean the top of the rack.

Top of tube is dirty Verify that top edge of the tube is clean.

Incorrect tube Verify that the tube is in the correct 
position.

Possible causes Recommended solutions

Dilute sample or rare 
events

Set the acquisition max time or number 
of events to a lower value in software.

Bubble in flow cell diverts 
stream

 Run SIT flush several times.

 Run daily clean.

 Run drain and fill flow cell.



Glossary

A

ABD unit An acronym for assigned BD trackable fluorescence unit assigned to 
CS&T beads. One ABD unit is defined as 1/40,000th of the 
fluorescence of a lymphocyte stained with anti-CD4 for a particular 
detector/fluorochrome. 

acquisition The process of collecting data from a flow cytometer and storing it 
in an electronic flow cytometry standard (FCS) file.

acquisition delay 
timer (worklist)

A set lag time between previewing and acquiring a tube in a 
worklist. Before the time expires, a stop timer can be used to 
continue previewing and adjusting settings, such as voltage and 
threshold. The delay value is set as a worklist preference. 

Administrator For BD FACSuite software, an assignable user role. Administrators 
can set up the instrument, create user accounts, and manage and 
save elements in all workspaces.

area scaling factor 
(ASF)

A control used to determine the magnitude of the area signal. 
Usually used to set the area equal to the height for the particles of 
interest. During setup, the ASF determined is based on 3-m beads.

analysis The use of gating strategies to define the populations in the data and 
display statistics about populations. 

assay In BD FACSuite software, a set number of tubes that share the same 
tube settings, worksheets, and reports. Assays are reusable and are 
run by worklists using the Loader. The two types of assays include 
BD-defined assays and user-defined assays.
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audit trail A software function that tracks changes to entries. Any changes 
that affect the data (for example, worksheet, reports, plots, gates, 
statistics) are listed as changes in the audit trail log.

B

batch analysis The automated analysis of a set of samples. 

bead lot file The CS&T and FC bead identifier that can be scanned or 
downloaded. 

BD Flow Sensor An optional hardware device that measures the acquired volume, 
which is used to determine cell counts in a sample.

BD FACS Universal
Loader (Loader)

An optional automated system that mixes samples and delivers 
tube racks and plates to the BD FACSVerse for acquisition. 

BD FACSuite CS&T 
research beads

Particles that are hard-dyed at three different intensities to emit in 
a broad spectrum that is detectable by all channels of the 
BD FACSVerse cytometer. BD FACSuite CS&T research beads are 
used with the software to automatically set up tube settings and 
assays, and characterize and track performance of the cytometer.

Br A relative optical background signal used for tracking optical 
background levels in a detector.

C

characterization QC The process that establishes target cytometer settings and sets pass 
or fail values for linearity, sensitivity, and %rCV. 

coefficient of 
variation (CV)

The standard deviation of the data divided by the mean of the 
data, typically expressed as a percentage (also known as relative 
standard deviation). When applied to channel data measured on a 
population of cells, the CV is a measure of variation independent 
of the population mean.
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compensation A mathematical or electronic correction applied to flow cytometric 
data to account for the overlapping fluorescence emission from one 
fluorochrome into the wavelength region where the second is 
measured. 

configuration A representation of the lasers, detectors, and mirrors that make up 
the cytometer's optics. 

cytometer settings See Instrument settings.

D

detector A device that converts light signals into electronic signals. 
Photodiodes and photomultiplier tubes are the two types of 
detectors used in BD cytometers.

E

electronic noise 
(rSD)

A statistical value in a particular detector used to predict the 
minimum acceptable signal levels required for the best attainable 
resolution and sensitivity for the system.

entry (worklist) A row in a worklist. Each entry includes a sample ID, tubes, and 
one task.

entry run package 
(ERP)

A file containing all information needed to replicate an entry in a 
different worklist, including acquired data. Individual worklist 
entries can be exported as entry run packages (ERPs). You can 
import ERP files into any worklist and analyze the entry.

E-sig (e-signature) An electronic signature that can be used on reports to verify and 
approve an entry after acquisition or analysis.

event rate The number of particles per second detected by the cytometer.

experiment In BD FACSuite software, a group of elements used to acquire and 
analyze data from the flow cytometer. An experiment is flexible 
and can be saved as an assay for use in a worklist. 
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expression A mathematical equation included in the system, or created by the 
user, to produce a statistic derived from existing statistics.

F

FC beads Particles that are used to create or update reference settings for BD 
standard fluorochromes.

FCS The flow cytometry standard file format used to save flow 
cytometry data.

filter (optical) A device used to selectively block light of particular wavelengths or 
frequencies while allowing other wavelengths to pass through.

filter (fluidic) A device that removes particles from the sheath fluid.

flow rate The volume per second of the sheath and the sample that passes 
through the flow cell. The rates are high, medium, and low. High 
and medium flow rates typically can be used for 
immunophenotyping and to increase event throughput. The low 
flow rate is typically used when high precision is required (for 
example, DNA studies) to measure slight variations in 
fluorescence.

fluidic mode Variation in the speed that the sheath and the sample pass through 
the flow cell to obtain different separation. The normal sensitivity 
fluidics mode has three flow rates: high, medium and low. The 
high-sensitivity fluidics mode has only one flow rate and slows the 
sample and sheath flow to obtain better separation between 
negative and positive fluorescence populations.

fluorescence The emission of light by a substance that has absorbed light or 
other electromagnetic radiation of a different wavelength. In most 
cases, emitted light has a longer wavelength, and therefore lower 
energy, than the absorbed light.

forward scatter 
(FSC)

A measurement of light refracting at less than 10° to the laser 
beam as a particle passes through the beam. The FSC measurement 
is an indicator of cell size.
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G

gate A boundary in a plot that defines a subset of the total sample 
population. Gating identifies cells of interest, classifies events in the 
gated population, and calculates population statistics.

gate hierarchy A representation of the relationship of gates in an experiment or 
assay. The hierarchy shows the name, color, and relationships with 
other gates.

H

heptagon In the BD FACSVerse system, the assembly of mirrors, filters, and 
detectors in the cytometer.

I

instrument settings A collection of values describing the state of the cytometer for 
acquisition. These settings include photomultiplier (PMT) voltages, 
thresholds, delays, window extensions, area scaling, spillover 
values, sheath flow rates, and sample flow rate.

J

K

keyword A unique field used to identify particular data attributes in data 
files created by the flow cytometer. Keywords are used in tubes, 
entries, statistics, and expressions.

keyword value The alphanumeric text entered in the Value field. 
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L

label A marker associated with a fluorochrome. For example, for CD4-
FITC, CD4 is the label.

laser delay A time adjustment in the software representing the amount of time 
it takes a particle to travel between lasers. This value is used to 
synchronize the processing and display of data for a single particle 
from multiple lasers. This value is measured and adjusted 
automatically during performance QC.

Levey-Jennings 
charts

A graphical presentation of data points from multiple runs for a 
single parameter, intended for analysis of trends in cytometer 
performance.

library In BD FACSuite software, a workspace for storing and managing 
shared system resources. Resources include assays, beads, reagents, 
keywords, labels, and tube settings.

Linearity The acceptable linear range is the ratio of bright beads to dim beads across 
the detector response. If the mean of the ratio is greater than 2%, the 
results are not considered linear. 

LW reference 
settings

Cytometer settings that roughly place normal lysed whole blood 
lymphocytes on scale for FSC, SSC, and fluorescence parameters 
using an FSC threshold.

LNW reference 
settings

Cytometer settings that roughly place normal lysed, unwashed 
whole blood lymphocytes on scale for FSC, SSC, and fluorescence 
parameters using a PerCP or PerCP-Cy5.5 threshold.

M

manual tube port A loading area that accepts individual tubes for acquisition. This 
port is located on the right front of the cytometer. 

median 
fluorescence 
intensity (MFI) 

The fluorescence intensity value of the event in a defined 
population that has an equal number of events with fluorescence 
intensities higher and lower than it.
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N

O

operator For BD FACSuite software, an assignable user role. Operators can 
use the instrument, and create, modify, and save their own 
elements in the software.

P

panel In BD FACSuite software, objects that contain buttons, fields, and 
selections to perform specific functions required for a workspace. 
You can maximize, minimize, or reposition a panel on the screen. 

parameter Tube and plot properties that define the data to be acquired from 
each particle and the display of data in plots.

performance QC The set of automated software functions used to measure and track 
cytometer operation and to set up consistent LW and LNW tube 
settings.

plot A graphic representation of data acquired by a flow cytometer.

PMT voltage 
(PMTV)

Acronym for photomultiplier tube voltage, the voltage for each 
detector in a cytometer configuration.

population A subset of events defined by a gate.

population view 
(hierarchy)

A display of the relationship between groups (subsets) defined in 
each tube based on the gating strategy.

pre-programmed 
startup and 
shutdown (idle 
based shutdown)

Settings that allow you to assign times for the system to 
automatically start and shut down after being idle. BD FACSuite 
software must remain on for preprogrammed startup to occur.
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preview The process of receiving and displaying live data on a worksheet 
without saving an FCS file. You can modify instrument settings 
during preview.

process control A control sample run exactly as a patient specimen. Normally 
produces an expected result.

Q

QC A group of procedures that measure cytometer performance and 
prepare the system for daily use.

Qr (relative 
fluorescence)

The detector efficiency defined as the number of photoelectrons 
measured per ABD unit.

R

rCV (%rCV) The percent robust coefficient of variation of a population. Used in 
the calculation of photon detection efficiency (Qr).

reagent A chemically reactive substance used to label, detect, measure, or 
produce other substances.

reference settings Tube settings and the associated spillover values that have been 
measured using fluorescence control tubes. 

report A display of results and associated information. Reports can be 
saved or exported.

report delay timer 
(worklist)

A set lag time between the acquisition of two entries in a worklist 
for viewing the report of the first entry. Before the time expires, use 
the stop timer to continue viewing the report and adjusting gates 
and statistics markers. The value is set as a worklist preference. 
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S

sample A single unit of material to be analyzed on a flow cytometer. 
Samples can be associated with one or more assays, divided into 
multiple tubes or wells, and mixed with substances such as 
reagents.

sample carrier A compatible tube rack or multiwell plate used to organize samples 
for increased throughput acquisition on the Loader.

setup & QC The group of functions and activities in BD FACSuite software that 
prepares the sample, control, and/or cytometer for operation.

sheath fluid A solution used in flow cytometers that carries and 
hydrodynamically focuses sample in the flow cell.

SIT (sample 
injection tube)

The component that aspirates sample from a tube or a well and 
delivers it to the flow cell. 

side scatter (SSC) The light scattered at a right angle to the incident light beam.

slope of gain The slope of the brightness versus voltage for bright beads (log 
MFI vs log PMT voltages) used in setup and QC.

spectral overlap The phenomenon of different fluorochromes emitting light within 
the same detection range. 

spillover values 
(SOVs)

The amount of spectral overlap calculated as the ratio of the 
primary signal in the channel to any interfering signal from 
another channel.

statistics view The calculated statistics displayed in a format that includes a title, 
keywords, expressions, and statistics for one or more populations 
and/or parameters. Statistics are associated with all gates and 
populations in plots on a worksheet. 

stopping rules The criteria used by the system to automatically stop acquisition, 
(for example, time, number of total events, and number of target 
population events).
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stop timer A countdown mechanism that allows you to pause an action 
(acquisition or reporting) to make changes to settings before 
resuming the action. The duration of the counter can be set as a 
worklist preference. See acquisition delay timer or report delay 
timer.

storage gate A boundary that defines which population will be saved in an FCS 
file.

system health 
report

A text file containing the current status of the system. The report 
also includes a ZIP file containing log files and other files that can 
be used by a BD technical support representative to analyze and 
troubleshoot the system.

T

task An action that the cytometer performs when you run a worklist. 
Tasks include the assay (BD-defined or user-defined), or a fluidics 
action.

threshold A trigger signal and level of discrimination to eliminate unwanted 
events. Only events with parameter values above the threshold will 
be analyzed.

tube In BD FACSuite software, a representation of a physical tube that 
contains saved properties (for example, reagents, labels, FCS data, 
stopping rules, tube settings, worksheets, and keywords).

tube settings A collection of values that place the positive population at the 
same position (brightness) whenever the tube settings are applied. 
Tube settings allow the system to produce comparable results from 
day to day and from system to system.

tube target values 
(TTV) 

The ratio of median fluorescence intensity (MFI) to assigned BD 
unit (ABD) for a tube. TTVs determine the brightness of the 
positive population for each fluorescence parameter.
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U

V

W

window extension The time added to the pulse duration above the threshold to give 
the total time during which a pulse is sampled.

worklist A series of tasks to be performed. A worklist organizes multiple 
entries, which include tubes, tasks, status, and other information 
about the sample. 

worksheet An area within the software where plots, gates, statistics, and other 
elements are created and modified.

workspace A functional area within the software that contains panels, fields, 
tables, and tools required for a specific function. Individual 
workspaces are provided for setup and QC, experiments, 
worklists, and the library.
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